Contents

Get Started with Your Account ................................................................. 1
  Log In to Your Account ................................................................. 1
  Organizer Quick Start ............................................................... 3
  Download GoToMeeting ............................................................ 4
  Try GoToMeeting Free ............................................................ 5
  Automatic Upgrades (Windows only) ........................................... 17
  Install the GoToMeeting Extension for Google Calendar ........ 18
  Install the GoToMeeting Outlook Plugin ..................................... 20
  Install the GoToMeeting Outlook Plugin in Silent Mode for Admins 22
  System Requirements ............................................................... 30
  Forgot Your Password ............................................................. 32
  Can’t Access Your Account ....................................................... 32
  Change Your Login Info ............................................................ 33
  Edit Your Personal Info ............................................................. 34
  Update Your Billing Info ........................................................... 35
  Set Your Default Language .......................................................... 36
  Preferences (Windows) ............................................................... 37
  Preferences (Mac) ..................................................................... 46
  Change Your Plan ....................................................................... 48
  Use OpenVoice Integrated Toll-Free Numbers ....................... 51
  Cancel or Renew Your Account ................................................ 56
  Updates to Your Account .......................................................... 60

Start, Schedule and Manage Meetings .............................................. 63
  Schedule a Meeting ............................................................... 63
  Schedule a Meeting with the Outlook Plug-in ......................... 68
  Configure a Proxy for the GoToMeeting Outlook Plug-in ......... 70
  Schedule a Meeting in Google Calendar ................................. 74
  Modify a Meeting in Google Calendar ..................................... 77
  Edit a Scheduled Meeting ....................................................... 79
  Set Default Audio Options ....................................................... 81
  OpenVoice Integrated Toll-Free Audio Service ....................... 83
Integrate GoToMeeting with Microsoft Outlook ........................................................... 84
Add a Custom Logo .................................................................................................... 88
Create a Personalized Meeting Page ........................................................................ 90
View Scheduled Meetings ........................................................................................... 94
Start a Scheduled Meeting .......................................................................................... 97
Start Instant Meetings .................................................................................................. 100
Embed a Meet Now Button on Your Website ........................................................... 102
View Meeting History ................................................................................................ 104
Cancel a Meeting ...................................................................................................... 106
Mobile Devices ............................................................................................................ 108
Join, Schedule, and Start Meetings via iOS .............................................................. 108
Start, Schedule and Manage Meetings from an Android device ............................... 114
GoToMeeting App for Android Permissions .............................................................. 120
GoToMeeting App for Windows devices ................................................................... 122
Use iOS Session Features ........................................................................................ 126
Use Android Session Features .................................................................................. 136
Use Windows Session Features ............................................................................... 144
Switch Devices While In Session .............................................................................. 149
Mobile Feature Comparison ...................................................................................... 150
Join Sessions .............................................................................................................. 151
Join a Session ........................................................................................................... 151
GoToMeeting Web App ............................................................................................. 154
Session Features ........................................................................................................ 164
Original Control Panel (Windows) ............................................................................. 164
New Control Panel and Grab Tab ............................................................................... 167
Invite Others .............................................................................................................. 168
Test your Connection during a Session ..................................................................... 170
Connect to Session Audio ......................................................................................... 171
Add Co-Organizers .................................................................................................... 177
Share Your Screen .................................................................................................... 179
Share Your Webcam ................................................................................................... 182
Record a Session ...................................................................................................... 193
Convert Session Recordings ...................................................................................... 195
Give Keyboard and Mouse Control ............................................................... 198
Transcoding Wizard (Windows only) ............................................................. 200
Change Presenter ............................................................................................ 203
Use Drawing Tools ......................................................................................... 206
View and Manage Attendees ......................................................................... 209
Access Labs Features ..................................................................................... 212
Use Chat ........................................................................................................... 223
Desktop Notifications (Windows) ................................................................. 226
Leave and End a Session ................................................................................. 227

FAQs .................................................................................................................. 228
Join a Session FAQs ....................................................................................... 228
Audio Conferencing FAQs ............................................................................. 229
OpenVoice Integrated (Toll-Free Audio) FAQs ............................................. 231
General GoToMeeting Troubleshooting FAQs ............................................. 232
GoToMeeting Essentials FAQs ...................................................................... 235
Roles FAQs ....................................................................................................... 236
HDFaces Video Conferencing FAQs ............................................................ 237
Recording and Playback FAQs ....................................................................... 240
Billing and Cancellation FAQs ..................................................................... 243
Security FAQs .................................................................................................. 244
GoToMeetingApp for Android FAQs ............................................................. 245
GoToMeeting App for iOS FAQs .................................................................. 250
GoToMeeting App for Windows Phone FAQs .............................................. 255
GoToMeeting App for Windows 8 and Windows RT FAQs ......................... 258
New Version of GoToMeeting FAQs ............................................................ 261
GoToMeeting Web App FAQs ........................................................................ 262

Troubleshooting ............................................................................................. 265
Audio Help ....................................................................................................... 265
Broadcast Computer Audio .......................................................................... 268
Find your Optimal Connection Settings (Windows) .................................... 269
Disable the Launcher Plugin ......................................................................... 271
Steps for Installing on Macs .......................................................................... 274
Steps for Installing on Windows ................................................................. 279
Get Started with Your Account

Log In to Your Account

After you've created your GoToMeeting account, use the email address and password you signed up with to log in online and access all the features that GoToMeeting offers.

Log in to your account


2. Enter your account credentials (i.e., the email address and password created during sign up). To have your information stored for the next 30 days, enable the "Remember me" check box.

3. Click Sign In.

4. You'll then have access to all of the features and tools GoToMeeting offers, as follows:
Forgot your password?

1. Go to the Forgot Your Password page.
2. Enter your login email address and click Continue to reset your password.
3. Soon you’ll receive a Forgot Your Password email. Click the link inside to create a new password.

Don’t have an account?

Try GoToMeeting free for 30 days! Included in your 30-day free trial:

- Unlimited online sessions
- Up to 25 attendees per session
- Audio via telephone and/or mic and speakers
- Free product training and 24/7 support
Organizer Quick Start

Follow along and you’ll be up and running in no time!

Install GoToMeeting

Once installed, you can start and schedule meetings with just a couple clicks. You can install GoToMeeting on your Windows or Mac computer, as well as your iOS, Android or Windows devices.

The GoToMeeting desktop application is used to host meetings.

- [Download GoToMeeting](#)

Start an instant "Meet Now" session

You can start an unscheduled meeting any time you want using the desktop software, web account or our mobile apps.

- [Start Instant Meetings](#)

Start a scheduled meeting

You can also schedule meetings ahead of time using the desktop software, web account or our mobile apps.

- [Schedule a meeting](#)
- [Start a scheduled meeting](#)
- [View scheduled meetings](#)
- [Edit scheduled meetings](#)

Explore GoToMeeting features and tools

GoToMeeting is chock-full of cool communication features. Use the links below to learn more!

- [Connect to audio](#)
- [Invite others to join](#)
- [Share your desktop](#)
- [Share your webcam](#)
- [Send chat messages](#)
- [Use drawing tools](#)
- [Record sessions](#)
Download GoToMeeting

To get the most out of GoToMeeting you can download and install the full-feature desktop software on your Windows and Mac computer.

Install on individual computers

Windows and Mac users must install the GoToMeeting desktop software in order to host meetings from their computers.

- [Download the Windows/Mac version](#)
- [Download the Windows 8/RT version](#)

For step-by-step instructions on downloading and installing the desktop software, see [Install on Windows](#) or [Install on Mac](#).

Distribute to multiple computers

System administrators may wish to install GoToMeeting across several computers at once (i.e., workstations at a company). See the following articles for more information:

- [Install the GoToMeeting MSI File (Windows)](#)
- [Install the GoToMeeting DMG File (Macs)](#)

Install on mobile devices

Mobile users can install the GoToMeeting free on iOS, Android or Windows devices.

- Download the [GoToMeeting app for iOS](#) on the App Store. (See [FAQs](#) for more information.)
- Download the [GoToMeeting app for Android](#) on Google Play. (See [FAQs](#) for more information.)
- Download the [GoToMeeting app for Windows Phone](#) in the Windows Phone store. (See GoToMeeting [FAQs](#) for more information.)

Trouble downloading?

For step-by-step instructions on downloading and installing the desktop software, see [Install on Windows](#) or [Install on Mac](#).

Trouble joining?

If you’re running into problems joining a session, see the following resources:

- [Join a Session](#)
- [Join a Session FAQs](#)
- [Join Help](#)
Try GoToMeeting Free

GoToMeeting Free is a video-chat tool that allows you to connect with co-workers or friends online quickly and easily! Ideal for small teams and quick sync-ups, GoToMeeting Free uses many of the same features as the full version of GoToMeeting (which is designed for larger teams and businesses). Get started with a meeting right away – no need to sign up.

If any of the following apply to your team, then GoToMeeting Free might be right for you!

- Your meetings are typically only 2-3 people.
- You need a simple and quick solution to chat and share webcams online.
- You are on a budget.
- You don't need the more robust tools included in the full version of GoToMeeting (like session recording and annotation tools).
Features and tools

You can do the following using GoToMeeting Free:

- Start an unlimited number of meetings.
- Invite up to 2 attendees per meeting.
- Share your audio and webcam.
- Share your screen.
- Chat with attendees.
- Share documents (PDF, Word, Excel or PowerPoint) with attendees.
- Schedule meetings by reserving and sharing Join URLs.

Advanced features: You do not need to sign up for a GoToMeeting Free account in order to start and join meetings. However, signing up will allow you to access some additional features of GoToMeeting Free (e.g., claiming a room, scheduling a meeting). Sign up to access the following features:

- Claim personalized meeting rooms.
- Lock rooms to control who joins.
- Have your name on your video tile and in the chat window.
- Add your own avatar to appear on your account.

GoToMeeting Free for Google Calendar

You can also schedule and start meetings for GoToMeeting Free in Google Calendar.

Check out:

- Install the GoToMeeting Google Calendar extension.
- Schedule a meeting in Google Calendar.
- Modify a meeting in Google Calendar.
- Start a scheduled meeting.
Start a meeting

2. Click the Start a Meeting button.

3. The new meeting will automatically launch in the browser window.
4. When prompted, enable the use of your speakers and webcam as follows:
   - Firefox – Click Share Selected Devices in the drop-down message.
   - Chrome – Click Allow in the top-navigation.

5. Once you are in session, a floating toolbar will appear at the top of your screen. This provides you with easy access to Mute and Webcam icons, even when the browser window isn't at the forefront of your screen.
Invite attendees (2 max)

1. Click the Add People icon 🔄 at the bottom of the page.

2. A pop-up window will display the Join URL for the meeting. You can share the link with attendees in any of the following ways:
   - Click the Copy Link button to copy the URL to your clipboard and share it as desired.
   - Click the Share via email link to launch a new email with the Join URL automatically included.
   - Click the Invite with Facebook link to launch a new Facebook message with the Join URL automatically included.

3. Up to 2 attendees can join the meeting (i.e., 3 participants, including you).
   - If the room is locked, then you will be prompted to approve or deny their joining.
   - If the room is unlocked, then they will be launched into session immediately.

When attendees join, they will be assigned a random nickname (e.g., "Charming Star", "Rugged Diamond") that will be displayed in the webcam and chat box.

Note: Attendees can have their own name appear in the webcam box and chat box if they sign in to GoToMeeting Free.

Share your audio and webcam

When you join a session, your audio and webcam are automatically shared.

To unshare them, you can do the following:

- Click the Mute icon 🎤 so that a "Muted" message appears across the shared webcam.
- Click the Webcam icon 📹 so that the shared webcam goes black with an icon 📷 across it.

Click the icons again to un-mute your audio or re-share your webcam.
Chat with attendees

Use the Chat bar in the lower-right of the bottom navigation to instant message with attendees. Simply enter your message in the next field and press Enter on your keyboard to send your chat.

Share your screen

1. Start a meeting.
2. Click the Share Content icon in the bottom navigation.
3. Click the Share Screen button.

**Note:** You must first enable the extension by clicking Enable Extension button then clicking Allow or Add.

4. Share your screen or applications as follows:
   - **Chrome** – In the pop-up window, select an application or screen to share with attendees. Click Share when finished.
• Firefox – In the browser drop-down message, select Entire Screen > Share Screen button. It is not possible to share only an application window using Firefox.

5. The Share Content icon will turn green (/ay) when your screen is being shared, and you will see the following message on your desktop (not visible to attendees) notifying your that the GoToMeeting Free extension is sharing your screen with others.
Share a document on your screen

If desired, you can share the image of a PDF, Word, Excel or PowerPoint file with attendees. Rather than sending the file to attendees for download, this feature temporarily displays the file on the shared screen in the web browser.

1. Click the Share Content icon 📞 in the lower navigation.

2. Upload a compatible file in either of the following ways:
   - Under "Share a document", click **Choose File**. Select the desired file in the File Upload window and click **Open** when finished.
   - Drag and drop the desired file into the "Share a document" box in the browser.

3. The file will be automatically uploaded and displayed on the screen for you and your attendees. For multi-page documents, you can use the Arrow icons in the top navigation to move between pages.

4. To stop sharing the file, click the Share Content icon 📞 again.

**Note:** The file is not saved to the meeting; if you would like to share it again, you will need to complete the above steps again.
Claim a meeting room

If desired, you can claim your own meeting room with a personalized URL. This allows attendees to always join the same meeting without you having to send out new invitations each time.

**Note:** You can only claim 1 room per account.

1. Click the **Claim room** link in the top-left corner.
2. If you haven't yet done so, sign in to GoToMeeting Free.
3. Use the text field to specify the URL you would like to use as a Join Link for your meeting.
4. Click the **Claim Room** button when finished.

5. To start a meeting with the claimed room, simply go to the new Join URL. Alternatively, you can **sign in** and click **Enter Your Room** on the home page.
Use locked rooms

If you want to control who joins your claimed room, you can lock it (i.e., make it private). When the room is locked, attendees are presented with a waiting screen until you arrive. When a room is unlocked, attendees will automatically join without your being prompted to approve them.

1. Enter your claimed room.
2. Click the Lock icon  in the top navigation so that the icon changes ( ).
3. When prompted, click Lock Your Room.
4. Attendees who attempt to join the room will see a waiting screen informing them that they must wait to be approved to join.

5. You will be prompted to allow or deny entrance to each attendee by using the and icons displayed along with the attendee’s shared webcam.
Schedule a meeting

1. Sign in to GoToMeeting Free.

2. Click the Schedule a Meeting button on the home page.

3. Click the Copy Invitation button to copy the Join URL of a new meeting to your clipboard. Share the link with your attendees, and then use it yourself when you want to start the meeting.
Leave feedback for GoToMeeting Free

You can leave feedback in either of the following ways.

- When you leave your first meeting, you will be prompted to rate how likely you would be to recommend GoToMeeting Free to a friend or colleague on a scale of 1 - 10.

![Feedback Rating](image)

- In the lower toolbar, click the Settings icon 🌐 and then Feedback to access the Feedback form, where you can report an issue or provide feedback.

![Feedback Form](image)
Sign up for a GoToMeeting Free account

You do not need to sign up for a GoToMeeting Free account in order to start and join meetings. However, signing up will allow you to access some additional features of GoToMeeting Free (e.g., claiming a room, scheduling a meeting).

2. Click the Start a Meeting button.
3. Click the Sign in link in the top navigation.
4. You can click Sign in with Facebook or Sign in with Google to continue.
5. When prompted, log in with your Facebook or Google credentials in order to connect your account.

System requirements

The following are required in order to use GoToMeeting Free:

- **Operating System**
  - Windows
  - Mac
  - Linux

- **Browser**
  - Google Chrome (latest version [here](#))
  - Mozilla Firefox (latest version [here](#))

- **Hardware**
  - Webcam
  - Mic/speakers (preferably with a headset)

**Note:** GoToMeeting Free for Androids using Chrome browsers is still considered a "work in progress", so feel free to try it but please forgive us for any bugs. We suggest using headphones to improve the audio experience. Chrome on iOS is not yet supported.
Automatic Upgrades (Windows only)

You can easily install the latest version of GoToMeeting whenever an update is available using the automatic updates feature. You won’t be prompted to install the latest version – you’ll simply get upgraded seamlessly when you’re not in session. By default on Windows, the automatic updates feature is enabled if you’re logged in to the application and have the “Remember me on this computer” option selected.

Enable or disable automatic updates

Note: If you prefer to be prompted every 24 hours the next time an update is available, you may turn off automatic updates, but you’ll be required to go through the download process.

1. Right-click the GoToMeeting daisy icon 🌼 in your system tray and select Preferences.
2. The default setting is to automatically install updates. If you wish to disable automatic updates, uncheck the "Automatically install updates" check box.

You can click learn about our latest updates to see what’s new in the latest version.
Install the GoToMeeting Extension for Google Calendar

The GoToMeeting Extension for Google Calendar supports both GoToMeeting and GoToMeeting Free. The extension allows you to schedule and update meetings directly from your Google calendar in a browser or on a mobile device. You can email meeting invitations and updates directly to attendees. To see documentation on scheduling meetings, see Schedule a meeting with the GoToMeeting Google Calendar Extension. This article covers:

Note: If you have already installed earlier versions of the extension, it is updated automatically to use the latest version of the extension when you relaunch your browser.

System Requirements

- Windows XP or newer
- Mac OS® X 10.7 or newer
- Google account
- Chrome or Firefox browser

Install GoToMeeting Google Calendar extension for Chrome

1. Go to the GoToMeeting Google Calendar extension in the Chrome Store.
2. Click the +Free button next to “GoToMeeting Extension for Google Calendar”
3. In the Confirm New Extension dialog, click Add.
4. The extension is installed automatically and ready to use. To double-check, go to **Chrome Tools | Extensions** and make sure it is listed and checked as **Enabled**.

---

**Install GoToMeeting Google Calendar extension for Firefox**

1. Go to the [Mozilla Add-Ons store](https://addons.mozilla.org). Search for GoToMeeting.

2. Click the **Add to Firefox** button on the **GoToMeeting Extension for Google Calendar**. (The button appears when you move a cursor over the location.)

3. Choose **Install Now** at the trusted author warning.

The extension is ready for use!
Install the GoToMeeting Outlook Plugin

The GoToMeeting Outlook plug-in allows you to schedule and manage GoToMeeting sessions directly from your Outlook calendar.

The plugin checks for updates each time you launch Outlook. If available, updates install automatically.

System Requirements
- Windows XP or newer (not available for Mac computers)
- Outlook 2010 or newer

Download the Outlook plugin

2. Click the following link to initiate the download: https://builds.citrixonlinecdn.com/builds/calendarintegration/outlook/G2M/setup.exe.
   - For Outlook 2010, click Yes on the download prompt. The plugin will be automatically installed on your Outlook Calendar.
   - For Outlook 2013, click Install on the Customization Installer pop-up to install the Outlook plugin. Click Close once the installer is finished.
3. You may need to restart Outlook in order to see the changes.

IMPORTANT: To ensure your audio preferences are used for your meetings, click Set Default Audio Options. For instance, if you specify toll or tollfree conference numbers, these will be picked up and used by the plugin.
Uninstall the Plugin

The process for uninstalling the plugin from a computer varies depending on the computer's operating system. See your operating system's user manual for more information.

Example (Windows 7): Go to Windows Start > Control Panel > Programs and Features. Right-click GoToMeetingOutlook Calendar Plug-in and select Uninstall > Yes.
Install the GoToMeeting Outlook Plugin in Silent Mode for Admins

The silent installation enables an administrative install of the Outlook plugin as a company-standard application. The process allows an IT admin to obtain a Trusted Publisher certificate for the plugin and deploy that to user devices, and then to create an installation package that will automatically install the plugin on user devices. The certificate must be renewed on an annual basis.

Once the plug-in is installed on a user's account, it updates automatically. Each time Outlook is restarted, the plug-in checks for updates, and if they are available, makes the updates automatically without user notification.

System Requirements

- Windows XP or newer
- Outlook 2010 and Outlook 2013 (must be set up to use Exchange as the mail system)
- Access to the Internet
- Visual Studio (VSTO) Installer is installed on user machines. (MicroSoft Office typically installs this as part of the Click-Once installer. To download it, go to the VSTO Installer. If the link fails, search for: 'download visual studio 2010 tools for office runtime'.)
Register for Certificate Access

To obtain the currently valid Trusted Publisher certificate, the admin must first request access to the Citrix Certificate Store. The certificates are valid for one year. Registering for access ensures you receive an email alert from Citrix when a new certificate is available. This enables you to update certificates on user devices before they expire.

**IMPORTANT:** If certificates expire on user devices, errors are generated and the users’ lose their ability to use the plugin to schedule and launch meetings until a valid certificate is in place.

1. Go to Podio: [https://podio.com/webforms/8544012/635668](https://podio.com/webforms/8544012/635668) and complete the registration form. Click Submit.

2. You will receive an email confirmation that will permit you to proceed to the next step.
Get Currently Valid Certificate

Once you have registered for access to the Citrix Certificate Store, or when a new certificate is available, you will receive an email directing you to the Citrix Certificate Store where you can download the latest certificate. You can then use your company-standard delivery tools or scripts to deploy the certificate to user devices.

1. Click the button in the email you received to access the Podio space, Citrix Signing Certificate (https://podio.com/citrix/citrixsigningcertificate).

2. In the Podio space, choose Public Certificates.
3. In the list of public certificates - there will be no more than two - check the Valid dates. Click on the latest certificate. The certificate download page displays.

4. Select the **CitrixOnline.cer** file. The file downloads to your local drive automatically.

**Disable Notifications in Podio as Needed**

Because this Podio space is only needed to provide you access to the latest certificate, and Citrix will email you directly when a new certificate is available, you may want to disable Podio notifications. To do this:

1. Open Podio and click on your profile menu in the upper right corner.

2. Click **Account Settings**, and choose **Email & Notifications**.

3. Uncheck all notifications, and choose **Save**.
Deploy Certificate

Deploying the certificate consists of copying it to local machine stores and then adding it to the Trusted Publishers store for both the machine and the current machine user. Most IT departments have tools that accomplish these steps. The deployment of the certificate is described here as a separate step, but you could also incorporate it into the silent install described in the next section.

To test this, or if you are scripting this install, you could use a script with syntax something like the following:

@Certutil -addstore -enterprise -f "TrustedPublisher" "CitrixOnline.cer"

If you want to step through these processes manually to test them or for a problem machine, see Install the Trusted Publisher Certificate Manually.

Configuring the Silent Mode Installation Package

The silent mode installation of the GoToMeeting Outlook Plugin can be accomplished using your standard IT deployment tools. Citrix provides an installation package that includes sample scripts and the Plugin installer that you can use or modify as needed.

The scripts provided, and their functions, are:

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ImportCertificate.cmd</td>
<td>Copies the certificate to the local machine and adds it to the Trusted Publishers store for the machine and current user.</td>
</tr>
<tr>
<td>Test_SilentPluginInstallation.cmd</td>
<td>Sample install of the GoToMeeting Outlook Plugin.</td>
</tr>
<tr>
<td>TestandInstall_G2MOutlookPlugin.cmd</td>
<td>Sample boot script to check for the plugin, and if it is absent, to install it. Also disables existing, older version of the plugin.</td>
</tr>
<tr>
<td>TestandInstall_G2MOutlookPlugin.ps1</td>
<td>The sample boot script in Windows PowerShell format.</td>
</tr>
<tr>
<td>CitrixOnline.cer</td>
<td>The certificate. Must be acquired from the Citrix Podio site.</td>
</tr>
</tbody>
</table>

1. If you haven't already, obtain the CitrixOnline.cer certificate.
2. Download the Citrix install package. The contents of the package are:
   - ImportCertificate.cmd
   - Readme.txt
   - Test_SilentPluginInstallation.cmd
   - TestandInstall_G2MOutlookPlugin.cmd
   - TestandInstall_G2MOutlookPlugin.ps1
3. Create the install model that works for your environments. The full install should accomplish the following:
   - Execute ImportCertificate.cmd as administrator to copy and install the certificate.
   - Optionally check local machines on boot for the presence of the plugin using the equivalent of TestandInstall_G2MOutlookPlugin.cmd.
   - Install the plugin in silent mode as in Test_SilentPluginInstallation.cmd, or TestandInstall_G2MOutlookPlugin.cmd.
• Disable any older plugins.

If you are using a boot script on local machines, the syntax would be something like:

"C:\Program Files (x86)\Common Files\microsoft shared\VSTO\10.0\VSTOInstaller.exe" /install https://builds.citrixonlinecdn.com/builds/calendarintegration/outlook/G2M/GoToMeetingOutlookCalendarPlugin.vsto /silent

This completes the silent mode installation instructions. If you have difficulties, questions, or comments, please either comment on this page, or contact developer-support@citrixonline.com.

The remaining sections of this article provide manual steps for the certificate deployment process.

Install the Trusted Publisher Certificate Manually

If there is a problem installing the Trusted Publisher certificate, or if the install is to be performed locally on a user device, you can complete installation manually.

1. Locate the Citrix Signing Certificate, CitrixOnline.cer, and double-click on the file to check the expiration date. The certificate is valid for roughly one year. Note the date of expiration and set a reminder to download a new silent install package with a new certificate a month or so prior to the expiration of your current certificate.
2. If the certificate is valid, click **Install Certificate**. Choose **Next** to continue.

3. In the Certificate Store window, choose **Place all certificates**, and click **Browse**. In the Select certificate store dialog, select Trusted Publishers and click **OK**, then click **Next**.
4. In the Completing the Certificate Import window, make sure the Certificate Store Selected by User is selected, and choose **Finish**.

![Certificate Import Wizard](image)

5. After a few moments, you should see an "Import was successful" dialog box. Choose **OK** to end the install process.

![Certificate Import Wizard](image)

**Use MicroSoft Management Console to Install Certificate**

1. In your computer’s **Start** menu, type **mmc** in Search programs and files and press **Enter**.
2. If you are asked for permission to proceed choose **Yes**. The management console opens.
3. Open **File | Add/Remove Snap-in**.
4. In the Add/Remove Snap-in box, select **Certificates** and then click **Add**.
5. Click **Computer Account**, and then click **Next**.
6. Click the **Local computer** (the computer this console is running on) option, and then click **Finish**.
7. Repeat steps 4 and 5, this time choosing **My User Account**.
8. Click **Close**, and then click **OK**. If you are asked to Save the console settings, choose **Yes**.
System Requirements

Before you download the latest version of GoToMeeting, please check to see that your computer and accessories meet the minimum system requirements.

Note: Attendees using Linux or Chromebook will be able to join GoToMeeting sessions on their web browser, but are unable to join using the Windows/Mac desktop software.

What are the system requirements for running GoToMeeting?

<table>
<thead>
<tr>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating system (any of following)</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Processor</strong></td>
</tr>
<tr>
<td><strong>RAM</strong></td>
</tr>
<tr>
<td><strong>Internet</strong></td>
</tr>
<tr>
<td><strong>Bandwidth</strong></td>
</tr>
<tr>
<td><strong>Browser (any of the following)</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Additional software</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating system (any of following)</strong></td>
</tr>
<tr>
<td><strong>Processor</strong></td>
</tr>
<tr>
<td><strong>RAM</strong></td>
</tr>
<tr>
<td><strong>Internet</strong></td>
</tr>
<tr>
<td><strong>Bandwidth</strong></td>
</tr>
<tr>
<td><strong>Browser (any of following)</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Additional software</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>iOS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating system</strong></td>
</tr>
<tr>
<td><strong>Device (any of the following)</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Internet</strong></td>
</tr>
<tr>
<td><strong>Additional software</strong></td>
</tr>
</tbody>
</table>
What equipment do I need to use GoToMeeting?

- Windows or Mac computer
- Internet connection (broadband is best)
- Microphone and speakers (built-in or USB headset)
- Webcam for HDFaces video conferencing

Most computers have built-in microphones and speakers, but you will get much better audio quality if you use a headset. You can also make calls on your landline or mobile device.
Forgot Your Password

Remembering all your passwords is hard. Luckily, resetting your GoToMeeting password is easy.

Forgot your password?

1. Go to the Forgot Your Password? page.
2. Enter your login email address and click Continue to reset your password.
3. Soon you'll receive a Forgot Your Password email. Click the link inside to create a new password.

If you're still having trouble accessing your account, contact Global Customer Support.

Can’t Access Your Account

If you're trying to log in but can't access your account, your subscription may have expired. You'll need to first update your billing information to continue using GoToMeeting.

Update your account

1. Log in to your GoToMeeting account.
2. You should be taken directly to the My Account page. In the Plan Details, click Subscribe Now to sign up for a paid subscription plan.
3. Choose the plan that best fits your needs, and click Review Your Plan.
4. On the Confirm Your Plan page, click Purchase Now. To ensure uninterrupted service, you will be billed automatically on the billing date. You can click Turn Off Renewal on the My Account page at any time to turn off automatic renewal.
5. Once you confirm your plan, you'll be able to use GoToMeeting without any disruptions.
Change Your Login Info

Have a new email address? Want to change passwords? No problem; just follow along.

Change your login info

1. Log in to your online account.

2. Select My Account in the top navigation.

3. Click Edit next to Login Info.

4. To change your email address, edit your email address in the Email Address field. To change your password, enter your new password twice – it must contain 8 - 32 alphanumeric characters.

5. Then enter your current password. If you forgot your password, click Forgot password? Enter your email address and reset your password by opening the link you receive in the Forgot Password email.

6. When you’re done, click Save Changes. You’ll see a confirmation message saying that your login information has been updated.
Edit Your Personal Info

You can edit your personal info, such as your first and last name, primary language, time zone and daytime phone number.

Edit your personal info

1. Log in to your GoToMeeting account.
2. Select My Account in the top navigation.
3. On the My Account page, click Edit next to Personal Info.
4. On the Change Personal Information page, you can edit your first or last name, primary language, time zone and daytime phone number (optional). You can also add your Twitter username to post questions about GoToMeeting and receive support.
5. When you’re done, click Save Changes. You’ll see a confirmation message saying that your personal information has been updated.
Update Your Billing Info

You can change or update your billing info at any time. If you have a corporate account, follow steps 1 - 2 below, and then click Contact Us in the Account Details section for Corporate Billing support.

Change your billing info

1. Log in to your GoToMeeting account.
2. Select My Account in the top navigation.
4. On the Change Billing Information page, you can change your credit card information.
5. When you're done, click Save Changes. You'll see a confirmation message saying that your billing information has been updated.
Set Your Default Language

You can set your default language for how you view the GoToMeeting website from the My Account page. After you've chosen your preferred primary language, you can view the GoToMeeting website in that language. You can also choose your preferred language while you're in-session – whatever language your operating system is set to is the default language for your in-session experience, but you can change that at any time from your Windows computer.

Set your account's default language

1. Log in to your GoToMeeting account.
2. Select My Account in the top navigation.
3. On the My Account page, click Edit next to Personal Info.
4. On the Change Personal Information page, you can choose your primary language so that the GoToMeeting website appears in your preferred language.
5. When you’re done, click Save Changes. You’ll see a confirmation message saying that your personal information has been updated.

Choose your language in-session (Windows only)

1. During a session, select the Globe icon at the top of your Control Panel.
2. Select your preferred language. You can switch languages at any time by selecting another language from the Globe icon.
Preferences (Windows)

The Preferences window allows you to modify the settings for running GoToMeeting (including audio, connection and integration settings).

- Windows users can access Preferences by right-clicking the GoToMeeting daisy icon in the system tray, or from the File menu while in-session.
- Mac users can access Preferences by opening the GoToMeeting desktop application and selecting GoToMeeting > Preferences in the menu bar. Please see Preferences - Mac Users for more information.

Start Up preferences

These settings allow you to determine how GoToMeeting is launched and updated.

- Start Automatically – Choose to have GoToMeeting automatically launch as soon as you log in to Windows.
- Start Manually – Choose to have GoToMeeting wait until you manually launch it to open.
- Remember me – Enter the login credentials for your account and choose whether GoToMeeting should remember them when you launch it.
  - Show me desktop notifications – Choose whether to allow GoToMeeting to show pop-up notifications regarding your account.
  - Remind me of upcoming meetings – Choose whether see pop-up notifications reminding you of upcoming meetings.
- Automatically install updates – Choose whether to allow the GoToMeeting desktop application to automatically download and install new versions/builds when they become available (without prompt).
General preferences

The General category lets you set your general GoToMeeting preferences.

- **File save settings** - Enables you to save the Chat Log to any drive or directory.
- **Security** - Set the inactivity timeout to automatically stop screen sharing if there is no keyboard input or mouse movement for the specified period of time.
- **Session Identity** - Remember your name and email as displayed in the attendee list.
Meetings preferences

The Meetings category lets you determine which GoToMeeting options are available to attendees during a meeting. You can also select which messages are viewable during a meeting.

- Enable or disable the ability for attendees to chat and view the Attendee List.
- Create a Chat Welcome Message that is sent to each attendee upon joining the meeting.
- Enable or disable various system messages that appear to you when specific meeting actions occur.
- Select the desired color for your GoToMeeting Viewer and Control Panel.

Note: If you disable the Chat Bubbles option, a new message icon will still appear on the Grab Tab to notify you of new chat messages as they are received.
Webinar preferences

![Webinar preferences screenshot]

Training preferences

![Training preferences screenshot]
Recording preferences

These preferences allow you to specify how sessions are recorded and where those recordings are saved.

**Note:** Be sure to check your audio device settings under Audio. Mac users can only view meetings recorded in the Windows Media Player format.

1. Select **Recording** in the left navigation.

2. In the Audio section, choose how you want the audio to be recorded:

   - **Don't record audio:** Records the presenter's screen only.
   - **Use GoToMeeting integrated audio:** Records everyone who speaks via VoIP or telephone.
   - **Use your own audio service:** Uses a microphone to record the organizer's voice, while a phone patch device will record everyone else who speaks (requires a physical input device).

<table>
<thead>
<tr>
<th>Using GoToMeeting Integrated Audio</th>
<th>Using Your Own Audio Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>Records all unmuted speakers in the meeting.</td>
<td>To record all unmuted speakers, you will need a phone patch connected to both your phone and the mic in port of your computer.</td>
</tr>
<tr>
<td></td>
<td>To record just your voice, you will need a microphone connected to your computer.</td>
</tr>
<tr>
<td></td>
<td>If you want to use VoIP with your own audio service, please contact your Account Manager (GoToMeeting corporate plans) or Global Customer Support (GoToMeeting plans).</td>
</tr>
<tr>
<td></td>
<td>Your Windows must have a sound card installed in order to record audio. For example, if you can hear music through your Windows, you have a sound card.</td>
</tr>
</tbody>
</table>

3. All recordings must be converted before they can be played back. In the Recordings section, select whether or not to be reminded to convert recordings each time the session ends.

4. In the Preferences window, click **OK**.
5. When your recordings are converted for playback, the recording files are saved to the Documents folder by default (C:\Users\<username>\Documents). You can select another folder by clicking **Browse**, navigating to the desired location and clicking **Save**. It is recommended that you choose a location on your hard drive.

**Recording preferences**

The Recording category lets you set your audio and video recording preferences. See [Record a Meeting](#) for more information.

- **Audio** - Allows you to enable or disable recording the audio portion of your meeting. To record, choose which audio service you have scheduled to use for your meeting (see the following table).
- **Video** - Allows you to select the meeting recording output format and destination for saving the file.
- **Save in** - Select the folder in which you want to save your recording.

Mac users are not able to record a meeting. If you want your meeting recorded, promote a Windows attendee to organizer in-session. A Windows-based organizer will have the recording feature.
Integration preferences

The Integrations category lets you determine where to display GoToMeeting integrations. Options include:

- **Use GoToMeeting with** - Select your GoToMeeting email and calendar integration. By selecting My default email application you can integrate with MAPI-compliant email/calendar programs other than Microsoft Outlook and Lotus Notes. Depending on your email application's capabilities, integration with MAPI-enabled programs allows for features such as automatically adding meetings to a calendar and automatic creation of email messages with meeting information.

- **Show GoToMeeting Toolbar in Microsoft Office** - Display the GoToMeeting Toolbar in Microsoft Word, Excel and PowerPoint.

**Note:** Changes will only be displayed after restarting Outlook, Lotus Notes and/or the instant-messaging application.

Connection preferences

The Connection category allows you to test the status of your GoToMeeting connection.

**Note:** To ensure a valid connection test, we advise that you refrain from testing your connection unless a GoToMeeting Global Customer Care representative directs you to perform the connection test.
Audio preferences

The Audio category lets you set up and test your microphone and speakers for recording and for your meetings utilizing VoIP. If changes to your audio settings are made during a meeting, your microphone is temporarily muted so you can privately manage your settings. See GoToMeeting Integrated Audio for more information.

- **Microphone Setup** - Select a microphone from the drop-down menu. To test, speak into your microphone; if connected correctly, the sound bar will move when you speak.
- **Speakers Setup** - Select your speakers from the drop-down menu. To test, click **Play Sound**; if connected correctly, the sound bar will move and you will hear a short soundtrack.
- **Advanced** - GoToMeeting automatically adjusts system mixer settings. We recommend you keep this checked. If you uncheck this selection, you must manually configure your audio settings through Windows Sounds and Audio Devices.
- **Use automatic volume and noise processing** - This option usually improves audio quality when people are talking. Unchecking this box may improve quality of music or other audio sources.

![Audio settings interface](image)
Webcam preferences

The Webcam category lets you set up and test your webcam for HDFaces Video Conferencing. Options include:

- **Your camera** - Shows the make and model of your detected webcam.
- **Select a display format** - Adjusts the aspect ratios of webcam feeds. (4:3 is the normal display and 16:9 is the widescreen display.)
- **Advanced** - Modifies your hardware settings from within GoToMeeting. Customizable options depend on your webcam manufacturer.

![Webcam Setup Screen](image)
Preferences (Mac)

GoToMeeting Preferences allow you to set preferences for running GoToMeeting, choose where you want to store recordings, select what your attendees can see and set your webcam preferences.

Mac users may access the GoToMeeting preferences by double-clicking the GoToMeeting Suite icon on their desktop and selecting Preferences from the GoToMeeting menu in the menu bar.
General Preferences

The General tab allows you store your account information and display name for meetings. If you check the "Remember me on this computer," your account information will be saved and you will not need to re-enter it when you join a meeting. You can also select the "Use GoToMeeting with default email application" check box to add email integration to your GoToMeeting account.

Recording Preferences

The recordings tab allows you to choose where you would like to store your recordings and how you would like to be notified to convert your recordings (you must convert recordings before anyone can see them).

Meeting Preferences

The Meetings tab lets you determine which GoToMeeting options are available to attendees during a meeting. Options include:

- Enable or disable the ability for attendees to chat and view the Attendee List.
- Create a welcome message that is sent to each attendee upon joining the meeting

Webcam Preferences

The Webcam tab allows you to select a camera to use for your webcam as well as a display format.
**Change Your Plan**

You can change your plan level at any time. Since your service is pre-paid, changes made to your plan won't take effect until the end of your subscription period.

**Note:** If you are the administrator of your account but are still unable to see some of the features and buttons described below, it is likely that you have an "offline" account (meaning that you manage your account and billing options through a Citrix Sales representative). In this case, you must contact [Global Customer Support](mailto:GlobalCustomerSupport@citrix.com) to modify your account and subscription plans.

**Change your subscription plan**

1. [Log in](https://myaccount.goto.com) to your online account.
2. Select **My Account** in the top navigation.
3. Click **Change Plan** in the Plan Details section.
4. Select a plan that best fits your needs. To purchase a multi-seat account, select the number of organizer seats you need from the drop-down menu.
5. Click **Purchase Now**. You can click **Edit** next to Plan Details or Billing Info to make any changes.

Your plan will renew on your billing start date to ensure uninterrupted service. Your credit card on file will be automatically charged. Learn about how to [turn off automatic renewal](https://myaccount.goto.com/billingHelp/cancel).
Upgrade from a GoToMeeting Essentials plan to a GoToMeeting 25 plan

1. Log in to your GoToMeeting account.
2. Select My Account in the top navigation.
3. On the My Account page, click Change Plan in the Plan Details section.
4. To switch your plan from a GoToMeeting Essentials plan to a GoToMeeting 25 plan, select the number of organizer seats (optional) and then choose either the monthly or annual plan.
5. On the Confirm Your Plan page, click Purchase Now.
Use OpenVoice Integrated Toll-Free Numbers

As a GoToMeeting user, you can now buy toll-free numbers, powered by OpenVoice Integrated, to use during your GoToMeeting sessions. You may sign up for OpenVoice Integrated during your initial purchase or you can add OpenVoice Integrated to your existing GoToMeeting account at any time. If you have a corporate plan, you must contact your Account Manager or Global Customer Support.

Note: OpenVoice can be purchased in two forms, either as an integration with GoToMeeting or as a standalone conferencing product. For information about OpenVoice Integrated, continue below. For information about OpenVoice as a standalone product, please see here.

Sign up for OpenVoice Integrated

1. On the Choose a Plan page, select a plan that best fits your needs. To purchase a multi-seat account, select the number of organizer seats you need from the drop-down menu.

2. Select the number of attendees and click **Buy it Now**.
3. On the Create Your Account page, select the “Add Toll-free numbers provided by OpenVoice” checkbox to add OpenVoice to your GoToMeeting account.

**Note:** You will be charged per attendee to your credit card. Even though your GoToMeeting account is prepaid, you will need to pay usage charges for using OpenVoice on your credit card.

4. If you are a new user, you need to create a GoToMeeting account. Enter your first and last name along with your email address.

5. Click **Continue**.

6. Enter your billing information and click **Review Your Plan**.

7. On the Confirm Your Purchase page, click **Purchase**.
When signing up for OpenVoice Integrated, you will be able to see the changes in your account on the Settings page and when you schedule future meetings.

On the Settings page, the Audio section will have an option to provide a toll-free number.

On the Schedule a Meeting page, the check box for “Opvoice Integrated” is selected by default in the Audio section while scheduling a future meeting.
Subscribe to OpenVoice Integrated

You can subscribe to OpenVoice Integrated at any time. Since your GoToMeeting plan is prepaid, you will find charges for your OpenVoice usage in your credit card. If you have a corporate plan, you must contact your Account Manager or Global Customer Support.

1. Log in to your GoToMeeting account.
2. Select My Account in the top navigation.
3. On the My Account page, under Plan Details, there is a description for the toll-free numbers provided by OpenVoice. To subscribe to it, click How it Works.
4. On the Toll-free Numbers from OpenVoice page, click Subscribe Now.

Your plan will renew on your billing start date to ensure uninterrupted service. Your credit card on file will be automatically charged at the end of your billing cycle. OpenVoice usage charges will be charged to your credit card directly.
Unsubscribe to OpenVoice Integrated

1. Log in to your GoToMeeting account.

2. Select My Account in the top navigation.

3. On the My Account page, under Plan Details, there is a description for the toll-free numbers provided by OpenVoice.

4. To unsubscribe, click Unsubscribe from OpenVoice.

5. On the Unsubscribe from Toll-free Numbers page, click Unsubscribe Now.

6. On the confirmation page, details of your usage and billing are explained and a confirmation email is sent to your registered email address.

7. You will see a message saying that your request has been processed with the details of your usage and billing.
Cancel or Renew Your Account

Your plan is set to auto-renew, but you can turn that setting off any time. When you cancel your account, your service will continue until the end of your subscription period (since GoToMeeting is a pre-paid service). At that time your service will stop, you will lose access to scheduled sessions and reports and you will not be automatically charged again. You can renew your account at any time.

Note: If you are the administrator of your account but are still unable to see some of the features and buttons described below, it is likely that you have an "offline" account (meaning that you manage your account and billing options through a Citrix Sales representative). In this case, you must contact Global Customer Support to modify your account and subscription plans.

Turn off renewal for free trials

1. Log in to your online account.
2. Select My Account in the top navigation.
3. Click Change Plan in the Plan Details section.
4. Select Cancel after my GoToMeeting Free Trial ends and click Continue.
5. Click Cancel after Trial. You’ll see a message and receive an email confirming that you won’t be charged after your free trial ends.
GoToMeeting User Guide

My Account

Plan Details
GoToMeeting Free Trial
- Plan Details
- Automatically subscribes to Monthly Plan on Dec 6, 2013
- Visa – 1111 will be charged $6.99 USD, tax not included

Login Info
- colleen.ai-hh@jdx.com
- Password ********

Personal Info
- Henry Johnson
- Primary Language: English
- Time Zone: Pacific Standard Time

Billing Info
- Visa – 1111
- Expires 10/15
- Henry Health Building
- 7444 Halsted Ave
- Goleta, CA 93117-2533
- United States
- Phone: 805-111-1111

What do you want to do?
- Change my plan or seats
- Cancel after my GoToMeeting plan ends

Cancel after Your Trial Ends?
- May we suggest GoToMeeting Essentials?
- Hold unlimited online meetings with up to 5 attendees for $19.00 USD/month. If you don’t need recording or to meet with 25 attendees, perhaps GoToMeeting Essentials is a better fit.

Questions?
- Contact Global Customer Support

Your Request Has Been Processed
- After your GoToMeeting free trial ends on Dec 6, 2013, your service will be canceled and you will not be charged for a plan. We sent a confirmation email to colleen.ai-hh@jdx.com.

You will not be able to access scheduled meetings or generate reports once your plan expires.
Turn off renewal for paid plans

1. Log in to your online account.
2. Select My Account in the top navigation.
3. Click Turn Off Renewal in the Plan Details section.
4. Click Turn Off Renewal. Your service will stop, and you will not be automatically charged after your plan ends. If you change your mind, you can log in at any time to restart your plan.
Renew your plan

1. **Log in** to your online account.
2. Select **My Account** in the top navigation.
3. Click **Renew Your Plan** in the Plan Details section.
4. If desired, click **Edit** to change your plan level. Then click **Purchase Now**. Your account will reactivate immediately!

**Note:** You will be billed automatically on your billing start date.
Updates to Your Account

We're in the process of rolling out updated versions of GoToMeeting, GoToWebinar and GoToTraining to our remaining customers who do not yet have the latest experience. As always, the updates are absolutely free.

As part of this upgrade, we’re also combining your GoTo ™ product log-in credentials. If you use the same email address for GoToMeeting, GoToWebinar or GoToTraining and also for Open Voice and the GoToAssist family of products, you will need to complete a secure, one time password reset. This means one less password to remember, and it’ll be easier than ever to switch between some of our most popular solutions.

Attend a live, online training session to learn more. Register today!

GoToMeeting Updates

Log in to your account at www.gotomeeting.com to get started.

Schedule meetings even faster and easier:

- Schedule and host meetings in localized languages such as French, German, Spanish, Italian and Mandarin.
- Schedule and start your meetings directly from the website.
- Designate a GoToMeeting organizer to host meetings on your behalf with the new meeting co-organizer feature. Watch the Co-Organizer Basics video (3 min) to learn more!

Personalize your meeting experience with new settings options:

- Create brand awareness by uploading a custom logo to the GoToMeeting waiting room.
- Select your default audio numbers, then set a preferred audio number so it conveniently appears first for attendees.
- Enable a no download, Web App option, for attendees who are unable to download software or are using an unsupported operating system such as Linux.
- Watch the Settings video (5 min) to learn more!

Try our latest features and tools using Citrix Labs:

- Try out GoToMeet.Me, one of our most popular new features. It’s a simple way for organizers to increase their professional presence online with a custom profile page and personalized meeting URLs to share with others. Try it today!
GoToWebinar Updates

Log in to your account at www.gotowebinar.com to get started.

Schedule webinars even faster and easier:

- Schedule and host webinars in localized languages such as French, German, Spanish and Italian.
- Create a webinar registration link in seconds with just a few clicks.
- Watch the Scheduling Basics video (9 min) to learn more!

Get more control over how attendees register and in-session interaction:

- Add a splash of color to your event by selecting custom background, header and border colors for registration and confirmation pages.
- Enjoy an increased capacity for polls (20) and survey questions (25), which means more attendee engagement.

Learn more about your audience:

- Use our new registration source tracking capability.
- Get more details from your registrants with up to 20 custom registration questions.

Improve vital email communication:

- Re-send invitations to individuals and cancel registration on behalf of registrants as well.
- Preview the automated webinar communication by sending yourself a copy of the confirmation and follow-up emails.
- Improve the webinar's workflow by setting the “reply-to” email address to any email of your choosing.

Leverage the content you create:

- Review past webinars with archived recordings that will no longer expire. We’ll continue to store them so you can build out your content library.
- Enjoy 3GBs of archived storage capacity for each webinar user at no additional cost.
- Archive larger recording files with a new, increased upload limit of 1GB per recording.
- Allow organizers on Macs to archive recordings.
- Watch the Recording Basics video (4 min) to learn more!
GoToTraining Updates

Log into your account at www.gototraining.com to get started.

Schedule trainings even faster and easier:
- Schedule and host trainings in localized languages such as French, German, Spanish and Italian.
- Watch the Scheduling Quick Start video (3 min) to learn more.

Easily manage your trainings with improved website usability
- Quickly find content such as tests, materials, polls and co-organizers using the search function.
- Generate reports to view training history.
- Enable a no download, Web App option for attendees who are unable to download software or are using an unsupported operating system such as Linux.
- Watch the Managing Libraries and Materials (9 min to learn more)

Easily record your events and share them with your learners:
- Immediately preview your newly added archived recordings directly from My Recordings.
- Learn on the go with archived recordings viewable from any mobile device.
- Allow organizers on Macs to archive any.mov or .wmv file.

Corporate Admin Center Updates

Log in to your updated administration center at www.gotomeeting.com and have a look around. See the Global Admin Center Guide for more information.

Easily manage users and settings with improved search, filter and management functionality:
- Create custom invitation templates to match your business processes.
- Save time by creating default user settings for all new invitees.
- Manage user settings even before the user accounts are activated.
- Make settings changes in bulk for all users at the same time.
- Assign seats, roles and groupings at the same time as well.
- Create a localized user experience by setting the primary language.
- Save important meeting links with the ability to reassign scheduled meetings to another user.
- Select your default audio numbers, then set a preferred audio number so it conveniently appears first for attendees joining sessions.
- Generate usage and bill reports for Open Voice Integrated services.
- Add a custom field within your Settings options to track cost centers.
- Watch the Global Admin Center Tutorial video (9 min) to learn more!

Don’t forget to explore our additional integrations available to administrators, including the Active Directory Connector (ADC) and WebSSO (SAML 2.0).
Start, Schedule and Manage Meetings

Schedule a Meeting

You can schedule meetings and start instant meetings from the GoToMeeting desktop software or by logging into your account online. You can also schedule recurring meetings to save your meeting for future use. One-time meetings automatically expire 30 days after the scheduled end time, but recurring meetings stay available until you delete them.

Schedule a meeting from the desktop software

1. Right-click the daisy icon in the system tray (Windows) or toolbar (Mac).

If you don't have the GoToMeeting software installed, download it first.
2. Use the Schedule a Meeting window to specify the details of your new meeting, as follows:

- **Subject** – Enter a title for the meeting.
- **Date** – Select the date and time of the meeting.
- **Audio** – Select the audio options that should be available to attendees. To add more international long-distance (toll) and/or toll-free numbers, click **Edit countries** to choose more countries.
- **Password** – If desired, enable the "Require meeting password" check box and enter a password. Attendees must enter the password in order to join the meeting.

3. If desired, enable the "Recurring meeting" check box so that you and your attendees can reuse the same Meeting ID and audio information until you delete it from the My Meetings page.

4. Click **Schedule** when finished. The new meeting will then be available from the My Meeting page.
5. If you integrate GoToMeeting with an email client (like Outlook), a meeting invitation will pop up — send it to attendees as a calendar appointment. If you want to remind attendees of a recurring meeting, click Recurrence in your Outlook invitation email, or choose another calendar to remind attendees.
Schedule a meeting from the web


2. On the My Meetings page, click Schedule a meeting.

3. Use the pop-up window to specify the details of your new meeting, as follows:
   - **Subject** – Enter a title for the meeting.
   - **Recurrence** – Select whether the meeting occurs once or more using the drop-down menu.
   - **Date** – Select the date and time of the meeting.
   - **Audio tab** – Select the audio options that should be available to attendees. To add more international long-distance (toll) and/or toll-free numbers, click **Edit countries** to choose more countries.
   - **Co-organizers tab** – If desired, enter the name or email address of attendees whom you would like to become co-organizers of the meeting.
   - **Password tab** – If desired, enable the "Require meeting password" check box and enter a password. Attendees must enter the password in order to join the meeting.

4. Click **Save** when finished. The new meeting will then be available from the My Meeting page.
5. In the Invite people window, click **Copy** to copy the information to your clipboard and paste it into an email, calendar invitation or web page.
Schedule a Meeting with the Outlook Plug-in

The GoToMeeting Outlook plug-in allows you to schedule and manage GoToMeeting sessions directly from your Outlook calendar. If you then update or reschedule the appointment on your calendar, the associated meeting will be rescheduled as well.

**IMPORTANT:** If you wish to use the GoToMeeting Outlook plug-in, it is highly recommended that you only schedule, update and/or cancel meetings in Outlook. This is because while all changes you make in the plug-in are automatically reflected in the web portal, changes made in the web portal are not duplicated in the Outlook plug-in. In addition, any rescheduling for meetings while in Outlook offline mode will not appear in the GoToMeeting admin site.

**Notes:** The Outlook Plug-in automatically uses your default audio settings when scheduling meetings. See Install the GoToMeeting Outlook Plugin for single machine and admin silent mode installation instructions.

Schedule a meeting via Outlook

1. **Create** a new meeting or appointment.
2. On the Meeting tab in the Ribbon, click **Add Meeting**. If prompted, sign in with your GoToMeeting credentials.
3. Session information for a new meeting (including join links and dial-in numbers) will be automatically populated in the body of the email.
4. Use the Outlook fields to specify the subject, date and start/end times.
5. Invite attendees by adding their email addresses in the To field. Click **Invite Attendees** in the ribbon if the To field is not displayed.
6. Click **Send** when finished.
Edit a meeting via Outlook

You can easily update any sessions that you originally scheduled via the Outlook plug-in.

**Note:** If a meeting was scheduled via the web app or desktop application, updating it in your Outlook calendar will not automatically update it in the GoToMeeting web app.

1. Open the desired appointment on your Outlook calendar.
2. Update the date, time, subject and/or attendees as desired.
3. Click **Send Update** when finished.

Remove a meeting from an Outlook appointment

If needed, you can remove the session information from an appointment without canceling the appointment altogether. This will keep the appointment on your calendar (and those of your attendees), but it will remove the meeting from the GoToMeeting system.

1. Open the desired appointment on your Outlook calendar.
2. In the Ribbon, click **Remove Meeting**.
3. Click **Send Update** when finished.
Configure a Proxy for the GoToMeeting Outlook Plug-in

The GoToMeeting Outlook plug-in supports proxies via Internet Explorer or the Control Panel. Currently, the following are supported:

- Proxy without login
- Proxy with login via User Name/Password

You can configure your proxy by following the below steps:

1. Open your Windows menu and click Control Panel.
2. Click the drop-down menu and select **Network and Internet**.

3. Click **Internet Options**.
4. Under the Connections tab, click **LAN Settings**.
5. Under Proxy server, enter your proxy address and port to activate the proxy and hit **OK**.

6. The next time you open your Outlook and click the **Add Meeting** button, enter your log-in information to use the proxy. Be sure to check the “Remember my credentials” check box so you will not have to enter your information again. Then click **OK**.
**Schedule a Meeting in Google Calendar**

The GoToMeeting Extension for Google Calendar supports both GoToMeeting and GoToMeeting Free. The extension lets you start and schedule meetings directly from your Google calendar. You can then email meeting invitations directly to your contacts. See [Install the GoToMeeting Extension for Google Calendar](#) to install the extension.

1. In your calendar, click the desired time slot and select **Create an event**.

   ![Create an event](image)

2. The event is added to calendar. Click the title of the event to open it.

3. The GoToMeeting extension displays under **Event details**. If you are not logged in, you will see the GoToMeeting Free extension:

   ![GoToMeeting Free](image)

   Click **Add** to add a scheduled GoToMeeting Free meeting to the event. GoToMeeting Free is limited to two additional attendees. [Skip below to view the invitation and scheduled event](#).
4. Click **Sign in to GoToMeeting PRO** to add the event using your account. Enter your GoToMeeting account user name and password and click **Login**.

5. If this is the first time you have logged in through Google Calendar, the extension requests access to your GoToMeeting profile. Click **Allow**.

6. Click **Add** to add the event using your GoToMeeting account:

7. Once you have added the event in either GoToMeeting or GoToMeeting Free, the detailed invitation text displays in the Description box that will be included in emails to invitees.
The audio settings for the meeting defaults to those set in your account in the Citrix portal. See Modify audio settings to change these in your GoToMeeting account from right inside your Google Calendar event.

8. Click **Save** to save the event. If you have invitees identified in the event, the Send invitations? query displays. Click **Send** to send the invites.
Modify a Meeting in Google Calendar

In addition to standard changes (guests, locations, times, etc.) on the Google Calendar, you can also modify the GoToMeeting audio settings for the event.

If you are logged into GoToMeeting, any changes you make and complete by clicking Save are reflected in your GoToMeeting account, and can be viewed in your online portal.

GoToMeeting Free

If you are editing a GoToMeeting Free event, the changes are limited to the schedule and guests. You cannot update audio settings.

Modify a meeting

1. In your calendar, double click the meeting you want to edit, or click once and select Edit event. Your meeting data displays.

2. Click the edit icon to modify the audio settings for this event. Basic data about the scheduled event displays. Modify the audio settings for the call as needed:

   - **VoIP** – Your participants can use microphone and speakers to connect to audio through their computer.
   - **Long distance number** – Your participants can use a telephone to dial into the audio conference using a long distance number. You can choose which countries to provide long distance numbers for your attendees.
   - **Toll-free number** – If OpenVoice Integrated is activated on your account, your participants can use a telephone to dial into the audio conference using a toll-free number. You can choose which countries to provide toll-free numbers for your attendees.
   - **Use my own conference call service** – This option is currently disabled.
3. Choose **Save** to save changes for the current meeting. A success message displays. If you are logged into GoToMeeting, the changes are updated in the GoToMeeting portal.

4. You will be prompted to send updates to attendees. Click **Send update** to send the invitation updates or click **Don’t Send** if you do not wish to send an updated event to guests.
Edit a Scheduled Meeting

You can edit a scheduled meeting any time before the start time by simply opening the GoToMeeting desktop application and clicking My Meetings or by logging in to your account from the web and selecting the meeting you want to edit. If you decide to change the date and time of the meeting, remember to notify your attendees of the change – the easiest way to let your attendees know of any changes is to send out a new invitation email.

After 30 days past the scheduled end time, your session will expire, and you won't be able to start or edit it. You will need to schedule a new meeting and send the new invite to your attendees.

Edit a scheduled meeting from the desktop application

1. On a Windows computer, right-click the GoToMeeting daisy icon in your system tray. On a Mac, open GoToMeeting, and select My Meetings. Your scheduled meetings will be displayed.

2. If prompted, enter your email and password, and click Log In.

3. Select the meeting you want to edit, and then click Edit.

4. Make your changes, and click Save.

5. Be sure to contact any previously invited attendees to notify them of the change. If you reschedule a meeting, remember to update your calendar appointment, or send a new invitation email to your attendees.
Edit a scheduled meeting from the web

1. Log in to your GoToMeeting account.
2. Next to the meeting you want to edit, click the Expand icon to open up the toolbar.
3. Click the Edit icon in the toolbar and make changes to the title, date/time, audio or password of your meeting.
   -or-
   Click the name of the meeting you would like to edit.
4. Click Save to save your changes.
5. Be sure to contact any previously invited attendees to notify them of the change. If you reschedule a meeting, remember to update your calendar appointment, or send a new invitation email to your attendees.
Set Default Audio Options

You can set the default audio options for all your future _upcoming_ sessions. Changing your audio options will not affect your previously scheduled sessions – it will only affect future scheduled sessions. You have 2 audio options: Use _built-in audio conferencing_ or _Use my own conference call service_ – you can choose one or the other but not both. If you choose to provide your own conference call service, you must provide your own telephone numbers for participants, and you won’t have access to built-in audio conferencing (VoIP, long distance and toll-free numbers).

Use built-in audio conferencing (VoIP, long distance numbers and toll-free numbers)

If you select _Use built-in audio conferencing_, you can select _VoIP_ or _Long-distance number_ to customize the default audio settings to best fit your needs.

1. Log in to your GoToMeeting account.

2. Click the navigation menu in the right sidebar.

3. Click _Settings_.

4. On the Settings page, select _Use built-in audio_. You can select both _VoIP_ and _Long-distance number_, or you can select one of the options.

   • _VoIP_ – Your participants can use microphone and speakers to connect to audio through their computer.

   • _Long distance number_ – Your participants can use a telephone to dial in to the audio conference using a long distance number. You can choose which countries to provide long distance numbers for your attendees.

   • _Toll-free number_ – Your participants can use a telephone to dial in to the audio conference using a toll-free number. You can choose which countries to provide toll-free numbers for your attendees.

5. When you're done, click _Save_.

© 2015 Citrix, LLC. All rights reserved.
**Use my own conference call service**

1. [Log in](#) to your GoToMeeting account.
2. Click the navigation menu in the right sidebar.
3. Click **Settings**.
4. On the Settings page, select the **Use my own conference call service** option. Choosing this option disables the built-in audio conferencing option.
5. Enter your own conference call info into the "Enter your conference call info" field, and then click **Save**.
OpenVoice Integrated Toll-Free Audio Service

Organizers can host meetings using OpenVoice integrated audio, which allows them to provide VoIP, toll (long distance) numbers and/or toll-free numbers.

OpenVoice integrated toll-free audio service must be purchased separately from your GoToMeeting plan. If you have a GoToMeeting corporate plan and your billing address is based in the U.S., U.K., Canada or Australia, you may purchase OpenVoice integrated toll-free audio online.

Organizers incur per-minute changes for each attendee who uses the OpenVoice integrated toll-free audio service.
Integrate GoToMeeting with Microsoft Outlook

The GoToMeeting Outlook Toolbar gives organizers on Windows computers with Microsoft Office 2002 or later quick and easy access to GoToMeeting’s features within Outlook.

Add the GoToMeeting Toolbar (Windows only)

1. Right-click the GoToMeeting daisy icon in the system tray, and select Preferences.
2. On the Integrations tab, select "Use GoToMeeting with" and then "Microsoft Outlook", as well as any other applications you would like integrated with GoToMeeting.
3. Click OK. You may need to close and restart any programs you selected for the GoToMeeting Toolbar to appear.
Use GoToMeeting with Outlook (Windows only)

1. Once you've **added the GoToMeeting Toolbar** from Preferences, open Microsoft Outlook.

2. Depending on which version of Outlook you have, you may be able to access the GoToMeeting Toolbar from the Outlook ribbon, or you may need to first select **Add-Ins** from the Outlook ribbon to see the GoToMeeting menu items. If you don't see the GoToMeeting Toolbar Add-In, **enable Add-Ins in Outlook**.

3. Whenever you'd like to host or join a session, simply use one of the following options to do so from within Outlook:
   - Host a Meeting
   - Join a Meeting
   - My Meetings
   - Meet Now
   - Schedule Meeting
Enable Add-Ins in Outlook 2010

3. In the Outlook Options window, select Add-Ins from the left navigation.
4. In the Inactive Application Add-ins section, select GoToMeeting Outlook COM Addin > Go.
5. In the COM Add-Ins window, select the "GoToMeeting Outlook COM Addin" check box, and then click OK.
Enable Add-Ins in Outlook 2007

2. Select the Tools menu > Trust Center.
3. In the Trust Center window, click Add-ins.
4. From the Manage drop-down menu, select GoToMeeting Outlook COM Addin > Go.
5. In the COM Add-Ins section, select the "GoToMeeting Outlook COM Addin" check box, and click OK.

Enable Add-Ins in Outlook 2003

2. Select the Help menu > About Microsoft Office Outlook.
3. Select the Disabled Items button.
4. Choose the GoToMeeting Outlook COM Add-in, and click Enable.
Add a Custom Logo

You can add a custom logo to your meetings, which attendees will see when a screen is not being shared.

Upload a custom logo for meetings

1. Log in to your online account.
2. Click the Menu icon in the top navigation, then select Settings.
4. Browse for and select the desired image, then click **Open**. Your logo can be up to 400 x 200 pixels and 100KB in size in either .GIF or .JPG format.

5. Click **Save** when finished.
Create a Personalized Meeting Page

You can create a personalized meeting page and URL (www.gotomeet.me/<text>) from which you can launch a recurring meeting and attendees can join it without needing the Meeting ID.

Note: The GoToMeet.Me program is currently in beta. Customers with GoToMeet.Me pages will notice many changes as the beta development progresses. If you attempt to sign up using your existing GoToMeeting credentials but encounter a login error prompting you to check your username and password, your account is not yet compatible.

Create a personalized meeting page

1. Log in to your GoToMeeting account.
2. Select Settings in the Navigation Menu.
3. Click Let’s Get Started in the “Personalize Your Meeting” section
4. On the Reserve Your URL page, create your personalized meeting URL by entering the text you would like at the end of the URL.

5. Click Reserve.

6. If the name is available, you will see a check mark next to the box. If the name is already taken, you will see a message telling you to enter a different name.

7. On the Profile page, fill out the additional profile information you would like displayed on your meeting page, such as your professional title, your location and your business URL.

   Make sure that the URL is complete (as in http://www.gotomeeting.com and not just gotomeeting.com)

   Click on the default Avatar to add a personal profile picture.
8. When you are done, click **Save**.

9. Your personalized meeting page is completed!

10. Your personalized meeting is listed in the header section of My Meetings Page.

11. Type in your meeting URL (http://gotomeet.me/<your name>) to test the page. If you ever forget your URL, log in to your account and see the personal meeting link displayed below your personal Meeting Name.

**Start a personalized meeting**

You can either start a personalized meeting from your account or your personalized URL.

**To start from your account:**

1. Log in to http://gotomeeting.com using your GoToMeeting credentials.
2. Click **Start**

**To start from your personalized URL:**

1. Type in your personalized meeting URL in any browser.
2. Click Join My Meeting.

You will be prompted to log in with your GoToMeeting credentials to start the meeting.
Edit a personalized meeting page

1. Log in to your GoToMeeting account.
2. Select Settings in the Navigation menu.
3. Click Edit next to your personalized meeting URL.
4. You can change any of the information displayed on your Profile page – except your meeting URL.
5. Click Done when you are finished.

Invite attendees to a personalized meeting

1. Click the Share button next to the meeting.
2. Click Copy to copy the invitation.
3. Paste the copied invitation to an email or calendar invitation.
View Scheduled Meetings

Your scheduled meetings are first displayed on the My Meetings page when you log in to your account, as well as in the GoToMeeting desktop application.

View scheduled meetings from the desktop application

1. On a Windows computer, right-click the GoToMeeting daisy icon in your system tray. On a Mac, open GoToMeeting, and select My Meetings.
2. If prompted, enter your email and password, and click Log In.
3. The My Meetings window appears listing all your scheduled meetings. You can start, edit or delete a meeting, as well as schedule new meetings.
View scheduled meetings from the web

1. **Log in** to your GoToMeeting account.

2. The My Meetings page displays a list of your scheduled meetings, along with meetings that are currently in-session. The meeting subject, start date and start time are displayed.
To view the Meeting Invitation, click Expand icon and then the Invite icon. You can click **Copy Invitation** to copy the invitation and send it to attendees.
**Start a Scheduled Meeting**

You can start a scheduled session from the web or from your desktop if you have GoToMeeting installed. You can also start a meeting from Google Calendar if you have the GoToMeeting extension installed.

**Start a scheduled meeting from the desktop application**

1. If you already have GoToMeeting installed on your computer, you can right-click the GoToMeeting daisy icon 🌼 in your system tray, and select **My Meetings**.

2. If prompted, enter your email and password, and click **Log In**.

3. Click **Start** next to the session you want to begin hosting.

You should see the **Control Panel** on the right side of your screen, which you can use to manage the meeting.
Start a scheduled meeting from the web

1. **Log in** to your GoToMeeting account.

2. On the My Meetings page, click **Start** next to the meeting you want to host. Or, on a Windows computer, you can right-click the GoToMeeting daisy icon in the system tray, and select **My Meetings > Start**.

3. To start the meeting, enter your email address and password, and then click **Log In**. You should see the **Control Panel** on the right side of your screen, which you can use to manage the meeting.
Start a scheduled meeting from Google Calendar

1. In Google Calendar, open the meeting you want to start.
2. Click Start Meeting.

3. For GoToMeeting Free, and if you are already logged in to GoToMeeting, the meeting starts. The GoToMeeting Control Panel displays on the right side of your screen, which you can use to manage the meeting. Otherwise, login to start the meeting.
Start Instant Meetings

You can start an unscheduled meeting any time you want using the desktop software, web account or our mobile apps.

Start a Meet Now from the desktop application

1. On a Windows computer, right-click the GoToMeeting daisy icon in your system tray. On a Mac, open GoToMeeting.
2. Select Meet Now.

3. If prompted, enter your email and password, and click Log In. You can select the “Remember me on this computer” check box, so you don't have to keep logging in every time you want to start a meeting.

GoToMeeting automatically launches the session with your Control Panel appearing on the right side of your screen.

4. Click Invite Others on the Control Panel to send the meeting information to your attendees.
Start a Meet Now from the web

1. **Log in** to your GoToMeeting account.
2. On the My Meetings page, click **Meet Now**.

   GoToMeeting automatically launches the session.
3. Click **Invite Others** on the Control Panel to send the meeting information to your attendees.

Start a Meet Now from Outlook

1. Once you've added the [GoToMeeting Toolbar](#) to Outlook, open Outlook, and select **Add-Ins** from the banner.
2. Using the GoToMeeting Toolbar, select **Meet Now**.

   GoToMeeting automatically launches the session.
3. An invitation email should automatically pop up in Outlook. Send the invite to your attendees.
Embed a Meet Now Button on Your Website

You can embed a GoToMeeting "Meet Now" button onto your website, so your attendees can easily join scheduled or instant meetings. Just copy any of the HTML codes below and paste it into the source code of the web page where you'd like to embed the button.

Add a Meet Now button

1. Copy any of the HTML codes below and paste it into the source code of your web page.

<table>
<thead>
<tr>
<th>Large Gray Button</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="http://www.citrixonlinecdn.com/dtsimages/im/support/en/Large_160X80.png" alt="Large Gray Button" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Small White Button</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="http://www.citrixonlinecdn.com/dtsimages/im/support/en/Small_120X60.png" alt="Small White Button" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Gray Button with Meeting ID Field</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="http://www.citrixonlinecdn.com/dtsimages/im/support/en/meetNowG.js" alt="Gray Button with Meeting ID Field" /></td>
</tr>
</tbody>
</table>
2. Schedule a meeting or start an instant meeting. Then invite attendees to join your meeting.

3. You can then instruct your attendees to visit your website and click the **Meet Now** button to join the meeting. They can also join by clicking the Join URL from the invite.

   • If your attendees click one of the buttons without the Meeting ID field, they'll be redirected to the **Join a Meeting web page** where they can enter the 9-digit Meeting ID and click **Join a Meeting** to enter.

   • If your attendees click one of the buttons with the Meeting ID field, they should be seamlessly launched into the meeting after entering the Meeting ID.
**View Meeting History**

You can view meeting history data to see information on your past meetings (date, time, title, duration and attendees). Meeting history data is stored for 90 days after a meeting’s scheduled end date. If you’re on a GoToMeeting corporate plan, meeting history is stored for up to 12 months.

1. **Log in** to your GoToMeeting account.
2. On the My Meetings page, click the Meeting History column.
3. You can use the dates at the top of the page to select a date range for past meetings.
View Attendee Details

1. On the Meeting History column, select the number in the Attendees column to view attendee details (i.e., name, email address and join and leave times) for a session.

2. To export the attendee data to Excel (.XLS), click the **Export to Excel** button.
Cancel a Meeting

You can edit or delete a scheduled meeting from the GoToMeeting desktop application or from the web.

Cancel a scheduled meeting from the desktop application

1. On a Windows computer, right-click the GoToMeeting daisy icon in your system tray. On a Mac, open GoToMeeting, and select My Meetings. Your scheduled meetings will be displayed.

2. Select the meeting you wish to delete.

3. Select Delete. When prompted to delete the meeting, click OK. Remember to manually delete the meeting from your calendar.

![My Meetings - GoToMeeting](image)
Cancel a scheduled meeting from the web

1. **Log in** to your GoToMeeting account.
2. Click the Expand icon *** to open up the toolbar next to the meeting you would like to cancel.
3. Select Trash icon 🗑️.
4. Click the **Yes** on the Delete Meeting dialog. Remember to cancel or delete the meeting from your calendar.
Mobile Devices

Join, Schedule, and Start Meetings via iOS

You can download the GoToMeeting app for iOS to use GoToMeeting from anywhere. Then learn more about the features offered while in session.
Join a session from the app

1. Download the GoToMeeting app from the App Store.
2. Open it and tap Join a Meeting.
3. Find the correct session in either of the following ways:
   - Enter the meeting ID provided by the organizer, then tap Join.
   - Tap the desired session under My Meetings (if you have the app connected to your calendar).
4. You will be automatically launched into session. See Use iOS Session Features to learn about what you can do during a session.
Schedule a meeting from the app

1. Download and open the GoToMeeting app from the App Store.
2. Tap Sign In and enter your GoToMeeting login and password.
3. Tap My Meetings in the lower toolbar, then tap the Add icon in the upper toolbar.

4. Use the available fields to configure your new meeting, as follows:
   - **Subject** – Enter a name for the meeting.
   - **Recurring meeting** – Tap this switch to toggle between a single meeting and series.
   - **Starts/Ends** – Tap this field to select the date and time of the meeting.
   - **Audio** – Tap to select which audio options should be available to attendees.
   - **Password** – To password-protect the meeting, enter a password in this field.

5. Tap **Done** in the upper toolbar when finished.
6. A pop-up message will confirm that the meeting was scheduled successfully. Tap **Send Invitation** to invite attendees, or tap **OK** to exit without sending invitations.

Start an instant meeting

1. Sign in to the GoToMeeting app and tap **My Meetings**.
2. **Meet Now** at the bottom of the page.
3. You will be automatically launched into session!

Start a scheduled meeting

1. Sign in to the GoToMeeting app and tap **My Meetings**.
2. Tap the desired meeting, then tap **Start**.
3. You will be automatically launched into session!
Invite attendees (before a meeting)

1. Sign in to the GoToMeeting app and tap **My Meetings**.
2. Tap the desired meeting, then tap **Send Invitation**.

3. Select the desired option, as follows:
   - *Calendar Invitation* – This will open a new event (using the Calendar app) with the meeting details pre-populated. You can add Invitees, then tap **Done**.
   - *Email* – This will open a new email (using the Mail app) with the meeting details pre-populated. You can add email recipients, then tap Send.
   - *Message* – This will open a new Message (using the Messages app) with the meeting details pre-populated. You can add recipients, then tap Send.
   - *Copy to Clipboard* – This will copy the meeting details to your clipboard, which you can then paste wherever desired (e.g., Notes app shown below).
Edit a scheduled meeting

1. Sign in to the GoToMeeting app and tap **My Meetings**.
2. Tap **Edit** in the upper toolbar.
3. Tap the meeting that you want to modify to open the meeting details.
4. Make the desired changes, then tap **Done**.

Cancel a scheduled meeting

1. Sign in to the GoToMeeting app and tap **My Meetings**.
2. Tap **Edit** in the upper toolbar.
3. Tap the Delete icon next to the desired meeting.
4. Tap **Delete** to permanently delete (i.e., cancel) the meeting. **Caution**: This cannot be undone!
**Start, Schedule and Manage Meetings from an Android device**

**Schedule a meeting from an Android device**

1. Open the GoToMeeting app for Android and log in to your account from the Host tab. If you don't already have the app installed, [download the free GoToMeeting app for Android](#).

2. Tap the **Schedule a Meeting** button on the Meetings screen.

3. You can then select whether or not it is a recurring meeting, choose the audio and edit the phone numbers.

4. When you're done, tap **Schedule**.
Edit a scheduled meeting from an Android device

1. Open the GoToMeeting app for Android and log in to your account from the Host tab. If you don’t already have the app installed, download the free GoToMeeting app for Android.
2. Tap the name of the meeting you would like to edit. Then tap Edit.
3. You can then edit the name of the meeting, the start date and time and the audio for that meeting.
4. When you're finished making changes, tap Save.
View scheduled meetings from an Android device

1. Open the GoToMeeting app for Android and log in to your account from the Host tab. If you don’t already have the app installed, download the free GoToMeeting app for Android.

2. Your previously scheduled meetings will appear. Remember that you can only start meetings that you previously scheduled from your Windows or Mac desktop on your Android device.
Invite others from an Android device before a meeting

1. Open the GoToMeeting app for Android and log in to your account from the Host tab. If you don't already have the app installed, download the free GoToMeeting app for Android.

2. Tap the name of the meeting and then tap the Invite button. You can choose to send an email invitation through any email application installed on your Android device.
Start scheduled meetings from an Android device

1. Open the GoToMeeting app for Android and log in to your account from the Host tab. If you don’t already have the app installed, download the free GoToMeeting app for Android.

2. Your previously scheduled meetings should appear. Remember that you can only start meetings that you previously scheduled from your Windows or Mac desktop on your Android device.

3. Select the meeting you want to start and click Start when prompted.

Cancel a scheduled meeting from an Android device

1. Open the GoToMeeting app for Android and log in to your account from the Host tab. If you don’t already have the app installed, download the free GoToMeeting app for Android.

2. Tap the name of the meeting you would like to delete and then tap the Delete button.

3. When prompted to delete the meeting, tap Delete.
Start a Meet Now from an Android device

1. Open the GoToMeeting app for Android and log in to your account from the Host tab. If you don't already have the app installed, download the free GoToMeeting app for Android.

2. If you've previously scheduled meetings from your Windows or Mac desktop, they should appear. To start an instant meeting, tap Meet Now.
GoToMeeting App for Android Permissions

When you install the GoToMeeting app for Android on your device, the app will request permission to access different features on your Android device to run properly. While some of the permissions may sound scary, keep in mind that almost all apps require certain permissions to run features. Below is a table of the features that the app is requesting permission to, with an explanation of why the GoToMeeting app is requesting permission for this specific feature.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pair with Bluetooth devices</td>
<td>Access Bluetooth devices for pairing</td>
</tr>
<tr>
<td>Directly call phone numbers</td>
<td>Access phone numbers to make direct calls</td>
</tr>
<tr>
<td>Read calendar events</td>
<td>Access calendar to view meeting schedule</td>
</tr>
<tr>
<td>Change audio settings</td>
<td>Access microphone for audio adjustments</td>
</tr>
<tr>
<td>Send sticky broadcast</td>
<td>Access broadcast for sending sticky messages</td>
</tr>
<tr>
<td>View network connections</td>
<td>Access network connections for monitoring</td>
</tr>
<tr>
<td>Prevent phone from sleeping</td>
<td>Access battery to prevent phone from sleeping</td>
</tr>
</tbody>
</table>

Accepted
<table>
<thead>
<tr>
<th>Feature</th>
<th>How GoToMeeting Uses this Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone calls</td>
<td>The app will use your device's Phone app to dial in to the phone call (should you choose to do so) by tapping the <strong>switch to phone button</strong> in the app's audio tab. The app also reads the state of phone calls to mute or disconnect from the session audio so that the meeting audio does not interrupt your phone call. The app will pair with your Bluetooth device to connect to your audio via Bluetooth.</td>
</tr>
<tr>
<td>Bluetooth</td>
<td>The app will use your network communication to connect to the internet.</td>
</tr>
<tr>
<td>Network communication</td>
<td>The app reads your calendar events to scan for upcoming meetings and display them in the app, enabling you to join with a single touch. This information is used solely to make joining a session easier and quicker.</td>
</tr>
<tr>
<td>Microphone</td>
<td>The app will use your microphone to share your voice with others in the meeting.</td>
</tr>
<tr>
<td>Audio Settings</td>
<td>The app uses information in your audio settings to provide you with optimal audio by switching to different audio settings and controlling your audio devices.</td>
</tr>
<tr>
<td>System Tools</td>
<td>The app uses your system tools to connect to your audio via Bluetooth devices.</td>
</tr>
<tr>
<td>Network communication</td>
<td>The app uses your network communication information to see whether you’re connected to the internet and to handle network disconnections.</td>
</tr>
<tr>
<td>Affects Battery</td>
<td>The app will keep your screen from locking when you are viewing a presenter's screen.</td>
</tr>
</tbody>
</table>

© 2015 Citrix, LLC. All rights reserved.
GoToMeeting App for Windows devices

The GoToMeeting app for Windows phone allows you join GoToMeeting or GoToWebinar sessions from a Windows Phone free of charge. Organizers can also start, schedule and edit meetings directly from the app.

Schedule a meeting

1. Log in to your account from the GoToMeeting app for Windows phone. If you don't already have the app installed, download the free GoToMeeting App for Windows phone and Windows RT/8.
2. Tap the Menu icon at the bottom of the screen.
3. Tap schedule.
4. Enter the information for your meeting and tap the Save icon.
**Edit a scheduled meeting**

1. Log in to your account from the GoToMeeting app.
2. Tap **Join** the top of the screen. You will see all your upcoming meetings.
3. Tap the name of the meeting you would like to edit.
4. Tap **edit the meeting**.
5. You can then edit the name, date, time and audio options for the meeting.
6. Tap the Save icon to save your changes.
View and start scheduled meetings

1. Log in to your account from the GoToMeeting app.
2. Tap Join at the top of the screen. You will see all your upcoming meetings.
3. To start a meeting, tap the name of the meeting you would like to start.
4. Tap Start the Meeting.
Start a Meet Now

1. Log in to your account from the GoToMeeting app.
2. Tap Host at the top of the screen.
3. Tap the Meet now button. A new meeting will begin.

Invite others to join

1. Log in to your account from the GoToMeeting app.
2. Tap Join at the top of the screen. You will see all your upcoming meetings.
3. Tap the meeting you would like to invite people to.
4. Tap invite people.
5. You can then invite people to your meeting via text message, email or social media.
Use iOS Session Features

The GoToMeeting app for iOS allows you to use many of the same features as when you join from the desktop app, including presenting content and sharing and viewing webcams.

Note: Some features are only available for iPads users.

Mute/unmute yourself

- Tap the Mute icon in the toolbar. The icon will turn gray when muted (🔇) and orange when unmuted (🔊).
Mute/unmute attendees

1. Tap the Attendee icon.

2. To mute or unmute a single attendee, click the Audio icon next to their name. Icons will have a red slash through them when attendees are muted.
Share content (iPad only)

Although iPad presenters can't share their entire screen with attendees, they can share specific content in the following ways:

1. Go to the Present Content screen by tapping the Screen Sharing icon and enabling the Present Content toggle.
2. Select one of the following share options. Be sure to tap the Play icon 🎥 in the floating toolbar so that you can share content.

- **Share from the Cloud**
  Open and share a file from your ShareFile or Dropbox account.
• Share from the Browser
  Open and share a web page by entering a URL or tapping the Bookmark icon.
• **Share from the Whiteboard**

  Use [drawing tools](#) to collaborate with attendees on a whiteboard screen.

Stop or pause content sharing (iPad only)

- To pause your shared content, tap the Pause icon in the floating toolbar.

- To completely stop sharing content from the cloud, browser or whiteboard, simply tap the Screen Sharing icon in the top navigation.
Preview, share and stop sharing your webcam (iPad only)

You can use HDFaces to share your iPad’s webcam and view the webcams of others.

- To preview your webcam, tap the Webcam icon in the top navigation.
- To share your webcam, tap Share My Webcam.
- To stop sharing your webcam, tap Stop Sharing My Webcam.
View and rearrange attendee's shared webcams (iPad only)

Tap the Webcam icon in the top navigation, then select one of the following views:

- **All** – All webcams that are being shared will be displayed a floating Viewer. You can drag this around your screen as desired.

- **Talking** – Only the webcam of the person or people currently talking will be shown at the bottom of your screen.

- **None** – All shared webcams will be hidden (this does not hide your shared webcam from attendees).

**Chat with attendees**

You can send chat messages to everyone in the meeting, only the organizers or to a single attendee.

1. Tap the Attendee icon.
2. Tap **Everyone, Organizer(s) Only** or a **specific attendee**.
3. If prompted, tap Chat.
4. Type your chat message, then tap Send.
Make attendees presenter or organizer

1. Tap the Attendee icon.
2. Tap the name of the desired attendee.
3. Select Make Presenter or Make Organizer.

Note: You cannot take back presenter control manually. The current presenter must instead transfer it back to you once they are finished.

Invite attendees to the session

1. Tap the Attendee icon.
2. Select Invite Others from the drop-down menu.
3. Select Email, Message or Copy to Clipboard to send the meeting information.
Use Drawing Tools (iPad only)

**Note:** Only the current presenter can use drawing tools.

1. As the presenter, make sure you've tapped the Play icon 🎬 in the toolbar so that you can share content.

2. Then tap the Drawing Tools icon 🎨 in the Grab Tab to expand and display the main controls. You may use Drawing Tools on any screen you're sharing.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎨</td>
<td>The Drawing Tools icon turns Drawing Tools on or off. When Drawing tools are on, the Drawing Tools icon is blue and the Drawing Tools toolbar is displayed.</td>
</tr>
<tr>
<td>🎬</td>
<td>The Play icon starts content sharing and the Pause icon pauses the screen so attendees will only be able to view the last screen that was displayed.</td>
</tr>
<tr>
<td>🖋</td>
<td>The Pen icon lets you draw and annotate on-screen. You can select different colors and adjust the width of the markings.</td>
</tr>
<tr>
<td>🎨</td>
<td>The Highlighter icon lets you highlight certain areas of your screen. You can choose from 4 different highlighter colors and adjust the width of the markings.</td>
</tr>
<tr>
<td>🎨</td>
<td>The Whiteboard icon brings the whiteboard to the screen which you can use to draw on a blank slate.</td>
</tr>
<tr>
<td>🕳️</td>
<td>The Undo icon undoes the previous action you made.</td>
</tr>
<tr>
<td>🕳️</td>
<td>The Redo icon redoes whatever action you've previously undone.</td>
</tr>
<tr>
<td>🕳️</td>
<td>The Erase All icon erases all drawings from the screen.</td>
</tr>
</tbody>
</table>

**Leave a session**

Tap the Leave icon ☑️ in the top navigation to leave a session, then select the desired option.

- **End Meeting for Everyone** – Ends the meeting completely and disconnects everyone from the session.
- **Leave Meeting** – Allows the meeting to continue after you leave by making someone else an organizer.
Use Android Session Features

The free GoToMeeting app for Android allows you to interact with others during a meeting, either by inviting attendees, promoting attendees or chatting with other attendees while in session.

Invite others from an Android device during a meeting

1. On an Android device, navigate to the Attendee List tab.

2. Tap the Invite Others icon to send the meeting information.
Make someone a presenter from an Android device

1. From the Attendee List, tap the attendee’s name and select Make Presenter.
Make someone an organizer from an Android device

1. As an organizer on an Android device, navigate to the Attendee List tab from the toolbar.
2. Select the attendee you would like to make co-organizer. Tap **Make Organizer** when prompted.
Chat on an Android device

1. Tap the Chat icon in the toolbar.

2. Select which attendee(s) you'd like to send a message. You can choose someone's name, the entire audience or only presenters.

3. Enter a message in the “Type a message” field and then tap **Send**.
View webcams from an Android device

1. Go to the Settings screen and make sure that the "View webcam" check box is selected.

2. You will automatically see shared webcams while in session. If more than one person is sharing their webcam, you will only see the webcam of the person is currently speaking.
Use Labs from an Android device

Labs features are exciting, new beta features that you can use to enhance your session. When you use a lab feature, you are agreeing to use a feature that has not been fully tested and may still have some bugs.

Opt in to Labs

In order to use lab features, you will have to opt-in to labs.

1. Tap the Labs icon on the Join screen
   -or-
   Go to the Settings screen and tap the Labs button.
2. Slide the Labs button **ON**.

3. Click **Agree** on the Terms of Use screen.

Labs is now turned on and you can use any labs feature by selecting the check box next to the feature.
Use the Dial Out (labs) feature

The dial out feature allows you to call a phone number while in a GoToMeeting session. To use Dial Out within a meeting, you must have labs enabled and the "Dial out" check box must be selected.

1. Once you have enabled Dial out, you can click the **Invite by phone call** button on the Attendee List screen.

2. You can either enter a phone number or click the Address Book icon to access your contacts. Once you have selected a number, you can click the Dial icon.

3. GoToMeeting will then call the new attendee and the new attendee can press 1 to enter the conference or press 0 to disconnect from the conference. You will be notified as to whether or not the new attendee has joined.
Use Windows Session Features

The free GoToMeeting app for Windows phone allows you to interact with others during a meeting, either by inviting attendees, promoting attendees or chatting with other attendees while in session.

Invite others during a meeting

1. On a Windows phone, tap the expand menu icon.

2. Tap invite people.

3. Select one of the following: Messaging, Email or Social Networks to invite someone through one of those mediums.
Chat with others during a session

1. To chat with someone in session, tap the attendees icon on the bottom toolbar.
2. Tap the name of the person you would like to chat with.
3. Tap chat.

Make someone a presenter

1. Tap the attendee icon in the bottom toolbar.
2. Tap the name of the attendee you would like to become presenter.
3. Tap Switch Presenter.

Make someone an organizer

1. Tap the attendee icon in the bottom toolbar.
2. Tap the name of the attendee you would like to promote to organizer.
3. Tap Promote to Organizer.
Share content (Windows 8.1 and Windows RT users only)

When you start a session as an organizer or are promoted to presenter, you will see a Share Content screen where you can share content during a meeting. You will have the option to share content from the web or share content from the whiteboard.
Share content from Cloud or Tablet

1. On the Share Content screen, tap **Share from Cloud or Tablet**.
2. You can then select content from another app on your device, such as Sharefile, DropBox and OneDrive. You can also present content from email attachments.

Share content from the web

1. Click **Share from the Web** on the Share Content screen.
2. Enter a URL into the browser to have attendees see web content.
Share content from the whiteboard

1. Click Share from the Whiteboard on the Share Content screen.
2. Use the available drawing tools to draw content that your attendees can see.
Switch Devices While In Session

If you are running iOS 8 and have the GoToMeeting app for iOS installed, you can seamlessly transition your attendance in a meeting from an iOS device to a Mac OS X 10.10 (Yosemite) computer or a different iOS device (e.g. switch seamlessly from an iPhone to a computer or an iPad).

In order to switch from an iOS to another iOS device or to a Mac computer, Continuity must be enabled. To enable Continuity, please refer to the Continuity support article from Apple.

Switch from an iOS device to a Mac computer

1. While attending a meeting on your iOS device, your computer will detect the meeting from your iOS device if both devices are in the same room.

2. A Safari icon with a mobile phone badge will be displayed on the left side of the main dock. Click on this icon and the desktop version of GoToMeeting will launch and the computer will join the meeting.

Switch from an iOS device to a different iOS device

1. The second iOS device (e.g. iPhone or iPad) will detect your meeting from the first iOS device.

2. If the second device is locked, swipe up on the GoToMeeting icon on the locked screen. The GoToMeeting app will launch and you will automatically join the meeting

   – or –

If the second iOS device is unlocked, double tap the Home button and swipe left until you reach a page with the meeting information. Tap the meeting information to launch the meeting.
**Mobile Feature Comparison**

The GoToMeeting mobile apps offer different features depending on the device's operating system. Use the chart below to see what is available on each app for iOS, Android and Windows devices.

<table>
<thead>
<tr>
<th>Features</th>
<th>iOS</th>
<th>Android</th>
<th>Windows RT</th>
<th>Windows Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join a meeting</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Schedule and start</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>meetings</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>View shared screen</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Invite others</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Promote others to</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>organizer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(iPad only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Promote others to</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>presenter</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(iPad only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chat with attendees</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>View and share</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>webcams</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(iPad only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Share content</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(iPad only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Use drawing tools</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>(iPad only)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Raise your hand</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Answer polls</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Leave a session</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
Join Sessions

Join a Session

You can join meetings from the web, desktop software or a mobile device!

Join a session from a computer
Join from a mobile device

Join a session from a computer

1. Access the meeting in any of the following ways:

- **Invitation email**
  Select the Join URL in your Invitation email. This will launch a new web browser page.

- **Web browser**
  Open a web browser and go to the Join the Meeting page. Enter the meeting ID (listed in your Invitation email), then click Continue.
• Desktop software
  Right-click the daisy icon in the system tray (Windows) or toolbar (Mac). Select Join, enter the meeting ID (listed in your Invitation email), and click OK.

  Note: This method is only available if you already have the GoToMeeting desktop software installed on your computer.

2. Depending on the organizer's account settings (as well as your operating system and web browser), you will be launched into session via the web app or via the desktop software. The desktop software will be automatically installed if needed.

  Note: If you have not yet done so, you will first be prompted to register for the active meeting.

3. Once you're in session, choose one of the audio options provided by the organizer to connect to the audio conference. You can choose your preferred audio option from the Audio pane of your Control Panel.
Join from a mobile device

1. Access the meeting in either of the following ways:

   - **Invitation email**
     Select the Join URL in your Invitation email. This will automatically launch the mobile app (or the app store if you have not yet installed it onto your device).

   - **Mobile app**
     Open the GoToMeeting app, enter the meeting ID and select **Join**. Alternatively, you can select the scheduled meeting from the list that is imported from your phone’s calendar (if available).

2. You will be automatically launched into session. If you have not yet installed the mobile app, you will be instructed to do so. See the following articles for more information:

   - Download the [GoToMeeting app for iOS](https://itunes.apple.com/app/gotomeeting-remote-meetings/id471483582) on the App Store. (See FAQs for more information.)
   - Download the [GoToMeeting app for Android](https://play.google.com/store/apps/details?id=com.citrix.gtmobile&hl=en) on Google Play. (See FAQs for more information.)
   - Download the [GoToMeeting app for Windows Phone](https://www.windowsphone.com/en-us/store/app/gotomeeting-remote-meetings/4601c21c-7f14-4b4e-b3e5-0f303395d243) in the Windows Phone store. (See GoToMeeting FAQs for more information.)
GoToMeeting Web App

Using the GoToMeeting web app, you can join sessions through your web browser (rather than joining via the GoToMeeting desktop app). This provides the following advantages:

- You can get into meetings even faster than with the desktop app (great for when you need to quickly touch base and share your screen).
- If you have software-installation restrictions (e.g., using a company computer or net kiosk), you can still quickly and easily join meetings.
- You can easily switch to the full-featured GoToMeeting desktop app if you want to use additional features.

Note: Once an attendee has updated to the full application, they will use it to join meetings directly rather than first joining via the web app.
Web app features and tools

The GoToMeeting web app allows you to use the following features and tools:

- **Join instantly** without going through a download or installation.
- View the presenter's shared screen.
- **Share** your own screen (if made presenter).*
- **Connect** to the audio conference using your computer's mic and speakers.*
- **Connect** to the audio conference by dialing in via phone.
- **Send** chat messages to other attendees (either privately or to everyone).
- **Mute** and unmute yourself, and **see** which attendees are speaking.
- **Change** the language of the web app.

*Note: The availability of these features depends on the attendee's web browser. Items marked with an asterisk (*) are only available on Google Chrome.

Enable/disable the web app

Organizers must have the web app enabled to provide attendees the ability to join via their web browsers. Once it is enabled, all attendees who do not have the GoToMeeting desktop app or the Citrix Online Launcher application installed on their computer will join sessions via the web app.

1. Click **Settings** in the right navigation.
2. In the "Web app" section, enable or disable the "Attendees will join meetings from the web app" check box.
3. Click **Save** when finished.

*Note: Any change to this setting will affect all future meetings, including those that have already been scheduled.*
Join a session via the web app

When the Web App has been enabled, GoToMeeting will automatically detect the optimal join method for each attendee.

- **If you already have the GoToMeeting desktop app or the Citrix Online Launcher application installed**, then you will join the session using the GoToMeeting desktop app (an updated version will be downloaded if needed).
- **If you have neither of those applications installed**, then you will join directly through your web browser using the GoToMeeting web app.
- **If you cannot install software on your computer**, then you will join the session directly through your web browser using GoToMeeting web app.

See the [GoToMeeting Web App FAQs](#) for more information and system requirements.

Connect to session audio

1. The first time you join a session via web app, you will see a "Select audio" pop-up. You can then select either **Use computer audio** (VoIP) or **Dial in using a phone** (depending on the audio options provided by the organizer). You can switch audio modes at any time during the session.

   **Note:** You will only see this prompt the first time you join. The web browser will then remember your selection for future sessions.

---

**Join via mic and speakers (VoIP)**

**Note:** This feature is only available for attendees using Google Chrome. Attendees using other web browsers must switch to the desktop app in order to use it.

- If you select **Use computer audio**, you will be prompted to allow the browser to use your microphone. Click **Allow** to continue.
• You will then see a “computer audio” pop-up window. You can select which device to use as your mic, then click OK, I'm all set to join the meeting.

Join via phone

• If you select Dial in using a phone, you will see “call in” information. You can select the desired country, use a telephone to dial in to the audio and then click OK, I'm all set.
**Mute/unmute yourself**

You can easily mute or unmute yourself at any time by clicking the Audio button 🎤 in the right navigation. It will turn red 🔄 when muted and green when unmuted 🎤 (i.e., others can hear you).

**Switch audio modes (mic/speakers vs. phone)**

*Note: This feature is only available for attendees using Google Chrome. Attendees using other web browsers must switch to the desktop app in order to use it.*

You can switch between using your mic and speakers (VoIP) and dialing in via phone at any time.

1. Click the Settings icon 🗼 in the right navigation.
2. On the Audio tab, select one of the following (depending on what options the organizer provided):
   - **Computer Audio** – Use the drop-down menu to select which device to use as mic and speakers.
   - **Phone call** – Use the drop-down menu to select which country's audio information should be displayed.
Chat with other attendees

You can send instant chat messages to other attendees during the session.

1. Click the Chat icon in the right navigation.
2. Use the drop-down menu to select the recipients of your message (everyone, organizers only, presenters only or a specific attendee).
3. Enter your message in the text field, then click Send.

Enable/disable speaker notifications

The web app displays a notification in the top right that indicates who is speaking. You can turn these notifications on or off.

1. Click the Settings icon in the right navigation.
2. On the General tab, use the Speaker Notifications toggle to turn notifications on or off.
3. If desired, you can change the opacity of the notification itself so that it doesn't obscure the presenter's screen.
Share your screen (become presenter)

Note: This feature is only available for attendees using Google Chrome. Attendees using other web browsers must switch to the desktop app in order to use it.

You can share your own screen (or a particular application) with the rest of the meeting participants.

1. An organizer must first give you presenter control.

2. You will be notified that you have been given presenter control and that in order to share your screen you must first install an extension. Click Download to continue.

3. You will be prompted to download the GoToMeeting Pro Screensharing extension. Click Add to continue.
4. Once the extension is successfully installed, you can select which portion of your screen to share – either their your screen, or a particular application (all applications currently running will be shown). Click **Share** to continue.

![Screen sharing interface](image)

5. While your screen is being shared, you will see a pop-up window reminding you that other attendees can see your screen. You can click **Hide** to minimize the window if desired.

![Pop-up window](image)

6. You can click **Stop Sharing** on the pop-up window to stop sharing your screen.
Change your name and email address

You can change the name displayed to other attendees in the Control Panel.

1. Click the Attendees icon 🗂️ in the right navigation.
2. Click the Arrow icon next to your name and select Edit name & email.
3. Enter your desired name and email, then click OK.

Change the web app's language

1. Click the Settings icon 🛠️ in the right navigation.
2. On the General tab, use the drop-down menu to select the desired language.
Switch to the desktop app

You can easily switch to the desktop app to use all of the features that GoToMeeting offers.

1. Click the daisy icon 🌻 in the right navigation.
2. Click **Switch to the desktop version**.

The download will begin immediately; see Steps for Installing on Windows or Steps for Installing on Macs for more information.

Limitations of the web app

While the web app allows attendees to use most of the same features and tools as the desktop app, there are some features that are not supported.

- Organizers cannot start meetings using the web app.
- Attendees cannot be promoted to organizer (though they can be **promoted to presenter**).
- Attendees cannot take control of the presenter's mouse and keyboard.
- Attendees cannot use drawing tools.
- Attendees cannot view or share their own webcams. However, they will be notified if webcams are in use so that they can switch to the desktop application (attendees using Chrome will not see this notification).

To use any of the features listed above, attendees can simply **switch to the GoToMeeting desktop app** while in session. Once they have downloaded the web app, they will join all future sessions using the desktop app (unless they uninstall both it and the Citrix Online Launcher application).
Session Features

Original Control Panel (Windows)

The control panel appears on the right side of your screen when you start or join a session. To free up space on your desktop, you can collapse the control panel and use the grab tab to continue to manage your session.

Note: Some users may see the new Control Panel. If your Control Panel looks different than the one shown below, click here.

Available features & tools

- **Screen sharing**: Present a document, PowerPoint presentation or anything else on your computer.
- **Keyboard and Mouse Control**: Give keyboard and mouse control to an attendee so they can control your screen.
- **Co-Organizers**: Make someone a co-organizer so they can share control the session with you.
- **Change Presenter**: Allow someone else to show their screen.
- **Drawing Tools**: Annotate directly on your screen to highlight, call out and draw attention to items on your screen.
- **Attendee List**: View the names of all the meeting attendees.
- **Audio**: Use the audio pane to switch between telephone, mic & speakers and/or conference call numbers (if available).
- **Webcam**: Turn on your webcam to work face to face with attendees.
- **Invite Others**: Click to invite attendees during a session.
- **Chat**: Send and receive chat messages.
- **Recording**: Record the presenter's screen, audio and shared applications during a session, then upload and store the recording for people to view.
- **Leave and End a Session**: Leave or end a session anytime during the session.
Mac Control Panel
New Control Panel and Grab Tab

Some GoToMeeting users may see the new GoToMeeting Control Panel with a redesigned look and feel. This new Control Panel is currently only supported on Windows 7 and Windows 8 in English. If you are not seeing the new Control Panel, click here for information about the regular Control Panel.

Just like the regular Control Panel, the new Control Panel allows you to use the following standard session features:

- **Screen Sharing**: Present a document, PowerPoint presentation or whatever you want to share with the audience.
- **Keyboard and Mouse Control**: Give keyboard and mouse control to someone so they can control your screen.
- **Co-Organizers**: Make someone a co-organizer so that person can present and control the session like you.
- **Change Presenter**: Change presenters so that someone else can show their screen.
- **Attendee List**: View the names of all the participants in-session.
- **Audio**: Use the Audio pane to switch between Telephone, Mic & Speakers and/or Conference Call Numbers (if available).
- **Webcam**: Turn on your webcam to work face to face with attendees.
- **Invite Others**: Invite attendees during a session by emailing the invitation or copying and pasting the join information.
- **Chat**: Send and receive Chat messages in-session.
- **Recording**: Record the presenter's screen, audio and shared applications during a session, then upload and store the recording for people to view.
- **Leave and End a Session**: Leave or end a session anytime during the session.

**Note**: Drawing tools/annotations are not yet available in the new Control Panel.
**Invite Others**

You can invite attendees to join your meetings either before or during the session.

**Invite attendees while in session (new Control Panel)**

1. Expand the Attendees pane.
2. Click the Invite icon 🔄.

3. Use the Invite Others window to invite an individual in any of the following ways:
   - Instruct the individual to go to [www.joingotomeeting.com](http://www.joingotomeeting.com) and enter the meeting ID listed in the window.
   - Click **Email** to launch a new email with the session information automatically populated, then send it to the individual.
   - Click **Copy to Clipboard** to copy the session information to your clipboard, then paste it wherever desired (such as an instant message to the individual).
Invite attendees before a session

1. Log in to your online account.

2. On the My Meetings page, click the Invite icon next to the desired session.

3. Click Copy to Clipboard to copy the session information to your clipboard, then paste it wherever desired (such as an email or an instant message to the individual).
Test your Connection during a Session

Does something feel off with your session? You can test your GoToMeeting connection while in session to find out for sure.

Test your connection in-session (Windows only)

1. While in a session, open Preferences.
2. Click Connection in the left navigation.
3. Under “Test your GoToMeeting connection”, click Test Connection.
4. Under “Test Results”, you'll see one of the following messages:
   - **Passed:** You've established a connection.
   - **Fail:** You haven't established a connection.

Having trouble connecting?

You may need to enter your Windows username and password or domain if you have a proxy that prevents you from connecting to GoToMeeting.

If you don't have a proxy, please check to see that you have the minimum system requirements.
Connect to Session Audio

Depending on the options provided by the session organizer, attendees can connect to session audio using various methods. Participants can also test their audio connection before or after a session if needed.

Note: Organizers can see Manage in-session audio for information about changing audio modes during a session and enabling/disabling chimes and on-hold beeps.

Available audio modes

Organizers can either select one or more of the built-in audio options, or they can provide their own conference call info.

Built-in audio conferencing

- **Computer audio (VoIP):** Participants can connect to audio through their computer's internet connection using a mic and speakers.
- **Conference call:** Participants can use a telephone to dial in to the session audio using toll and/or toll-free phone numbers (depending on the organizer's settings).

Third-party audio conferencing

- **Custom conference call info:** Participants can use a telephone to dial into the session audio using a third-party audio service (provided by the organizer).
Connect via computer audio (VoIP)

Audio quality may vary depending on the audio software, hardware, operating system and Internet connection being used. We recommend using a USB headset plugged directly into the computer and placing the microphone away from other speakers or devices to avoid noise feedback.

**Note:** This feature is only available if enabled by the organizer.

1. First ensure that your mic and speakers are properly plugged in to your computer.

2. Select **Computer audio** as follows:

   - **While in the Hallway**, select the **Computer Audio** option. You can click **Test your sound** to select the right audio hardware.
   - **While in session**, select **Computer audio** on the Audio tab (Options pane). You can use the drop-down menus to select the right audio hardware.
Connect via telephone

Note: This feature is only available if enabled by the organizer.

1. First locate the audio information provided by the organizer. You can find it in any of the following locations:

   - Check the Invitation email sent by the organizer.
   - While in the Waiting Room before a session, select the **Phone call** option.
   - While in a session, go to the Audio tab (Options pane) and select the **Phone call** option.
2. Find the phone number for the desired country.
   - Check the list of phone numbers included in the Invitation email (listed by country).
   - While in the Waiting Room or during the session, use the drop-down menu to select the desired country.

3. Use a telephone to dial the provided phone number.

4. When prompted, enter the Access Code and Audio PIN listed in the session information. See Manage audio via keypad commands (phone mode only) for more information.

   **Note:** If you are having trouble with your audio connection, you can check for alternative phone numbers.

### Connect via custom conference call

If the organizer uses a third-party conference-call service, they may wish to provide their own details about how to connect to the session audio. In this case, their instructions will appear in the Hallway and on the Audio tab (Options page).

**Note:** This feature is only available if enabled by the organizer.
Switch between audio modes

Attendees can switch between the provided audio modes any time during the session by opening the Audio tab (Options pane) and selecting the desired audio mode.

Note: Only those options provided by the organizer will appear. If only one method of connecting was provided, then attendees will not be able to switch to another audio mode.

Manage audio via keypad commands (phone mode only)

When participants are connected via telephone, they can use their phone's keypad to manage the audio of the conference call.

All participants:

- *3 – Turn "on-hold" beeps on or off
- *4 – Hear a menu of keypad commands available to you.
- *6 – Mute or unmute the participants audio.
Organizers only:

- **2** – Hear the number of attendees currently dialed in via telephone.
- **5** – Change the "listening mode" of all attendees; pressing this command repeatedly will cycle through the following modes:
  - Soft mute: All attendees are automatically muted, but they can unmute themselves if desired.
  - Hard mute: All attendees are automatically muted and cannot unmute themselves.
  - Unmute: All attendees are automatically unmuted (default mode).
- **8** – Change the "chime controls"; pressing this command repeatedly will cycle through the following modes:
  - Both entry and exit chimes on (default)
  - Both entry and exit chimes off
  - Only exit chimes on
  - Only entry chimes on

Check for alternative phone numbers

If you are having trouble connecting to the session with the phone number provided in the Options pane, you can check to see if the organizer provided any alternative phone numbers.

1. On the Audio tab (Options pane), click **Problem dialing in?**.
2. A new browser window will open and direct you to the right page.
3. Use the drop-down menu to select the desired country, then use the alternative session information provided to try dialing in again. If you're still having problems connecting, see Audio Help for more information.
Add Co-Organizers

As the scheduling organizer of a session, you can allow other attendees to be co-organizers who can facilitate the session with you.

You can either add an organizer before a session begins (which allows them to start the session on your behalf), or you can promote an attendee to organizer while in session. Co-organizers are able to access all the same features as the scheduling organizer.

If you’re the scheduling organizer, you can make someone a co-organizer so that another participant can present and control the session like you. Attendees can be promoted to organizers in-session but won’t have access to post-session features, such as reporting and sending follow-up emails.

Promote an organizer during a session

Note: Only attendees who joined via the desktop app can be promoted to organizer. Attendees who joined via Web App must switch to the desktop app to be promoted. Mobile attendees cannot become an organizer.

1. In the Attendees pane, right-click the name of the desired attendee and select Make Organizer.

2. You will be prompted to confirm that you wish to promote the attendee to organizers. Click Yes to continue. The attendee will be notified of their new organizer status.
Add a co-organizer before the session

You can make someone a co-organizer before the meeting begins so that they can start the session if you are unable to. You can only add individuals who are also members of your same account.

**Note:** Only organizers with a corporate account can add co-organizers to their session.

1. Log in to your online account.
2. Either schedule a new meeting, or open an existing meeting from the My Meetings page.
3. On the Co-organizers tab, search for a user on your account by entering their first name, last name or email address. Repeat for additional co-organizers.
4. Click Save. You will be prompted to share the meeting invitation with the newly added organizers.
Share Your Screen

You can share your screen during a session, which allows you to present a document, presentation or anything else you’d like to attendees. You can choose to share one or more of your monitors or even a single application. You can also show a clean Windows desktop to hide icons and the task bar, as well as blank out the background, so that the focus remains on the content you are presenting to your attendees.
Share your screen (new Control Panel)

1. You can begin screen sharing in either of the following ways:

   • Click the Screen button in the Control Panel or Grab Tab.

   **Note:** Using this button will automatically share the entire screen of your main monitor. If you wish to share a more specific item with attendees, use the option below.

   • On the Screen tab (in the Options pane), use the "Start sharing my" drop-down menu to select the portion of your screen you would like to share, as follows:
     - *Screen of main monitor, secondary monitor or both monitors* – This shares the entire screen of one or both of your monitors (if more than one is configured). Be sure to close any windows you do not want to share before proceeding.
     - *Screen of main monitor, secondary monitor or both monitors (CLEAN)* – This shares your screen, but also hides your background, task bar and desktop icons. Be sure to close any windows you do not want to share before proceeding.
     - *Application* – This shares only the specific application that you select and hides the rest of your screen (available for Windows Presenters only).

2. The Screen icon at the top of the Control Panel will glow green when your screen is being shared with other attendees.
Pause/restart screen sharing (new Control Panel)

Pausing screen sharing will freeze the image of the screen that attendees see.

1. Hover over the Screen button in the Control Panel or Grab Tab so that the Pause button appears.

   - Click the Pause button to pause screen sharing. The Screen icon will start flashing when screen sharing is paused.

   - Click the Play button to restart screen sharing.

Stop sharing your screen (new Control Panel)

When you stop screen sharing, attendees will see the Hallway again and a message that the organizer's screen is not being shared.

1. Click the Screen button in the Control Panel or Grab Tab.
**Share Your Webcam**

You can share your webcams with other attendees using high-definition video conferencing. Up to 6 different webcams can be shared during a session. All you need is an internet connection and a webcam to begin enjoying a telepresence-quality experience!
Preview your webcam (**new Control Panel**)

Put your best face forward and get ready for business! You can preview how others will see you, what’s around you or behind you, and ensure that others see only what you want them to see before your share your webcam.

- Select the **Webcam tab** in the Options pane to see a preview.
- Once you share your webcam, a blue highlight will appear around the webcam box and the "Preview" header will disappear.

---

© 2015 Citrix, LLC. All rights reserved. 183
Share your webcam (new Control Panel)

There are multiple places on the Control Panel and grab tab where you can turn on your webcam, as follows:

- Click the Webcam button 📹 at the top of the Control Panel or in the grab tab.
- Click the More icon • • • on the Webcam tab (Options pane) and select Share My Webcam.
- Click the Webcam icon ▶ next to your name in the Attendee pane.
- Right-click your name in the Attendee pane and select Share My Webcam.
Pause/restart sharing your webcam (new Control Panel)

When you pause webcam sharing, other attendees will still see the webcam box with your name, but the screen will be blacked out until you resume sharing. This does not free up a webcam spot (e.g., if all 6 webcam spots are filled, another attendee will not be able to start sharing their webcam).

- Hover over the Webcam button at the top of the Control Panel, then click the Pause button. Click the Play button to restart sharing.
- Click the Pause icon at the top of your webcam box in the Viewer. Click the Play icon to restart sharing.
Stop sharing your webcam (new Control Panel)

When you stop webcam sharing, your webcam box will disappear and the webcam spot will be freed for another attendee to share their own webcam.

- Click the Webcam button at the top of the Control Panel or in the grab tab.
- Click the More icon on the Webcam tab (Options pane) and select Stop Sharing My Webcam.
- Click the Webcam icon next to your name in the Attendee pane.
- Right-click your name in the Attendee pane and select Stop Sharing My Webcam.
- Click the Webcams menu in the Viewer, then select Stop Sharing My Webcam.
- Click the Stop icon at the top of your webcam box in the Viewer.

See Share your webcam (new Control Panel) for information about restarting webcam sharing after it's been stopped.
Hide/show all webcams or your own webcam (new Control Panel)

Hiding webcams does not pause or stop webcam sharing; it simply hides all webcams currently being shared (or just your own) so that they do not take up space in the Viewer. Keep in mind that if you are sharing your webcam and then hide all webcams or your own webcam, other attendees will still be able to see you.

1. Access the drop-down menu in either of the following ways:
   - On the Control Panel, go to the Options pane > Webcam tab and click the Options icon.
   - In the Viewer, click Webcams in the top-right.

2. Select the desired option:
   - To hide all webcams, click Hide Webcams.
   - To hide only your own webcam, click Hide My Webcams.

Use the same process and select Show All Webcams or Show My Webcam to display them again.
Start or stop webcam sharing for other attendees (new Control Panel)

Note: This feature is available to organizers and co-organizers only.

Organizers can send webcam requests to attendees in any of the following ways:

- Click the Webcam column on the Attendee List.
- Right-click an attendee's name from the Attendee List, and select Send Webcam Request from the drop-down menu.

Organizers can turn off attendee webcams in any of the following ways:

- Click the Webcam icon next to an attendee's name. Attendees will see a yellow tool tip or dialog indicating that the organizer has closed their webcam feed.
- Right-click an attendee's name from the Attendee list, and select Stop Webcam Sharing.
Share or stop webcams from the Control Panel

You and your attendees can share webcams in any of the following ways:

- Click the Webcam icon on the Grab Tab.
- Click the Share My Webcam button in the Webcam pane on the Control Panel.
- Select Share My Webcam from the Webcams drop-down menu.
- Click the Webcam icon next to your name in the Attendee List (Windows only).
- Right-click your own name in the Attendee List, and select Share My Webcam.

Organizers can send webcam requests to attendees in any of the following ways:

- Click the Webcam column on the Attendee List.
- Right-click an attendee's name from the Attendee List, and select Send Webcam Request from the drop-down menu.
Organizers can turn off attendee webcams in any of the following ways:

- Click the Webcam icon next to an attendee's name. Attendees will see a yellow tool tip or dialog indicating that the organizer has closed their webcam feed.
- Right-click an attendee’s name from the Attendee list, and select Stop Webcam Sharing.

Manage your webcam from your video feed

- Temporarily Pause/Play your video by selecting the Pause icon or Play icon on the top-right corner of your webcam feed. (a)
- Resize the webcam Viewer and Screen Sharing using the slider. You can click and drag any part of the slider to adjust the display. (b)
- When only webcams are being shared, participants can resize webcams by clicking and dragging the bottom-right corner of the Viewer. Expand and minimize how webcams and/or screen sharing is displayed by clicking and dragging the bottom-right corner of the Viewer.
  - If only webcams are being shared, you can adjust the size and position of the webcam Viewer from the Webcams drop-down menu by selecting one of the following Webcam Positions:
    - Top
    - Left
    - Bottom
    - Right

Toggle the webcam layouts

Attendees can change the webcam position from the Webcams drop-down menu located in the top-left corner of the viewer or the Webcam pane in the Control Panel (only available when both webcams and Screen Sharing are enabled).

- Share My Webcam - Shares your own webcam.
- Stop Sharing My Webcam - Stops broadcasting your own webcam.
- Hide Webcams - Hides the webcam viewer but still broadcasts your webcam feed to other attendees.
• **Always in Front** - Keeps webcams on top of all other applications and windows (only available for Windows organizers and all Mac participants). Hiding webcams decrease bandwidth consumption.

![Webcam options](image)

**Remove webcams for all participants**

From the Options menu, organizers can uncheck the **Attendees Can Share Webcams** setting to remove the option for all participants to share webcams.

![Options menu](image)
Manage your webcam settings

1. Open the File menu > Preferences > Webcam. Or, right-click the GoToMeeting daisy icon from your system tray, and select Preferences > Webcam.

2. From your Webcam Preferences, you can view the following:

- **Your camera** – Shows the make and model of your detected webcam.
- **Select a display format** – Adjusts the aspect ratios of webcam feeds. 4:3 is the normal display and 16:9 is the widescreen display.
- **Advanced** – Modifies your hardware settings from within GoToMeeting. Customizable options depend on your webcam manufacturer.
Record a Session

You can record any session and then store the recording for attendees to view at a later time. When a session is recorded, then the presenter's screen, the audio and any shared applications are recorded. Recording is enabled by default, but if you previously disabled it then you must first adjust your recording settings before you can record a session.

Note: Session recording is not supported for GoToMeeting Essentials organizers.

Get started with session recording

Successfully using session recording requires a series of steps on the part of the organizer. Use the steps below to set up and use session recording.

1. Record sessions: You can start and stop recording during meetings.

2. Convert recordings: After each recorded session, the recording file is saved to the specified location in .G2M format. You must then convert the recording into a downloadable format (.WMV or .MP4).

Start/stop recording a session (new Control Panel)

Note: We recommend having 2 organizers record the session in case 1 organizer encounters any issues that may potentially disrupt the recording.

1. Ensure that you are sharing your screen, application and/or webcam.

2. At the bottom of your Control Panel, click Record this meeting. The Recording icon will glow and attendees will see a notification that the session is being recorded at the bottom of their Control Panel.

Note: At least 500MB of free space must be available to record a session in GoToMeeting format, and at least 1GB of free storage space for Windows Media Player and .MOV format. If the recording space drops below 100MB, the recording automatically stops.

3. Click Stop recording to temporarily pause or stop recording altogether. If desired, you can click Restart recording to start recording again.

4. Once you end the session, you will be prompted to convert it using the GoToMeeting Recording Manager. You must convert session recordings in order to view them later.
Start/stop recording a session (original Control Panel)

Note: We recommend having 2 organizers record the session in case 1 organizer encounters any issues that may potentially disrupt the recording.

1. Ensure that you are sharing your screen, application and/or webcam if needed.

2. To start recording a session, click the Start Recording button in the Screen Sharing pane of the Control Panel. If you do not see the button, click View > Recording in the Control Panel menu.

   ![Start Recording Button](image)

   Note: The free storage space available in the saved recording file location is displayed next to the button. At least 500MB of free space must be available to record a session in GoToMeeting format, and at least 1GB of free storage space for Windows Media Player and .mov format. If the recording space drops below 100MB, the recording automatically stops.

3. The button will change to Stop Recording in your Control Panel. All attendees in the session will see a "This session is being recorded" notification at the bottom of their Control Panel.

   ![Stop Recording Notification](image)

   ![Stop Recording Button](image)

   Note: The recording may take some time to process and convert, depending on which recording media format you chose. If you didn't choose a location to save your recording to before the session started, the recording file is located in the My Documents folder by default.

4. To stop recording a session, click the Stop Recording button to temporarily pause or stop recording altogether. If you do not see the button, click View > Recording in the Control Panel menu.

   ![Stop Recording Button](image)
Convert Session Recordings

Once a session has been recorded, the recording file must be converted before anyone can view it. Using the Recording Manager, you can easily convert multiple recordings at once whenever it's convenient for you.

Convert a recording

1. Open the Recording Manager as follows:

- **Convert immediately**: As soon as you end a session that was being recorded, the Recording Manager will automatically launch and prompt you to convert your recordings.
- **Convert later**: Open the Recording Manager at any time by right-clicking the daisy icon in your system tray and selecting Convert Recordings (Windows) or by opening Preferences > Recordings > Convert recordings now (Mac).
2. Under "Recordings you need to convert", any unconverted files will be listed (both the most recent session and any past sessions that were not yet converted). Use the check boxes to select the files that you wish to convert.

3. Use the "Choose a file format" drop-down menu to select the desired format (.WMV or .MP4 for Windows, .MP4 and .MOV for Macs).

4. Click **Convert Recording**.
5. The conversion process will begin for the selected files. The recording may take some time to process and convert, depending on which recording media format you chose.

6. Once the file has been successfully converted, it will be moved to the "Converted recordings" list in the Recording Manager. You can click the Folder icon to automatically open the folder on your computer in which the converted file is stored.

7. You can share the converted recording with attendees via email, YouTube, Vimeo, etc. so that anyone can view it.
Give Keyboard and Mouse Control

When you are Presenter, you can grant other attendees shared control of your keyboard and mouse. This allows them to move the mouse about your shared screen and use their own keyboard to type on it, which can aid in collaboration.

Of course, your mouse always has priority. You can always override another attendees' mouse movements to temporarily regain control without removing their access.

Share keyboard and mouse control with others (new Control Panel)

Note: Attendees who joined via Web App must switch to the desktop app to share keyboard and mouse control. Mobile attendees cannot use this feature.

1. Share keyboard and mouse control in either of the following ways:

   - On the Screen tab (in the Options pane), use the "Share keyboard & mouse with" drop-down menu to select "Everyone" or an individual.
   - In the Attendees pane, right-click the name of the desired attendee and select Give Keyboard and Mouse.

2. All attendees with keyboard and mouse control will have a Check icon next to their name in both drop-down menus shown above. All attendees will see a notification that they have been given access to the presenter's keyboard and mouse.
Remove keyboard and mouse control from others (new Control Panel)

You can remove keyboard and mouse control in the same way that it was granted. Once attendees have control removed, the Check icon □ will disappear.

Give keyboard and mouse control to an attendee

1. From the Attendee List, right-click an attendee's name.
2. Select Give Keyboard & Mouse from the drop-down menu. Once you give keyboard and mouse control to an attendee, they automatically become a panelist for the remainder of the session.
3. When prompted to confirm that you'd like to give them control of your keyboard and mouse, click Yes. Once they accept control, they can begin controlling your screen.

Take back keyboard and mouse control

1. In the Screen Sharing pane of the Control Panel, click the Give Keyboard & Mouse button.
2. Select your own name from the drop-down menu.
3. When prompted to confirm that you'd like to take back keyboard and mouse control, click Yes.

Temporarily take control of your keyboard and mouse

1. Simply type or move your mouse to re-gain control temporarily. The other person can continue to control your keyboard and mouse, but you will override their movements.
2. Instruct the person with keyboard and mouse control to resume controlling your screen when you're finished.
Transcoding Wizard (Windows only)

The GoToMeeting Transcoding Wizard can transcode (converting a video file into a different format) or make your GoToMeeting recording universally compatible with other media players and 3rd party video sharing sites like Vimeo, YouTube, etc.

When using Windows, GoToMeeting, GoToWebinar, and GoToTraining record using the GoToMeeting Codec. To view this recording, you must Install the GoToMeeting Codec on your computer or view the recording by using a media player that supports the GoToMeeting Codec such as the most recent version of VLC Media Player.

You can set your meeting recording to automatically transcode at the end of your session in your Preferences. Please remember that transcoding your recording requires additional time and this is option is not selected by default.

If you have a recording that wasn't transcoded, you may using the Transcoding Wizard to convert your file. This transcoded file can be played on any Windows computer and a Mac with a Windows Media component installed on it.

Download the Transcoder

1. Click GoToConverter.exe and download the transcoder.
2. Double-click the downloaded exe.

The GoToConverter.exe file will be placed in the directory location of your computer where the .exe was located. On running the transcoder, you will see a file called Interop.WMP Lid.dll appear.
Transcoding a recording

**Note:** We recommend maintaining a copy of the original recording file prior to transcoding.

1. Run the GoToConverter.exe file.

2. Your GoToMeeting recordings (from the default recording location) will be auto-listed in the converter.

   OR

   You can click **Select File(s)** and select your recording(s) manually.

3. Click **Start**.

   On clicking **Start**, all the listed items in the GoToConverter begin to transcode and all your original GoToMeeting recordings will be replaced with the converted file once the process is completed.

   If GoToMeeting is not installed and you run the Transcoder, an error will be displayed stating that GoToMeeting cannot be located. The converter will then start in *Advanced* mode and the codec will need to be specified.

   **Notes:** We recommend installing GoToMeeting prior to running the GoToConverter file for a more seamless conversion experience. The Transcoding wizard is not available for Mac users. However, they can view the transcoded recordings by using the most recent version of VLC Media Player.
Common Error Messages and their Solutions

You may see the following error messages when you try to transcode a recording:

- **Contains special charaters**
  The transcoder cannot transcode files that have certain characters in the file name like !, @, % & etc.

- **Not a WMV file**
  The transcoder can only be used on Windows computers and the can only transcode files that have a .wmv extension.

- **Does not contain a G2M Codec**
  This error message is displayed when the GoToMeeting codec isn't there. It’s likely that the recording is already transcoded.

- **GoToMeeting exited with an error**
  The conversion process is unsuccessful if the GoToMeeting transcoder has crashed.
Change Presenter

The presenter has the ability to share their screen with other attendees during a session. As an organizer, you can make another attendee the presenter at any time (which does not cause them to automatically become an organizer).

Make an attendee Presenter (new Control Panel)

Note: Only attendees who joined via the desktop app can be Presenter. Attendees who joined via Web App must switch to the desktop app to become Presenter. Mobile attendees cannot be made Presenter.

1. Select a Presenter in either of the following ways:

   - On the Screen tab (in the Options pane), OR
   - In the Attendees pane, right-click the name of the desired attendee and select **Make Presenter**.

2. Confirm the Presenter as follows:

   - If the attendee joined via the desktop app, you will be asked to confirm that you want to make them Presenter. You can also enable the "Request keyboard and mouse control" check box to have a request sent to the attendee before clicking **Yes**.

   - If the attendee joined via the Web App, you will be notified that they must switch to the desktop app in order to become Presenter. Click **Send Present & Download Request** to prompt the attendee to switch.
Note: Though you'll still see this notification, Web App attendees who are running Chrome will be able to share their screen without switching to the desktop app.

3. The new Presenter will be notified, and you will see a confirmation that you are no longer the Presenter.

- Desktop app attendees will see a "You've been made the Presenter" window prompting them to share their screen.
• Web App attendees running Chrome will be prompted to install the GoToMeeting Pro Screensharing extension in order to share their screen.

• Web App attendees running another browser will be prompted to switch to the desktop app.

Take back Presenter control (new Control Panel)

You can resume Presenter control in the same way you passed it to another attendee:

- On the Screen tab (in the Options pane), use the "Change Presenter to" drop-down menu to select your own name.
  - OR -
- In the Attendee pane, right-click your own name and select Make Presenter.
Use Drawing Tools

Participants can use drawing tools to draw directly on the shared screen so that the marks are visible to all attendees. This allows participants to highlight areas of the screen, draw attention to certain parts and generally illustrate their point. Organizers and presenters can allow only other organizers or all attendees to draw on the shared screen.

Use drawing tools (new Control Panel)

1. Click GoToMeeting and hover over Drawing Tools.
2. Use the menu to select the desired drawing tool (pen 🖌️, highlighter 📂, spotlight 🧐, or arrow 🖇️). You can also change the pen color, if desired.
3. Click and drag the mouse over your desktop to start drawing on the shared screen.
Enable/disable drawing tools for all participants *(new Control Panel)*

1. Click *GoToMeeting* and hover over Drawing Tools.
2. Click *Attendees can draw*.
   - When drawing tools are enabled for others, a Check icon ✓ will appear next to *Attendees can draw*. Attendees can click and drag the mouse over the Viewer to make their drawings appear on the shared screen for all participants.
   - When drawing tools are disabled for others, the Check icon ✓ will disappear.

Enable/disable drawing tools for an individual *(new Control Panel)*

1. Right-click the participant's name in the Attendee pane.
2. Click *Allow Drawing*.
   - When drawing tools are enabled for the user, a Check icon ✓ will appear next to *Allow Drawing*. The attendee can click and drag the mouse over the Viewer to make their drawings appear on the shared screen for all participants.
   - When drawing tools are disabled for the user, the Check icon ✓ will disappear.

Erase all drawings *(new Control Panel)*

1. Click *GoToMeeting* and hover over Drawing Tools.
2. Select *Erase all drawings*. All drawings done by any participant will immediately disappear.

Use drawing tools *(original Control Panel)*

1. During a session, click the Drawing Tools menu icon 📐 from the Grab Tab.
2. Select a drawing tool.
Allow another organizer or panelist to draw *(original Control Panel)*

1. Right-click a participant's name from the Attendee List.

2. Select *Allow Drawing*. The participant now has a Drawing Tools icon next to their name in the Attendee List. They can access the drawing tools from their Grab Tab.

Erase all markings *(original Control Panel)*

1. If you’re the presenter, click the Drawing Tools menu icon from the Grab Tab.

2. Select *Erase all drawings*.

Disable drawing tools *(original Control Panel)*

1. If you’re the presenter, click the Drawing Tools menu icon from the Grab Tab.

2. Select *Normal non-drawing mode* to disable drawing tools for everyone.
View and Manage Attendees

The Attendees pane displays a list of all the participants in a session.

Mute/unmute attendees

- **To mute or unmute a single attendee**, click the Audio icon next to their name. Blue icons 🎤📞 represent unmuted attendees, while orange icons 🎤🎧 represent attendees who have been muted by the organizer.
- **To mute or unmute all attendees**, click the Mute All 🎤 or Unmute All 🎤 icons at the bottom of the Attendees pane.

Note: It is not possible for an attendee who muted themselves to be unmuted by the organizer.

Give an attendee keyboard and mouse control

When you are Presenter, you can grant other attendees shared control of your keyboard and mouse. This allows them to move the mouse about your shared screen and use their own keyboard to type on it, which can aid in collaboration. Of course, your mouse always has priority. You can always override another attendees' mouse movements to temporarily regain control without removing their access. See Give Keyboard and Mouse Control for more information.

Make an attendee presenter

The presenter has the ability to share their screen with other attendees during a session. As an organizer, you can make another attendee the presenter at any time (which does not cause them to automatically become an organizer). See Change Presenter for more information.
Make an attendee an organizer

If you’re the scheduling organizer, you can make someone a co-organizer so that another participant can present and control the session like you. Attendees can be promoted to organizers in-session but won’t have access to post-session features, such as reporting and sending follow-up emails. If you’re the scheduling organizer, you can make someone a co-organizer so that another participant can present and control the session like you. Attendees and panelist can be promoted to organizers in-session but won’t have access to post-session features, such as reporting, archiving recordings and sending follow-up emails. Panelists can speak and present during the session and answer assigned questions, but the organizer first has to give a panelist the presenter role before they can present. See Add Co-Organizers for more information.

Stop/start attendee webcam sharing

- To request that an attendee start sharing their webcam, right-click their name in the Attendee list and select Send Webcam Request. The attendee will be prompted to share their webcam (they can click Share My Webcam or Not Right Now).

- To stop sharing an attendee's webcam, right click their name in the Attendee list and select Stop Webcam Sharing.
Hide/Show Attendees and Chat panes from an attendee

If desired, you can hide the Attendee list and/or disable chat for some attendees (both are enabled by default). To do so, right-click their name in the Attendee list and select Allow Attendee List and/or Allow Chat. A Checkmark icon ✓ will be displayed next to the select when it is enabled, and will disappear when one or more panes are disabled.

Dismiss an attendee

You can remove an attendee from the meeting by dismissing them. To do so, right-click their name in the Attendee list, select Dismiss Attendee, and then click Yes to confirm. Attendees will automatically be disconnected from the session and will see a message notifying them that they were dismissed from the meeting.
**Access Labs Features**

Labs features are exciting, new beta features that you can use to enhance your session. When you use a lab feature, you are agreeing to use a feature that has not been fully tested and may still have some bugs.

**Note:** GoToMeeting users will also see a Labs menu in their left navigation once they log in to their account. These labs features are different from those offered in the Control Panel.

**Enable Control Panel Labs Features**

The labs menu in your Control Panel allows you to enable exciting, new beta features that can be used to enhance your session! If you decide you no longer want to use a lab feature, you can always disable the feature from your Control Panel.

1. Click **File** in your Control Panel.
2. Select **Labs**.
3. If you are using labs for the first time, you must select **Agree** on the Labs dialog box.
4. You will then see the available lab features under **File** in your Control Panel. Select a feature to enable it, and a check mark will appear next to it. Select it again to disable it.
Available Lab Features

- **Video Sharing** - If you select the Video Sharing option, presenters on Windows will see a Share a Video button in their Webcam pane. Presenters can share .wmv, .asf, .avi, .mov and .mp4 files. Screen sharing and webcams will be paused while you are video sharing, and videos shared during a session will not be captured in a recording. You cannot share a video directly out of PowerPoint or the web. For users to hear audio of a shared video, the session must use GoToMeeting integrated audio.

- **Profile Pictures** - If you select the Profile Pictures option, presenters and attendees on Mac and Windows can assign themselves a profile picture by dragging and dropping an image file onto the Attendee pane.
• **Allow Pane Undocking** - If you select the Allow Pane Undocking option, organizers and attendees on Windows can undock panes from the Control Panel by clicking the Undock icon in the pane. They can click the Dock/Undock icon to re-group a pane back into the Control Panel, or group undocked panes with other undocked panes by dragging and dropping them together.

• **Allow Sharing a Rectangle** - If you select the Allow Sharing a Rectangle option, presenters on Windows can share a specific, rectangular portion of their screen (rather than their entire screen) by going to the Screen Sharing pane, clicking the Show My Screen drop-down menu and selecting Rectangle.
Presenters can move the rectangle anywhere on the screen and resize it to fit certain sections that they want to share. In order to see other rectangle sharing options, presenters can right-click the rectangle frame.

**Show Control Panel to Attendees** - If you select the Show Control Panel to Attendees option, presenters on Windows can show their Control Panel to attendees while screen sharing if they wish to demonstrate how to use or navigate the Control Panel (typically, the Control Panel is invisible to attendees). Presenters must remember to turn this feature off when they are done instructing so as to not confuse attendees.
Enable Labs in Different Versions of GoToMeeting

1. Log in to your account and click Labs in the left navigation.

2. Click Agree on the Labs Terms of Use pop-up.

3. At the bottom of the page, you will see the features that are currently available for you to try. Click Try it under the feature you would like to use. The meeting will start.
Sightboard uses your webcam and some magic to spot the whiteboard in your room, zoom in and show it to your attendees as if they’re sitting right in front of it. Sightboard can even see behind you as you write on the board!

You’ll need a Windows PC with an HD webcam.

Start this meeting

Try another experimental feature in a different GoToMeeting version!

Click Try it to start a Labs meeting and add it to My Meetings.
A recurring meeting will also be created and on your My Meetings page, which will run a different version of GoToMeeting. On the My Meetings page, you can tell which meetings have a labs feature by the Labs icon next to the Meeting ID.
Available Web Labs Features

- **Sightboard**: If you click the **Share a Whiteboard** button in the Labs pane of the Control Panel, you will be able to share any whiteboard in your webcam's vicinity. Your webcam will search for an area to use as a whiteboard, and once that area has been detected, you can drag the edges of the orange box to define the desired whiteboard area and then zoom in by clicking that space. You can use any white area or open space as a whiteboard. Attendees will clearly see anything written on the whiteboard, even if you are in front of it (your image will be transparent).

**Note**: You can currently only share a whiteboard from a Windows desktop.
Each time you draw or erase something new on the whiteboard, a snapshot of the whiteboard will automatically be taken. Once you close the whiteboard, you will see a pop-up with all the snapshots that were taken while sharing your whiteboard. You can select which snapshots you want to save as a PDF and where on the computer you would like to save it, and click **Save**. A pop-up confirming where your snapshots are saved will appear.
Leave Feedback

Lab features are not currently supported by customer care. However, we would love to hear any feedback that you have regarding these features!

- To leave feedback, click the **Give Feedback button** on the Control Panel while in session.
Use Chat

You can exchange instant chat messages with other participants during a meeting. Organizers can also send a Chat to the entire audience. Organizers can save a Chat log after the session ends to review messages later.

Chat with others (new Control Panel)

Use the Chat pane to send messages to other attendees.

1. Expand the Chat pane.
2. Use the "To" drop-down menu to select the recipients of the message: "Everyone", "Organizer(s) only" or an individual attendee.
3. Enter your message in the text field, then click Send.

Send a welcome message to attendees (new Control Panel)

Note: This feature is available to organizers and co-organizers only.

You can set up a chat message to be automatically send to each attendee as they join the session.

1. In the Chat pane, click the Options icon.
2. Enable the "When attendees arrive, show them this chat message" check box.
3. Enter you message, then click OK.
4. Attendees will see the message in their Chat pane as soon as they join.
Save the chat log (new Control Panel)

You can save a log of the Chat messages as a Rich Text file (.RTF). The Chat log will only include messages that you saw; any private message sent between other attendees will not be included.

**Note:** This feature is available to organizers and co-organizers only.

1. Click GoToMeeting in the top navigation and select Save Chat Log.
2. Select a location on your computer and change the default name (if desired).
3. Click Save.
Desktop Notifications (Windows)

Desktop Notifications is a free GoToMeeting feature for Windows users designed to deliver simple and effortless access to complimentary Citrix software upgrades, information, news and discounts you may be eligible for. Desktop Notifications delivers information right to your desktop, allowing you to safely receive important product information that is relevant to you. Desktop Notifications are sent only by Citrix as a service to our customers.

Show desktop notifications

Occasionally, when you are connected to the Internet, Desktop Notifications will automatically connect with Citrix servers to see if there are any new messages for you. If there are any messages for you, Desktop Notifications will display them on your computer screen.

Disable desktop notifications

1. To disable desktop notifications, unselect the "Show me desktop notifications" check box the next time a notification appears.

2. You should no longer receive notifications on your desktop.
**Leave and End a Session**

You can leave or end a session anytime during the session – even before the scheduled end time. You have the option to leave a session without ending it for everyone else in-session so that everyone else can continue with the session.

**Leave a session without ending the session for everyone**

1. While in-session, make sure there’s another organizer before you leave the session. If there isn’t another organizer, right-click someone’s name from the Attendee List, and select **Make Organizer**. Wait until the person has accepted organizer control before leaving.

2. From the Control Panel, click the Quit icon on the top-right corner. When prompted to leave or end the session, click **Leave the Meeting**. Or, you can click **File > Leave Meeting** to exit a session.

**End a session for everyone**

1. On the top-right corner of your Control Panel, click the Quit icon. Or, you can click **File > Leave Meeting** to exit a session.

2. When prompted to end the session for everyone, click **Yes**.
FAQs

Join a Session FAQs

Review frequently asked questions on joining a session.

How do I join a session?

Open your GoToMeeting invitation emails, and click the Join URL. Or, you can visit the Join a Meeting page, and enter your 9-digit Meeting ID from your invite.

Do I need a account to attend a session?

No, you don't need a account to attend a session.

What are the system requirements for attending a session?

- Internet connection
- Windows® 8, 7, Vista, 2003 Server or XP
- Mac OS® X 10.6 (Snow Leopard®) or newer
- iOS 6 or newer
- Android 2.2 or higher
- Internet Explorer® 7.0 or newer
- Mozilla® Firefox® 4.0 or newer
- Safari™ 3.0 or newer
- Google Chrome™

See the full System Requirements for more information.

Can I attend a GoToMeeting session from an iPad, iPhone or iPod touch?

Yes, you can attend sessions on your iPad, iPhone, or iPod touch as an attendee only. You won't have the ability to share your screen if given presenter control.

Can I attend a GoToMeeting session from an Android smartphone or tablet?

Yes, you can attend sessions on your Android smartphone or tablet as an attendee only. You won't have the ability to share your screen if given presenter control.

Can I view presentations in full-screen mode?

Yes. On the top of the Attendee Control Panel, select the View menu > Full Screen. Or, you can click the View button on the Grab Tab to toggle between Full Screen and Window mode.
Audio Conferencing FAQs

Review frequently asked audio conferencing questions.

Is there a cost for using the integrated audio conferencing feature?

Your plan includes unlimited audio at no extra cost. You can use toll-based phone conferencing or VoIP (requires microphone and speakers) exclusively or allow participants to choose between both options. You can also provide your own conference call number for organizers, panelists and/or attendees, but you won’t be able to choose our integrated audio conferencing options if you do so.

If you purchased a plan that provides toll (long distance) numbers, participants who dial in are charged their standard long-distance rate for calling. If you purchase Integrated Toll-Free service, your participants can dial in using a toll-free number, and you’ll be charged according to the plan that you select.

You and your attendees can also connect to the audio conference free of charge by choosing the Mic & Speakers (VoIP) option where you can send and receive audio over the Internet at no cost using a microphone and speakers connected to your computer. (A USB headset is recommended.)

Is there a toll-free audio option? How do I sign up?

If you’d like to purchase Integrated Toll-Free audio service provided by Citrix Online Audio so that your participants can dial in by telephone using toll-free numbers, call us at 1 866 962 6492. You can then provide your participants with a toll-free number if you so choose. Over 45 countries are available for toll-free numbers.

With this service, you can give your attendees the option of dialing in using VoIP, toll (long distance) or toll-free audio conferencing without any additional equipment needed.

Can I mute/unmute individual attendees?

As the organizer, you can easily mute attendees on VoIP by clicking the Microphone icon or Telephone icon next to their name in the Attendee List. You can mute attendees who dial in by phone only if they entered their Audio PIN. Attendees will be able to unmute themselves if they wish to speak.

Can I use my own toll-free phone numbers for all of my sessions?

Yes. As an organizer, you can easily change your default audio options from the Settings page. Simply log in to your account, and select Settings to adjust the audio options for future sessions. To provide your own conference call service, select Use my own conference call service on the Settings page, and enter the conference call info for attendees (and optionally for organizers and panelists). Then click Save to apply the audio settings for all future sessions (new default setting).

What microphone/speaker configuration is recommended for best audio quality using VoIP?

For optimum audio quality, we recommend a USB headset connected to your computer, or USB headphones and standalone microphone connected to your computer. Analog versions are okay, but not ideal. We don’t recommend using a webcam mic.
Can I test the quality of my microphone and speakers setup before a session?

Yes. Just right-click the GoToMeeting daisy icon 🌻 in your system tray, and select Preferences > Audio to choose the device(s) you want to test.

Where can I go for help with audio problems?

Please see our Audio Help for tips on how to troubleshoot common audio problems.

Can I broadcast my computer's audio?

Although GoToMeeting is designed to broadcast audio over VoIP or telephone, you can also broadcast recorded audio from your computer. Due to some sound card limitations, these instructions may not always work on every system.

Broadcast audio on Windows 7 or Vista

1. Right-click the Speakers icon 🎧 in the system tray, and select Recording devices.
2. On the Recordings tab, right-click the first item on the list, and select the Show Disabled Devices option.
3. Check that Stereo Mix is the default device, and click OK.

Broadcast audio on Windows XP

1. Double-click the volume icon in the system tray.
2. Select Options > Properties.
3. Below Adjust Volume for, choose Recording.
4. Check that Stereo Mix is enabled, and click OK.
5. On the Recording Control window, select the check box under Stereo Mix.

Broadcast audio using hardware

You will need the following:

- Two 3.5 mm audio splitters (one male, two female)
- One 3.5 mm audio patch cable (two male ends, typically 3" long)

1. Plug one splitter into your line out port (typically green for speakers).
2. Plug the other splitter into your microphone port (typically pink).
3. Plug the patch cable into the splitter on line out and then into the splitter on your microphone.
4. Plug your microphone into the microphone splitter, and then plug your speakers into the line out splitter.

Is there any way to see if there are any unidentified callers in my meeting?

Yes, internal customer support reps and Account Managers can enable the "Audio Attendee Identification" feature from the User Settings page. Organizers will then be able to see any unidentified callers who have called into the meeting (as well as attendees who have called into the meeting without joining the screen-sharing portion of the meeting) but have not entered their Audio PIN.
OpenVoice Integrated (Toll-Free Audio) FAQs

Review frequently asked questions about OpenVoice Integrated (toll-free audio).

What is OpenVoice Integrated (toll-free audio)?

Organizers whose accounts include an OpenVoice Integrated subscription can use it to offer their attendees toll-free phone numbers for over 50 countries. This provides attendees with an alternative to connecting with their mic and speakers (VoIP) or incurring long-distance phone charges, making it easy for them to choose the most convenient method of joining the audio conference. See OpenVoice Integrated (Toll-Free Audio) for more information.

How much does it cost to use OpenVoice Integrated?

Per-minute charges are based on your service contract, and minutes are calculated per participants. For instance, if 3 participants dialing to the session for 10 minutes using the toll-free option, you will have used 30 minutes of your plan. Those who join by regular toll numbers are charged rates based on their own long-distance provider. There are no additional charges for those who join a session using VoIP.

How am I billed for OpenVoice Integrated?

You will receive a separate monthly invoice from Citrix Online Audio, LLC for any toll-free minutes used by you and your attendees.

How do I add the toll-free option to sessions that I’ve already scheduled?

For any sessions that were scheduled prior to enabling toll-free integration, the regular toll-based conference numbers will automatically be changed when toll-free numbers are added to an existing session. It is recommended that you resend the invitation email to participants so they have access to the new toll-free audio information. The Meeting ID and URLs will stay the same, and the new toll-free number will be provided to attendees in the Waiting Room, as well as in the Audio Pane of the Control Panel.

Will I use the same toll-free number for each session?

No, as with existing sessions, each session will have a unique toll-free number and access code. If you wish to re-use the same audio options for your sessions, select the “Recurring meeting” check box in the Schedule a Meeting window. Once you do so, the OpenVoice integrated toll-free number and access code remain the same.

How do I schedule a session with OpenVoice integrated toll-free?

When you’re scheduling a session, click Edit countries in the Audio section to choose which toll-free numbers you’d like to provide to attendees.

For which countries do you offer international toll-free & long-distance (toll) service?

See the available international toll-free and long-distance (toll) numbers.
Is there anything different about recording a session with OpenVoice integrated toll-free?

No. Whether you or your attendees join with VoIP, long distance or toll-free audio, you can seamlessly record audio. Open Preferences > Recording > Use GoToMeeting integrated audio.

How can I cancel OpenVoice integrated toll-free?

If you'd like to cancel your OpenVoice integrated toll-free service, please contact our 24/7 Global Customer Support.

General GoToMeeting Troubleshooting FAQs

Review frequently asked GoToMeeting troubleshooting questions.

I never received my GoToMeeting invitation email. What should I do?

It's possible that your email server blocked the invitation email. If you're in a corporate environment and don't have the ability to check email in a spam folder, check with your administrator to see if the invitation can be resent.

Where can I view my scheduled meetings?

See View Scheduled Meetings for information on where to find My Meetings.

I forgot my password. What should I do?

Go to the Forgot Your Password? page, and enter the email address you use to log in to your account. Once you click Continue, an email will be sent to you where you can click a link to create a new password.

How long will my past meetings appear in my Meeting History?

Past meetings will appear in your meeting history for 90 days after a meeting's scheduled end time. If you're on a GoToMeeting corporate plan, you can view meeting history up to 12 months after a meeting's scheduled end date.

What happens when I stop showing my screen? What do my attendees see?

When you click the Stop button, Screen Sharing will be turned off, and you will no longer show your screen to attendees. Instead, your attendees will see the Waiting Room until you resume Screen Sharing. If you're on a GoToMeeting corporate plan, you can customize the Waiting Room and display a logo to attendees.

How do I share one application and nothing else?

A presenter can share a single application by right-clicking the screen-sharing icon on the Control Panel and then selecting the application to share from the list of applications presented. The application-sharing feature is only available to presenters using Windows computers.
If I'm the organizer, how do I take back Keyboard and Mouse Control?

As a security feature, you can regain control of your computer by simply moving your mouse. The change of control happens almost instantaneously. At any time, you can revoke an attendee's shared control of your mouse and keyboard if you want to prevent him or her from regaining control.

Are there any files or folders left on an attendee's computer after the session ends?

Some downloaded files do remain after a meeting so that attendees can join future meetings more quickly (without having to download all the files again). The Citrix Online Launcher app may be installed on attendees' computers, which also includes an optional browser plugin that lets them join faster. These files are inactive, will not consume system resources, do not compromise security and perform no functions until the attendee joins another meeting and the files are engaged by a new Meeting ID. If desired, an attendee may uninstall all GoToMeeting files using the Add/Remove Programs feature in the Windows control panel.

If the option to save chat logs is enabled, attendees will see their chat history stored by default in the My Documents folder. They may also see GoToMeeting log files stored in %temp%\CitrixLogs\gotomeeting on Windows computers and ~/Library/Logs/com.citrixonline.GoToMeeting/ on Macs.

Why would I make someone else an organizer in my meeting?

If you created a meeting and needed to leave, but wanted your attendees to continue the discussion, you would want to make someone else the organizer. The meeting would proceed without you and without interruption.

Is there a charge for using GoToMeeting’s integrated audio?

GoToMeeting is packaged with both VoIP and a telephone conferencing at no extra cost. You may decide to use one or both of these services or choose another method of connecting to audio during meetings. Our phone conference service provides a toll-based phone number that meeting participants can dial. Participants are then charged their standard long-distance rate for calling a toll-based number, just as if they made a regular long-distance call. There is no additional charge for the conferencing feature. If attendees wish to avoid incurring long-distance charges, then they can join the meeting with VoIP. Please see Integrated Toll-Free Audio for information on how to provide your attendees a toll-free option.

How do I save chat sessions from my meetings?

Under the File menu, select Save Chat Log. Or, if you are using a Windows computer, open Preferences > General, and select the "Chat Logs" check box to automatically save logs to that computer after each meeting.
Is video streaming supported in GoToMeeting?

While we do not yet support streaming video, our GoToMeeting technology is fast enough to keep up with screen changes on the desktop, so it appears as if it is streaming video.

Because more data is being sent to all meeting attendees, bandwidth usage will increase for all meeting participants. The amount will depend on the resolution and length of the video.

Also, certain versions of Windows Media Player with Microsoft DirectX (an advanced suite of multimedia application programming interfaces, or APIs, built into Microsoft Windows operating systems) will not display the video.

To enable video display for your meetings, you need to disable Hardware Overlay for your player. Please see your media player’s help section for instructions on disabling Hardware Overlay.

Can I change a meeting in Outlook without going into GoToMeeting to change the time manually?

No, once you generate the invitations and calendar event, you must change the meeting time in GoToMeeting if you want to reschedule the meeting.

What happens if I have two monitors?

You can choose to either display one or both of the monitors. However, your two-monitor display may cause problems of resolution and visibility for your attendees if you display both monitors simultaneously.
GoToMeeting Essentials FAQs

What is GoToMeeting Essentials?
GoToMeeting Essentials is a lighter version of GoToMeeting that allows up to 5 attendees and 1 organizer to join your meeting.

What is the difference between GoToMeeting Essentials and other GoToMeeting plans?
GoToMeeting Essentials supports all GoToMeeting features except for the ability to record a meeting. The regular GoToMeeting plan allows up to 25 attendees per session and also allows you to add multiple organizers to your account.

<table>
<thead>
<tr>
<th>Feature</th>
<th>GoToMeeting Essentials</th>
<th>GoToMeeting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attendee Limit</td>
<td>5</td>
<td>25</td>
</tr>
<tr>
<td>HDFaces Video Conferencing</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Screen Sharing</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>VoIP</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Phone Conferencing</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Recording</td>
<td>✗</td>
<td>✓</td>
</tr>
</tbody>
</table>

Can I switch from a GoToMeeting Essentials plan to a GoToMeeting 25 plan?
Yes, you can easily switch from a GoToMeeting Essentials plan to a GoToMeeting 25 plan by going to the My Account page and clicking Change Plan. However, you cannot switch back to a GoToMeeting Essentials account since GoToMeeting Essentials is not offered as a subscription option (it is only available to existing GoToMeeting Essentials users).
Roles FAQs

Review frequently asked questions on roles in GoToMeeting FAQs.

What is an organizer?

An organizer has a GoToMeeting account and schedules, starts, manages and ends a session. An organizer can also designate other attendees to be organizers. Once a session starts, the scheduling organizer is the default presenter and may either begin presenting or pass the presenter controls to another organizer.

What is a presenter?

A presenter is the person who is presenting their screen to the audience. The GoToMeeting organizer is always designated as the initial presenter. The presenter role can then be passed to another organizer or attendee.

Presenters can show their complete desktops, a clean screen (with no icons or taskbar) or a specific application window to the audience. Presenters may choose to pause Screen Sharing at any time. Presenters may give other organizers the ability to control their keyboard and mouse.

What is an attendee?

An attendee is any person who attends a session, including organizers and presenters. By default, attendees can view the presenter's screen. An attendee may remotely control the presenter's computer screen if given the privilege. An attendee may optionally chat with other attendees, use Drawing Tools or view the Attendee List.

How many people can speak on the call at once?

When using integrated audio conferencing, up to 25 attendees can be unmuted and speak on the call at any one time.
HDFaces Video Conferencing FAQs

How is HDFaces different from other web conferencing video solutions?

We provide the highest resolution video conferencing quality currently available among web conferencing providers – up to 6 streams at 640p x 480p for a maximum resolution of 1920p x 960p. Best of all, there’s no additional cost to use HDFaces with GoToMeeting!

What are the system requirements for HDFaces video conferencing?

- Internet connection with cable modem, DSL or better
- Windows® 8, 7, Vista, XP or 2003 Server, or Mac OS® X 10.6 Snow Leopard® or later
- Dual core 2.4GHz CPU or faster with at least 2 GB of RAM
- Internet Explorer® 7.0 or later, Mozilla® Firefox® 3.0 or later, Google Chrome 5.0 or later or Safari® 3.0 or later
- 700 Kbps or more bandwidth recommended per participant for simultaneous screen sharing, audio and video conferencing

Which webcams are recommended?

Video conferencing will work with most standard video conferencing webcams. From our testing, we highly recommend the following webcams:

- Logitech® HD Pro Webcam C910
- Logitech HD Webcam C510
- Logitech HD Webcam C310

Which webcams are unsupported?

HDFaces video conferencing does not support the following webcams:

- 4eyeGrab
- Hava Remote Video Device
- Hava Video Device
- BT878 VfW to WDM mapper (32-bit)
- Live! Cam Notebook Pro (VF0400)

If 6 video streams are being shared and I turn off my video stream, can another participant share their video?

Yes, participants can stop and share video streams at any time. Organizers can also disable an attendee’s video stream so that another participant can share their webcam.

Can I temporarily stop my webcam without giving up my webcam slot?

Yes. You can pause your webcam temporarily by clicking the Pause button on the top-right corner of your webcam feed.
Is HDFaces available on GoToWebinar and GoToTraining?

Yes! HDFaces video conferencing is available for GoToMeeting, GoToWebinar and GoToTraining at no additional cost.

How do I set up my webcam to use with HDFaces video conferencing?

Install your webcam using the manufacturer's installation instructions. You can set your webcam settings from GoToMeeting Preferences. We recommend using a headset with mic and speakers (VoIP) instead of your webcam's built-in mic and speakers.

What happens if I install a webcam during an HDFaces session?

In most cases, we should be able to detect your new hardware and allow you to use it during the same session.

What are the bandwidth requirements for HDFaces?

We recommend 700Kbps or more per participant for simultaneous screen sharing, audio and video conferencing. HDFaces uses bandwidth optimization to make the best possible use of any available bandwidth. If you experience slow performance issues, try closing data-intense applications like YouTube, Netflix, Skype, etc.

What is the supported video frame rate?

HDFaces supports up to 30-frames/second. The frame rate depends on your webcam, lighting, network and computer.

Can I join an HDFaces session from an Android or iOS device?

Yes. You can join HDFaces sessions as an attendee, but you'll be unable to view or share webcams and show your screen if you're using an iPhone or iPod Touch. If you're on an Android or an iPad 2 or newer, you can share and view webcams in meetings. In a webinar, you can only view webcams from an iPad.

Can I view webcams if I join an HDFaces session from an Android or iOS device?

- If you are joining an HDFaces session from an Android, you will be able to view webcams. However, you will not be able to share your own.
- If you are joining an HDFaces session from an iPhone or iPod touch, you will not be able to view webcams. However, if you are joining from an iPad you will be able to view webcams.

What are some video conferencing tips and best practices?

- Secure your webcam on your computer to make sure it's stable and won't move around.
- Choose a location with adequate lighting. If you're sitting directly in front of a window, try moving to another spot; otherwise, your webcam may only capture your silhouette.
- Position your webcam so that your entire face fills up at least half of your webcam viewer.
- For optimal performance, open Preferences > Webcam > Advanced. If you have a high-performance webcam, you can enable high-quality features, such as "face recognition" or "right light," to enhance your video conferencing experience.
How do I select a different webcam if I have more than one plugged in to my computer?

To select a different webcam, open Preferences > Webcam. If more than one webcam is detected, simply choose which webcam you'd like to use from the Your Camera section.

Can I record webcams during an HDFaces session?

Although you can record screen sharing and audio, you cannot record webcams at this time.

Why can't I see other participants' webcams?

Your webcam viewer may be minimized, but you can bring the viewer back up again from your taskbar or dock. If you previously selected the Hide Webcams from the Webcams drop-down menu, select Show Webcams. Only staff members can show their webcams.

Why can't other attendees see my webcam?

Double check to see if your webcam is connected to your computer and then try clicking the Share My Webcam button if you haven't already done so. To see if your webcam has been detected, open Preferences > Webcam.

What should I do if I'm experiencing poor video quality?

Make sure you have adequate lighting in your room. If you have low bandwidth, you should make sure you have nothing else running that might use up bandwidth. If your webcam is out of focus, turn off the auto-focus setting on your webcam. You can also check to see if you're using one of our unsupported webcams.

What should I do if my webcam stops working?

If you have low bandwidth or CPU issues, you may see a "Low Bandwidth" or "Computer Overloaded" message. You'll be prompted to hide all webcams and/or stop sharing your own webcam. If you click Yes, all webcams and/or your own webcam will be hidden.

To improve bandwidth and CPU performance, close all other programs on your computer, and switch to a high-speed cable Internet connection (if you haven't already).
Recording and Playback FAQs

Here you can review frequently asked questions regarding session recording and playback. Please see Record a Session for details about starting and stopping session recording, as well as modifying the recording settings.

How do I record a session?

Please see Record a Session for details about starting and stopping session recording, as well as modifying the recording settings.

How do I locate my session recordings?

By default recordings are stored in /Users/<current user>/Documents/Recordings. See Locate Recording Files for more information.

How can I tell how much storage I have left?

1. Log in to the GoToMeeting web app and click My Recordings in the left navigation.

2. The Storage Space widget in the left navigation shows how much storage space is in use and how much is remaining. By default, you have 3GB of storage space for materials and recordings.
What file formats are supported?

If you select the **GoToMeeting format** (Windows only):

- Recordings are ready for viewing with Windows Media Player 9 or higher, immediately after leaving or ending a session.
- To play a recording, viewers must have GoToMeeting or the [G2M2 video codec](https://www.gotomeeting.com/downloads) installed on their computer.
- Mac viewers are unable to view recordings in the GoToMeeting format.
- At least 500MB of disk space is required to record in the GoToMeeting format.

If you select the **Windows Media Player format** (Windows only):

- Allow time for the conversion to take place. The time needed is dependant on video content, CPU speed and amount of memory available.
- The recording doesn't require viewers to have GoToMeeting or the G2M2 video codec.
- At least 1GB of disk space is required to record in the Windows Media Player format.

If you select the **.MOV format** (Mac only):

- Recordings are automatically saved as .MOV files using H.264 compression. (If you recorded on GoToMeeting v5.2, your recordings will be saved as .MP4 files instead.)
- Recordings must be converted using the [GoToMeeting Recording Manager](https://www.gotomeeting.com/support) before anyone can view it.
- After completing the conversion process, anyone can view the recording without additional conversions.
- At least 500MB of disk space is required to record in the .MOV format.

Can people on Macs view sessions recorded on Windows computers?

Yes, but only if the recorded session file has been converted to the Windows Media Player format. The organizer must select the Windows Media Player format setting before recording the session to allow people on Macs to view recordings.

Can I include audio in my session recordings?

The [Recording Preferences](https://www.gotomeeting.com/support) will determine if and how audio is included in session recordings. The following options are available:

- **Don't record audio**: Records the presenter's screen only.
- **Use Use GoToMeeting integrated audio**: Records everyone who speaks via VoIP or telephone.
- **Use your own audio service**: Uses a microphone to record the organizer's voice, while a phone patch device will record everyone else who speaks (requires a physical input device).

Can I exclude audio from session recordings?

Yes, you can modify the settings so that only the shared screen is included by selecting the "Don't record audio" option under Recording Preferences.

Can I record a session using my own audio service?

If you're using your own conference call number, you must have a sound card and an audio input device like a microphone to record audio. If you're recording a teleconference, you can position the microphone...
next to the phone or set up a phone recording adapter to your phone and line-in input on your computer's sound card. If you’re having trouble with your audio, see Audio Help.

Where are my recorded sessions stored?

When you end or leave a recorded session, the recording is automatically saved to the location specified under Recording Preferences (the default location is "C:\Users\<username>\Documents"). You can change the location before you begin recording, if desired (you cannot change the location once the recording has started). Recordings will include the session's subject in the file name.

Note: We recommend that the location has a minimum of 1GB of free space to accommodate the recording.

Can I edit a recorded session?

You can use third-party editing software such as TechSmith Camtasia® to edit recording files. However, you must first re-encode the file using a tool like Microsoft Expression Encoder.

1. Download and open Microsoft Expression Encoder.
2. From the File menu, select Import to find your recording.
3. Select the Encode tab, and expand the Video pane.
4. Configure the settings. We recommend setting the Video Output Format to VC-1 Main and setting Size Mode and Video Aspect Ratio to Source.
5. Select the Output tab, and choose a location for the saved file.
6. From the File menu, select Encode to start the encoding process. Processing time will depend on the length of recording, output settings and your system hardware. Once re-encoding is completed, you can edit the recording.

Can I post a recorded session?

Yes. Viewers must have Windows Media Player 9 or higher installed in order to view the recording.

Can I mail a recorded session?

Yes. Depending on its size, a session recording can be zipped and sent via email or via File Transfer Protocol (FTP). Recipients must have the following installed in order to view files sent via email. Windows Media Player 9 or later installed in order to view.

If the session is sent in the GoToMeeting format, recipients must either have the GoToMeeting software installed or download the GoToMeeting codec.
Billing and Cancellation FAQs

Review frequently asked billing and cancellation questions.

How do I change my password?

Have a new email address? Want to change passwords? See Change Your Login Info for more information.

How do I cancel my paid subscription plan?

Your plan is set to auto-renew, but you can turn that setting off any time. See Cancel or Renew Your Account for more information.

If you’re on a corporate plan, contact our Corporate Billing Center.

How do I change my plan or switch products?

You can change your plan level at any time. See Change Your Plan for more information.

What charges apply when I change my plan?

Plan changes will be automatically adjusted and pro-rated against your current account balance. We’ll send you a confirmation email receipt after the changes are completed.

- If your new plan selection increases your subscription price, you’ll be prompted to enter payment. Once finished, you’ll have instant access to the features for the new plan. Your subscription billing date will change to reflect the date of the change in plan.
- If your new plan selection decreases your subscription price, we’ll credit your account and apply the credit toward your next scheduled payment. Your subscription billing date will change to reflect the date of the change in plan.

My account lapsed. How do I reactivate it?

We’re glad you’re back! See Cancel or Renew Your Account for more information.
How can I review the charges billed to my account?
You can see your account history by logging in and viewing your recent billing activity at the bottom of the page.

How do I get answers to billing questions or request a refund?
Contact Global Customer Support and we'll take care of all your questions and requests.

Will I get a receipt for my purchase?
You can see all your receipts by logging in and clicking My Account > View All Activity. We'll also send a receipt via email for your first subscription purchase, subsequent renewals and any time you change your subscription plan.

Security FAQs
Review frequently asked security questions.

How secure is GoToMeeting?
Your sessions are completely private and secure. All of our solutions feature end-to-end Secure Sockets Layer (SSL) and 128-bit Advanced Encryption Standard (AES) encryption. No unencrypted information is ever stored on our system.

How do I use GoToMeeting with firewalls?
Our solutions use HTTP outbound connections to transparently enable screen-sharing sessions, even with corporate firewalls in place. In most cases, organizers and attendees can connect to Citrix Online's servers without re-configuring firewall settings.

Can my computer get a virus from downloading the software or attending a session?
No, neither organizers nor attendees can catch or be exposed to viruses from downloading our software. We continuously monitor our development environment for viruses and malware, and all of our downloadable software is digitally signed to prevent tampering by third parties. The warning message customers might see when they install the software is a default message displayed by their browser whenever they download executable files.

Do I need to set my browser to accept cookies to use your website?
You can browse our website without having cookies enabled. However, if you need to log in to an existing account, you will need to adjust your browser's privacy settings to accept cookies. We primarily use cookies to provide you with secure access to your account.
GoToMeetingApp for Android FAQs

Review frequently asked questions on GoToMeeting App for Androids.

Can I use the app to join GoToMeeting and GoToWebinar sessions?

If you're running Android 4.0 or higher, you can install the GoToMeeting app from the Google Play Store to join GoToMeeting and GoToWebinar sessions as an attendee. If you're a GoToMeeting organizer, you can log in and schedule and start a meeting from the app, but you won't yet be able to share your screen, so we recommend making someone else who joined the meeting from a Windows or Mac the presenter or co-organizer.

We recommend using devices with a 1Ghz processor or higher for optimal performance.

How can I download the GoToMeeting app?

You can download the GoToMeeting app from the Google Play Store by logging in to your Google account that's linked with your Android device and searching for the GoToMeeting app. If you don't see an Install button, you may not be running Android 4.0 or higher (the minimum system requirement needed to install the GoToMeeting app).

You can also download the GoToMeeting app from the Amazon Appstore (only available in the U.S.), which lets you instantly download the GoToMeeting app to an Android device.
What are the minimum system requirements for joining a GoToMeeting or GoToWebinar session from my Android device?

- Android 4.0 or higher
- 1 Ghz CPU or higher recommended
- WiFi or 3G connection (WiFi and headset recommended)
- Free GoToMeeting App from Google Play or Amazon Appstore

How do I join a meeting on my calendar from the app?

Meetings in the Android Calendar app sync with the GoToMeeting app so you will see a list of your upcoming meetings on your Join screen. You can quickly join a meeting by tapping the name of the meeting.
You will also see a GoToMeeting widget that displays your upcoming meetings. You can tap the meeting to view the meeting information, and tap **Join** to join the meeting.

![GoToMeeting widget](image)

**Can I schedule meetings from the GoToMeeting app?**

Yes, you can schedule meetings from the GoToMeeting app by tapping the **Schedule a Meeting** button. You can then select whether or not it is a recurring meeting, choose the audio and edit phone numbers. You can also **edit meetings** and **invite others** from the GoToMeeting app.
Can I host GoToMeeting and GoToWebinar sessions on the app?

You can log in to schedule or start instant or existing meetings from your Android smartphone or tablet, but you won't be able to share your screen. We recommend making someone else who joined the meeting from a Windows or Mac the presenter or co-organizer from the Attendee List. Unfortunately, you can't start GoToWebinar sessions from your Android device at this time.

What are some of the unsupported GoToWebinar features?

Organizers and panelists can't do the following:

- Host or join a GoToWebinar session
- Join a session from a panelist invitation email
- Present as a panelist or organizer
- Start Screen Sharing

Attendees can't do the following:

- Start Screen Sharing or accept Presenter Control

Can I record a session from my Android?

No, you cannot currently record sessions from an Android device.
Can I chat from the app?

Yes, all attendees, organizers and presenters in a meeting can chat by tapping the Chat icon in the toolbar, entering a message and tapping Send. You can choose to chat with everyone in the meeting or privately with another person in the meeting. When you receive a Chat message, the Chat icon will bounce in the keyboard toolbar.

Chat is currently unsupported for GoToWebinar.

Why do I see an “Unable to Join the Meeting” error telling me that the Meeting ID is invalid?

If you manually entered the Meeting ID, double check to see that you typed it correctly.

Why do I have to enable cookies to join? How do I enable cookies on my browser?

If your browser is set to disable cookies, you must first enable cookies before you can join a session. To enable cookies, go to your browser's settings and select Accept Cookies.

I prefer to dial in to the audio conference by telephone. Where can I find the Audio PIN?

You do not need an Audio PIN to dial in to the audio conference by telephone. To dial in to the audio conference by telephone, you can set your default audio to Phone by going to the Settings tab and selecting the Phone icon next to Default Audio. If your default audio is set to Phone and you join a meeting from an Android device, you will be automatically dialed in to the meeting.

You can see if you are connected to the meeting by VoIP or telephone in the Audio tab. If the organizer has provided dial-in phone numbers, you can switch to telephone by tapping Switch to Phone in the Audio Tab. In the Audio tab, you'll see a list of phone numbers associated with the session. If the organizer provides international country numbers, you can choose which country you want to dial into. Once you tap Dial, you will automatically dial in to the conference from your Phone app and will need to navigate back to the GoToMeeting app to return to the session.

Why am I disconnected from GoToMeeting when I try dialing in from my phone?

If you’re using a device that doesn’t allow simultaneous data and voice sharing (CDMA), you must connect to the Internet from a WiFi network to dial in using the same device you use to join the session; otherwise, you’ll be disconnected from GoToMeeting. If you aren’t connected to the Internet through WiFi, you must use your device’s mic and speakers (VoIP) or dial in with a different device to connect to audio.
GoToMeeting App for iOS FAQs

Review frequently asked questions on GoToMeeting App for iOS.

What are the system requirements for using the GoToMeeting app for iOS?

Please see System Requirements for details.

Are there any additional fees for using the GoToMeeting app?

Nope, the app is free, and there's no charge for attending GoToMeeting, GoToWebinar or GoToTraining sessions. But you may be responsible for any long-distance charges associated with dialing into sessions by phone or any data charges that may be incurred.

Can I host a GoToMeeting or GoToWebinar session from my iPad, iPhone or iPod Touch? Can I show my screen if I'm given presenter controls?

Yes, you can log in and host a meeting from an iPad, iPhone and iPod touch with the GoToMeeting app. Organizers can schedule meetings, start previously scheduled meetings and even launch instant meetings from the My Meetings screen. Only iPad presenters can share content on-screen. At this time, you can't host a GoToWebinar session from an iOS device.

Can I schedule meetings from the GoToMeeting app for iOS?

Yes, you can schedule meetings from the GoToMeeting app for iOS. You can invite attendees to these meetings, edit the audio and create a meeting password from the GoToMeeting app. Also, you can delete meetings from the My Meetings screen.
How do I share content as a presenter?

If you're presenting from an iPad, you can share content from the cloud, browser or whiteboard by tapping one of those options from the Tap to Share Content screen. Presenters must first tap the Play icon in the toolbar for attendees to see shared content. The Screen Sharing icon will turn green when content is being shared.

Can I invite others to the meeting?

Yes, organizers can invite others by tapping the Invite icon and selecting either Email, Message or Copy to Clipboard to send the meeting information to others.

As an organizer, can I promote attendees to presenter or organizer?

Organizers can make someone who joins from a Windows, Mac or iPad the presenter so that person can share their screen. At this time, attendees who join from an iPhone an Android cannot be made presenters.

From the Attendee List, organizers can make someone else who joined from a Windows, Mac or Android the organizer. Currently, attendees who join from an iOS device cannot be made an organizer.
Can I see how my screen looks to attendees?
Yes, when sharing content you can preview how attendees are viewing your screen by tapping the Screen Sharing icon and turning Audience View on. A thumbnail image of what attendees are seeing will appear on-screen, which you can hold and drag with 1 finger to move it across the screen.

Can I only draw on a whiteboard?
No, presenters can use Drawing Tools to annotate directly on any screen being shared by tapping the Drawing Tools icon in the toolbar.

Can I join a GoToWebinar session as a panelist?
No, you can't join a session as a panelist on an iPad, iPhone or iPod Touch.

Can I record a session from my iOS device?
No, you can't currently record sessions from an iOS device.

Can I be made presenter during a webinar on an iPad?
No, not at this time.

How does attending a GoToMeeting or GoToWebinar session on an iPad, iPhone or iPod Touch compare with the experience on a Windows or Mac?
Just as on a Windows or Mac, you can view the presenter's screen, see who's attending and who's talking. However, some organizer features are not yet available on the iPad, iPhone and iPod Touch.

Unsupported features for GoToWebinar on iOS:
- Drawing tools
- Presenter controls
- Keyboard and mouse controls
- Start sessions
- Schedule sessions

Unsupported features for GoToMeeting for iOS:
- Keyboard and mouse controls of the presenter's desktop

How can I change the view or zoom into the presenter's screen?
You can view the presenter's screen in both portrait and landscape mode. You can also double-tap anywhere on the GoToMeeting Viewer to change the display to Fill Screen mode. Double-tap a second time to zoom in to 100% mode. Double-tap a third time to return to the default view – Entire Screen mode. You can also pinch or expand with 2 fingers, and pan to different parts of the presenter's screen by dragging 1 finger across the GoToMeeting Viewer.
Can I chat with other meeting participants? Can I ask questions during a webinar?

During a meeting or training, you can tap Chat in the toolbar to instantly send and receive messages to everyone in the meeting, to only the organizer(s) or to individual attendees. You can toggle between meeting participant names in the Attendee List to read and send messages.

During a webinar, you can tap Questions in the toolbar to send questions to the organizer. You can also view other attendees' questions and answers if the organizer sends the response to everyone in the webinar.

Can I connect to audio from the GoToMeeting app?

If the organizer provides both mic and speakers (VoIP) and conference call numbers as audio options, you'll automatically connect to VoIP over your iPad, iPhone or iPod Touch's Internet connection (WiFi or 3G) once you join. The audio quality depends on the quality and bandwidth available on your WiFi or 3G network (WiFi recommended).

You can dial in by telephone on your iPad, tap the Settings icon > Audio Settings > Telephone to access the conference call information. If you want to dial in on your iPhone, tap the Settings icon > Meeting Information > Phone Number link to automatically connect to audio. With a single tap of a U.S. telephone number, the conference call number, access code and Audio PIN are automatically dialed.

If you have an iPhone 4 or 4S on a network that does not allow simultaneous voice and data sharing (CDMA), you won’t be able to connect to GoToMeeting and dial in on your iPhone at the same time. To connect to audio, you should use your iPhone’s Internet connection (WiFi or 3G) or dial in with a different device.

Can I mute/unmute iOS attendees?

Yes, if the attendee is connected to VoIP, you can mute/unmute them to allow them to speak. If the attendee dials in by phone, you can mute/unmute them only if they have entered the Audio PIN, which they can access in-session from Settings.

Why can't I switch from Telephone to Mic & Speakers (VoIP)?

Once you dial in to the audio conference by telephone, Mic and Speakers (VoIP) becomes disabled for the remainder of the session. If you want to switch back to VoIP, you will need to leave the session and rejoin.
Why can't I connect to GoToMeeting and dial in by telephone on my iPhone?

If you have an iPhone on a network that does not allow simultaneous voice and data sharing (CDMA), you won't be able to connect to GoToMeeting and dial in on your iPhone at the same time. To connect to audio, you should use your iPhone's built-in mic and speakers (VoIP) or dial in with a different device.

If the organizer only provides a conference call number as the audio option and you try to dial in to the audio conference from a CDMA network without having a WiFi connection, you'll see a notification saying that your device does not support simultaneous voice and data sharing. Once you tap the Dial button on the notification, you won't be able to see the presenter's screen.

What audio options does the GoToMeeting app support?

- iPad, iPhone or iPod Touch's built-in mic and speakers (VoIP)
- iPad, iPhone or iPod Touch's built-in mic along with external headphones connected via the 3.5-mm stereo headphone jack
- Headset connected via the 3.5-mm stereo headphone jack
- Bluetooth Hands Free devices

For optimal audio quality, we recommend using a headset.

Can I join HDFaces meetings and webinars from an iPad and view webcams?

Yes, you can join HDFaces meetings and webinars and view webcams from an iPad. You can share your own webcam in a meeting from an iPad 2 or newer, but you cannot yet share your own webcam in a webinar.
GoToMeeting App for Windows Phone FAQs

Review frequently asked questions on the GoToMeeting app for Windows Phone.

What can I do with the GoToMeeting app for Windows phone?

As an attendee, you can do the following:

- Attend online meetings and webinars free of charge
- Join meetings in seconds by entering the Meeting ID and your name in the app
- Chat with others in meetings
- Raise your hand, participate in polls and question and answer in webinars
- View the presenter’s screen
- Connect to audio through VoIP
- Dial in by phone

As an organizer, you can do the following:

- Start and end scheduled meetings
- Schedule meetings
- Start a Meet Now session
- Invite others
- Give presenter controls to attendees
- View the Attendee List

What Windows devices are supported by this app?

The GoToMeeting app will work on any phone, tablet or desktop running Windows 8. See additional FAQs for the GoToMeeting app for Windows tablet.

Can anyone use the app?

Yes, anyone can download the app and join a meeting. In order to host a meeting, users will need to have an active GoToMeeting account or free trial. For those that want to host meetings but don't have an account, there will be a free trial link in the app description.
How do I join a meeting from a Windows phone?

If you know the 9-digit Meeting ID, you can join the meeting by simply opening the GoToMeeting app and entering the Meeting ID and your name. If you don't have the GoToMeeting app yet, you can install it for free from the Windows store.

How do I start a meeting from a Windows phone?

You can start a meeting by opening the GoToMeeting app, going to the Host screen, entering your email address and password and tapping Log In. You can then either select a scheduled meeting or tap Meet Now to start an impromptu meeting.
Are there any limitations to using the GoToMeeting app?
Yes, it is not possible to view or share webcams from a Windows Phone 8.

What are the system requirements for using the GoToMeeting app for Windows phone?
- Windows Phone 8

Are there any additional fees for using the GoToMeeting app?
You can download the GoToMeeting app and join unlimited sessions for free; however, you will be responsible for any data charges that may occur if the phone is not connected to WiFi. In addition, you must sign up for a free trial or paid subscription plan in order to host meetings from the app.

Can I join GoToTraining and GoToWebinar sessions from the GoToMeeting app?
You can join GoToWebinar sessions, but you cannot currently join GoToTraining sessions.

Can I connect to audio from the GoToMeeting app?
Yes. You will be automatically connected to VoIP over the tablet's WiFi connection, or you can switch to either 3G or 4G connection. You will also have the option to dial in to a conference by going to the Settings screen before a session and tapping Phone in the Audio section, or tapping the Phone icon in the bottom toolbar while in session.

Why does my Windows desktop sometimes launch the GoToMeeting desktop application instead of the GoToMeeting app?
If you launch GoToMeeting from a web browser on a computer using an x86 or x64 processor, it will automatically launch the desktop application. In order to launch the GoToMeeting app for Windows, select the app icon on your desktop.
GoToMeeting App for Windows 8 and Windows RT FAQs

Review frequently asked questions on the GoToMeeting app for Windows 8 and Windows RT.

What is the GoToMeeting app for Windows 8 and Windows RT?

The GoToMeeting app for Windows 8 and Windows RT can be downloaded to your Windows 8 desktop and Windows RT tablet from the Apps for Windows store. Windows 8 users can join meetings from either the app or desktop version.

What can I do with the GoToMeeting app for Windows 8 and Windows RT?

- Attend online meetings free of charge
- Join meetings in seconds by entering the Meeting ID and your name in the app
- Schedule meetings
- Start scheduled or impromptu meetings
- View the attendee list and chat with others
- Pass presenter role
- View the presenter's screen
- Connect to audio through VoIP

How do I join a meeting with the GoToMeeting app for Windows 8 and Windows RT?

If you know the 9-digit Meeting ID, you can join the meeting by simply opening the GoToMeeting app and entering the Meeting ID and your name. If you don't have the GoToMeeting app yet, you can install it for free from the Windows Store.
Are there any limitations to using the app?

- Presenting, Screen Sharing and Keyboard and Mouse Control
- Viewing and sharing webcams
- Dialing in by phone

What are the system requirements for using the GoToMeeting app for Windows 8 and Windows RT?

Organizers must be using GoToMeeting v5.0, build 799 or higher for attendees to join sessions on the app. Any user with Windows 8 or Windows RT running on x86, x64 or ARM processors will be able to use the GoToMeeting app. Windows 8 tablets and all-in-one devices, such as the Surface Windows 8 Pro, are not officially supported on the GoToMeeting desktop application, but if the GoToMeeting app for Windows 8 and Windows RT is installed, you can enter the 9-digit Meeting ID and your name on the app to join a meeting from the mobile app.

For more information, see the complete GoToMeeting System Requirements.

Are there any additional fees for using the GoToMeeting app?

Nope, the app is free, and there’s no charge for attending GoToMeeting sessions. But you may be responsible for any data charges that may be incurred.

Can I join GoToTraining and GoToWebinar sessions from the GoToMeeting app?

You cannot currently join training sessions from the GoToMeeting app. You are able to join any webinar or meeting hosted by a GoToMeeting organizer using GoToMeeting v5.0, build 799 or higher.

Can I host a GoToMeeting session from the GoToMeeting app for Windows 8 and Windows RT?

Yes, you can host a GoToMeeting session by opening the app, tapping View your meetings on the Enter Meeting ID screen and entering your email and password. On the My Meetings screen, you will see a list of your scheduled meetings which you can tap to start, or you can tap Meet Now to start an impromptu meeting.
Can I connect to audio from the GoToMeeting app?

If the organizer provides mic and speakers (VoIP), you will automatically connect to mic and speakers over your device’s Internet connection (WiFi) once you join. The audio quality on your device depends on the quality and bandwidth available on the WiFi network that you’re connected to. For best results, you should make sure you have nothing else running that might use up bandwidth. WiFi connection is highly recommended.

Can I join password-protected meetings from the app?

No, you cannot currently join password-protected meetings from the GoToMeeting app for Windows 8 and Windows RT.

Are webcams supported? I’m prompted to use my webcam but I don’t see them at all.

Although you may be prompted to use your webcam, GoToMeeting does not currently support webcams for Windows 8 or Windows RT. Therefore, you will not be able to see others’ webcams or show your own.

If I have the GoToMeeting app for Windows 8 and Windows RT, as well as the GoToMeeting desktop application on my desktop, what happens when I click the Join URL?

If you have the GoToMeeting app for Windows 8 and Windows RT, as well as the GoToMeeting desktop application installed on your Windows 8 desktop, clicking the Join URL will automatically launch the GoToMeeting desktop application.
New Version of GoToMeeting FAQs

Review frequently asked questions on the new version of GoToMeeting

What does the new version of GoToMeeting offer?

- **Multi-language support**: Switch to English, French, German, Italian, Spanish or Chinese, and even set your default language.
- **Choose a preferred telephone number**: Set a preferred telephone number that your attendees see first in invites and meetings.
- **More scheduling options**: Schedule, edit and delete meetings from the My Meetings page, as well as from the GoToMeeting for iOS and Android apps.
- **Unified log-in experience**: Log in to your account to easily manage and access your Citrix products from the My Account page.

What else is different?

You'll probably notice some improved features on the new version of GoToMeeting.

- **Even higher reliability and performance**: Use the new best-of-breed platform to collaborate in real-time all across the globe.
- **New look and feel**: Scheduling meetings and running reports never looked better with our new and improved website. It's sleeker and easier to navigate.

Will I lose anything?

Nope, the new version of GoToMeeting is very robust and offers an even better experience. And don't worry about losing your previously scheduled meetings, meeting history or reports – all your data will be moved over to the new system after you upgrade.

How do I transition to the new version?

You've probably received an email with instructions that tell you how you'll be upgraded. The next time you log in, the new version will automatically download.

Do I need to download anything?

Yes, the next time you log in, you'll automatically upgrade to the new version of GoToMeeting.

Will my pricing stay the same?

Yes, your plan and pricing will stay the same, but please note the following:

- GoToMeeting charges will now appear on your credit card or bank statement as "GoToCitrix.com".
- If your billing address location mandates sales tax on subscription-based software (SaaS), data archiving or telecom services, we may be required to collect state and/or local sales taxes by law. For more information, see Domestic Sales Tax.
GoToMeeting Web App FAQs

Review frequently asked questions about attending meetings via the web app. Also see GoToMeeting Web App for more information.

What is the GoToMeeting web app?

You can use the GoToMeeting web app to join sessions through your web browser (rather than joining via the GoToMeeting desktop app). See GoToMeeting Web App for more information.

Can I also host meetings with the web app?

No. The web app is only for attendees who are joining the session; organizers must use the desktop app to host meetings.

Can I tell if my account is enabled for web app?

Yes. Log in to your account, click Settings in the right navigation and look under the "Web app" section. If the "Attendees will join meetings from the web app" check box is enabled, the your attendees can join via web app. If it is disabled, then you will need to enable it in order to have attendees join via web.

Is the web app experience different from the desktop app experience?

Yes. Unlike the GoToMeeting desktop app, the GoToMeeting web app runs entirely in the attendee’s web browser and does not require any download or installation. Like the desktop app, the web app also has a collapsible Control Panel that appears at the right of the screen and provides attendees with various features and tools (including chat, mute and language settings).

While the web app allows attendees to use most of the same features and tools as the desktop app, there are some features that are not supported. See "Limitations of the web app" under GoToMeeting Web App for more information.

Can an attendee select the web app over the desktop app?

If an attendee already has GoToMeeting installed, they will have to uninstall both the application and the Citrix Online Launcher in order to use Web App.
Can I tell which attendees have joined with the web app?

Yes. You can easily see which attendees have joined via web app by checking the Attendee pane of the Control Panel. Attendees who have joined via web app will have the text "(web)" next to their name.

Can web app attendees share their screen?

Yes. Web app attendees can be promoted to presenter and share their own screen. They will need to install the GoToMeeting Pro Screensharing extension in order to do so.

Note: This feature is only available for attendees using Google Chrome. Attendees using other web browsers must switch to the desktop app in order to use it.

Can web app attendees join the audio conference using VoIP?

Yes. Web app attendees can use their computer's mic and speakers to join the audio conference (VoIP).

Note: This feature is only available for attendees using Google Chrome. Attendees using other web browsers must switch to the desktop app in order to use it.

Can web app attendees join the audio conference by dialing in via phone?

Yes. Web app attendees can dial in by phone in the same way as with the desktop app. Organizers can provide long-distance (toll), toll-free and third-party phone numbers for attendees.

Can web app attendees be muted by the organizer?

Yes. If web app attendees connect to audio via VoIP or dial in via phone and use the audio PIN, then the organizer can mute them. If they do not use the audio PIN to identify themselves, then the organizer will not be able to mute them.

What are the system requirements for the web app?

In order to join meetings via Web App, the following must be true on the attendee's computer:

- Internet Explorer 8.0 or newer or Safari 5.1 or newer with Flash Player 10.2 or newer and JavaScript enabled.
- Firefox 24 or higher and Chrome 31 and higher.
Does the web app work on Mac or Linux systems?

Yes. The GoToMeeting Web App works on Mac systems that meet the above requirements. Although the GoToMeeting Web App does not officially support Linux, it may also work on Linux systems that meet the above requirements.

Note: Because Linux is not officially supported by GoToMeeting, the Global Customer Support team will be unable to troubleshoot any Linux joining issues.

Does the web app work with mobile devices?

No. The web app can only be used for desktop computers, but the GoToMeeting apps for iOS, Android and Windows Phones allow attendees to easily join sessions from their mobile devices.

Is web app available to international customers?

Yes, the Web App is available to both U.S. and international organizers. Attendees will see the Globe icon in their Control Panel, which they can click to switch their language while in session.

Is the web app available with GoToWebinar and GoToTraining?

Yes, GoToWebinar and GoToTraining each have their own web apps.

Are there any security limitations with the web app?

Just like the current version of GoToMeeting, the web app is backed by end-to-end 128-bit AES encryption. Attending meetings from a "locked-down" environment should be faster and easier since a download is not required when using the web app.

Note: Some proxies and firewalls may prevent the Web App from launching.
Troubleshooting

Audio Help

If you are experiencing difficulty with audio, determine which scenario is applicable to you and follow the recommended guidelines.

I can't hear anyone

Test your audio setup by clicking **Settings** in the Audio pane of your Control Panel. Or, you can right-click the GoToMeeting daisy icon in your system tray, and select **Preferences > Audio**. Check to see if you're using an appropriate audio device. Click **Play Sound** to check that you can hear sound from your speakers. Speak into the microphone to test your microphone setup.
No one can hear me.

If you're the organizer, you must click Start Broadcast at the top of your Control Panel, or press *1 on your telephone’s keypad to start the audio conference.

Check to see that you're not muted by clicking the Audio icon 🎤 in your Control Panel or Grab Tab.

If you're experiencing problems dialing in by phone, try hanging up and dialing in again.

If you're having problems connecting to VoIP (Mic & Speakers), test your computer's detected audio devices by clicking Settings in the Audio pane. Speak into your microphone to test if your microphone setup is working.

I hear static or clicking sounds.

Move electronic handheld devices, such as an iPhone, away from your mic and speakers.

I hear echo, feedback or background noise.

If you suspect that the echo is coming from an attendee, check to see who's talking at the bottom of the Audio pane in the Control Panel, and mute the attendee by clicking that person's Audio icon 🎤. If you dial into the audio conference by telephone, make sure that you select Telephone from the Audio pane in the Control Panel instead of Use Mic & Speakers.

Built-in or external speakers may cause an echo. Try lowering the speaker's volume.

Built-in microphones on your computer or webcam can pick up noise and cause an echo. We don't recommend using built-in microphones. Try plugging in a USB headset to your computer.

The audio quality is poor and choppy.

Poor network performance, lack of memory or high CPU usage often causes the audio quality to drop, become delayed or sound robotic.

Try closing all applications you aren't using to free up some bandwidth.

If you're using a dial-up Internet connection with VoIP, it may cause poor performance. For optimum performance when using VoIP, we recommend using a broadband Internet connection.

If the problem persists, switch to Telephone mode. Select Use Telephone in the Audio pane and dial into the audio conference.

No sound is detected.

After the first minute of a session, GoToMeeting looks for microphone input from attendees who have the following: a microphone, speaking rights and unmuted.

If no audio input is detected, you may see a "Trying to speak?" pink tip. You may see the error when you haven't spoken or made any sounds when the session starts or if your microphone device is incorrectly selected. Click Audio Setup in the Audio pane to test your input device.
No microphone is detected.
If a microphone (or headset) isn’t detected or connected properly, you may see a pink tip.
Check that your microphone (or headset) is properly plugged in.
If the problem still persists, try switching to Telephone mode if available. Then dial in to the conference using the telephone number and Audio PIN provided in the Audio pane of your Control Panel.

My microphone is disconnected.
If your microphone isn’t working or gets unplugged during a session, you may see a pink tip.
Check that your microphone is properly plugged in.
If the problem still persists, try switching to Telephone mode if available. Then dial in to the conference using the telephone number and Audio PIN provided in the Audio pane of your Control Panel.

I can't connect to audio with VoIP.
In some cases, you will see an error that reads "Internet Audio Not Available." In this scenario, are a few things you can try to connect to the audio in the meeting.

If you see the above error message, please try the following:

- Update the device drivers for your sound hardware.
- Close any programs on your computer that you are not using.
- Unplug audio hardware that you are not currently using.
- Exit the GoToMeeting program and restart it.

Note: If you see this error message in the Audio pane, you will not be able to record your session unless "No Audio" is selected in the Recording Preferences. Audio PINs and muting controls will also be disabled.
Broadcast Computer Audio

While GoToMeeting is designed to efficiently broadcast voice audio over telephone or VoIP, there may be times when you wish to broadcast an audio recording from your computer. In this section you will find audio configuration instructions that should allow you to transmit both your voice and audio from your computer. Due to some sound card limitations, these procedures may not work with every system.

Configure Windows XP to broadcast audio

Note: Not all computers have a Stereo Mix option. Depending on your sound card, it may be called something else (like "What U Hear" on some Soundblaster cards) or may be absent entirely.

Note: You cannot use your microphone when switching via software.

1. Double-click the volume icon in the system tray (usually bottom-right of your desktop).
2. Select Options, then Properties.
3. Under Adjust Volume, choose Recording.
4. Ensure "Stereo Mix" is checked.
5. Click OK.
6. On the Recording Control screen, select the check box under Stereo Mix.

Configure Vista or Windows 7 to broadcast audio

Note: Not all computers have a Stereo Mix option. Depending on your sound card, it may be called something else (like "What U Hear" on some Soundblaster cards) or it may be absent entirely.

Note: You cannot use your microphone when switching via software.

1. Right-click the volume icon in the system tray (usually bottom-right of your desktop).
2. Select Recording devices from the menu.
3. Right-click the first item on the list and ensure Show Disabled Devices is checked.
4. Ensure Stereo Mix is the default device.
5. Press OK.

Hardware option

Parts needed:

- Two (2) 3.5 mm audio splitters (1 male, 2 female).
- One (1) 3.5 mm audio patch cable (2 male ends, typically 3" long).

Configure your system to broadcast with hardware

1. Plug 1 splitter into your line out port (for speakers, typically colored green)
2. Plug the other splitter into your microphone port (typically pink)
3. Plug the patch cable into the splitter on line out and then into the splitter on microphone.
4. Plug your microphone into the microphone splitter, and then plug your speakers into the line out splitter.
Note: You may use your microphone and speakers simultaneously.

Find your Optimal Connection Settings (Windows)

The GoToMeeting Connection Wizard tests and determines the ideal connection settings that GoToMeeting can make within your network. After running the wizard, you can store your optional connection settings on your Windows computer and use those settings in the future to connect to sessions.

Run the GoToMeeting Connection Wizard on Windows

1. To begin the test, download the GoToMeeting Connection Wizard. The G2MConnectionWizard.exe file should download in your default browser.

2. Open the G2MConnectionWizard.exe file and run the software when prompted.

3. When the GoToMeeting Connection Wizard launches, click Next to start the connection test. GoToMeeting's home page should launch in your default browser. If you're not redirected to www.gotomeeting.com, open your browser and go to that page.

4. Click OK to continue. The Connection Wizard will determine the best connection setting for your computer when connecting to GoToMeeting. This process may take a few minutes to complete.
5. Once the detection process is complete, click **Next**.

6. Try out the new connection settings by starting a meeting, then select the appropriate option in the Connection Wizard window:

   - **GoToMeeting now properly connections to the GoToMeeting service infrastructure** – Click **Next > Finish** to complete the Connection Wizard test.
   - **GoToMeeting now properly connects to the GoToMeeting service infrastructure, but I still experience problems** – Contact [Global Customer Support](http://support.citrixonline.com/gotomeeting/contact) for further troubleshooting. You may be asked to provide a GoToMeeting Connection Wizard report by clicking **Wizard Report**.
   - **GoToMeeting still cannot connect to the GoToMeeting service infrastructure** – Contact [Global Customer Support](http://support.citrixonline.com/gotomeeting/contact) for further troubleshooting. You may be asked to provide a GoToMeeting Connection Wizard report by clicking **Wizard Report**.

7. Click **Next**. The following screen will explain the next recommended steps.
Disable the Launcher Plugin

Disable the Citrix Online Launcher plugin in Firefox on Windows

1. Open Firefox.
2. Select the Firefox menu > Add-ons.
3. In the Add-ons Manager, find the Citrix Online Web Deployment Plugin. Click Disable.

You can re-enable it again by clicking Enable. Please note that each time you download and execute the Citrix Online Launcher file, the add-on will automatically become re-enabled.
Disable the Citrix Online Launcher plugin in Chrome on Windows

1. Open Google Chrome, and type chrome://plugins/ into the address bar.
2. Find the Citrix Online Web Deployment Plugin, and click Disable.

You can re-enable it again by clicking Enable. Please note that each time you download and execute the Citrix Online Launcher file, the add-on will automatically become re-enabled.

Disable the Citrix Online Launcher plugin in Safari on Macs

1. Open Finder and select the Go menu > Go to Folder. Or, press Command + Shift + G.
2. Type ~/Library/Internet Plug-Ins and click Go.
3. Delete the CitrixOnlineWebDeploymentPlugin.plugin by dragging it to the Trash on your Dock. You can also Ctrl + Click the plugin, and then select Move to Trash.

You can restore it by dragging it out of the Trash, or you can Ctrl + Click the plugin from the Trash, and select Put Back.

Once you remove the plugin from your Internet Plug-ins, it is removed from your Mac and from all other browsers on your computer. Please note that each time you launch GoToMeeting, the plugin will automatically become re-enabled.
Disable the Citrix Online Launcher plugin in Firefox on Macs

1. Open Firefox.
2. Select the **Tools menu > Add-ons.**
3. In the Add-ons Manager, find the **Citrix Online Web Deployment Plugin.** Click **Disable.**

You can re-enable it by clicking **Enable.** Please note that each time you launch GoToMeeting, the add-on will automatically become re-enabled.

Disable the Citrix Online Launcher plugin in Chrome on Macs

1. Open Google Chrome, and type `chrome://plugins/` into the address bar.
2. Find the **Citrix Online Web Deployment Plugin,** and click **Disable.**

You can re-enable it again by clicking **Enable.** Please note that each time you launch GoToMeeting, the plugin will automatically become re-enabled.
Steps for Installing on Macs

When you start or join a meeting, the installation package (including applications and plugins) will be downloaded onto your computer. By leaving the applications installed and the plugin enabled, you will be able to join future meetings more quickly by avoiding the extended download process. See Join Help for troubleshooting information.

Note: These instructions apply to Mac customers only; also see Steps for Installing on Macs for more information. See Join Help for troubleshooting information.

About the installation package

The installation package includes the following components:

- **GoToMeeting desktop app**
  This is the main software that you use to start and join meetings.

- **GoToMeeting Launcher app**
  This “helper” application is required to install and launch the GoToMeeting desktop application. It must be installed on the computer, even if the GoToMeeting application is already installed.
  
  Note: If you remove the Launcher application at a later time, you’ll need to go through the entire download process again. We don’t recommend that you do this if you frequently join meetings, as you will lose the benefit of faster join times.

- **Web Deployment browser plugin (optional)**
  This plugin allows your web browser to automatically start the Launcher application, which in turn launches the GoToMeeting application. Although disabling or blocking the plugin will not prevent you from joining meetings, our products work best if the plugin is allowed to run when the browser prompts by clicking Allow, Run this time or Trust.
Download the desktop app

1. Organizers can start a meeting (or attendees can join a meeting) to initiate the software download. Once the web browser launches, you will see the following:

   • If the Launcher application is not installed (either first time joining or it was removed), then the Citrix Online Launcher.dmg file will automatically start downloading. Continue to Step #2.
   • If the Launcher application is already installed, then the web browser will automatically start the Launcher app, which will then launch the GoToMeeting application (or install it again, if needed). You will not need to continue to Step #2, but you will see the dialogs described in Run the desktop app once installed.

2. If the Launcher application is not already installed, the Citrix Online Launcher.dmg file will automatically begin downloading. Depending on which web browser you are running, you can complete the download as follows:

   • Apple Safari
     Double-click the “Citrix Online Launcher” file in the browser’s Downloads window (click restart the download if the download doesn’t start).

   • Mozilla Firefox®
     Select "Open with" then click OK when prompted (click restart the download in the browser window if needed).

   • Google Chrome™
     When the download finishes, click Citrix Online Launcher file.zip at the bottom of the page to open the file (you may need to refresh the page and/or click download & run).
3. When the Citrix Online Launcher window opens, double-click the Launcher icon.

4. You will see a message noting that “Citrix Online Launcher” is an application downloaded from the internet. Enable the “Don’t warn me […]” check box, then click Open to continue. The GoToMeeting application will then finish downloading and automatically launch. Once the download is done, you will be able to join future meetings even faster!

See Run GoToMeeting once installed for more information about joining future meetings.

**Note:** If you remove the Launcher application at a later time, you’ll need to go through the entire download process again. We don’t recommend that you do this if you frequently join meetings, as you will lose the benefit of faster join times.
Run the desktop app once installed

Once the Launcher application has been installed, you will not need to download it again (unless you remove it). When you next start or join a meeting, you will be prompted with additional dialogs from the web browser requesting permission to start the Launcher and/or GoToMeeting application on your behalf.

- **Apple Safari**
  Users running Safari will not be prompted by any additional dialogs.

- **Mozilla Firefox**
  If you are running Firefox, you may be prompted to choose an application to use (either the Citrix Online Launcher application, or the GoToMeeting application).
  1. Select the "Remember my choice for citrixonline links" check box to avoid being prompted by the dialog again when joining future meetings.
  2. Click **OK** to continue. The Launcher application will then start.
• **Google Chrome**

If you are running Chrome, it may request your permission to open an external application (i.e., the Launcher application or the GoToMeeting desktop application) by prompting you with an "External Protocol Request".

1. Select the "Remember my choice for citrixonline links" check box to avoid being prompted by the dialog again when joining future meetings.

2. Click **Launch Application** to continue.

3. Click **Open** when prompted. The Launcher application will then start.
Steps for Installing on Windows

When you start or join a meeting, the installation package (including applications and plugins) will be downloaded onto your computer. By leaving the applications installed and the plugin enabled, you will be able to join future meetings more quickly by avoiding the extended download process. See Join Help for troubleshooting information.

Note: These instructions apply to Windows customers only; also see Steps for Installing on Macs for more information. See Join Help for troubleshooting information.

About the installation package

The installation package includes the following components:

- **GoToMeeting desktop app**
  This is the main software that you use to start and join meetings.

- **GoToMeeting Launcher app**
  This “helper” application is required to install and launch the GoToMeeting desktop application. It must be installed on the computer, even if the GoToMeeting application is already installed.
  
  Note: If you remove the Launcher application at a later time, you'll need to go through the entire download process again. We don't recommend that you do this if you frequently join meetings, as you will lose the benefit of faster join times.

- **Web Deployment browser plugin (optional)**
  This plugin allows your web browser to automatically start the Launcher application, which in turn launches the GoToMeeting application. Although disabling or blocking the plugin will not prevent you from joining meetings, our products work best if the plugin is allowed to run when the browser prompts by clicking Allow, Run this time or Trust.

Download the desktop app

1. Organizers can start a meeting (or attendees can join a meeting) to initiate the software download. Once the web browser launches, you will see the following:

   - **If the Launcher application is not installed (either first time joining or it was removed)**, then the GoToMeeting Launcher.exe file will automatically start downloading. Continue to Step #2.
   
   - **If the Launcher application is already installed**, then some or all of the following steps will be skipped. The web browser will automatically start the Launcher app, which will then launch the GoToMeeting application (or install it again, if needed). The customer will not need to continue to Step #2, but they will see the dialogs described in Run GoToMeeting once installed.

2. If the Launcher application is not already installed, then the GoToMeeting Launcher.exe file will automatically begin downloading. Depending on which web browser you are running, you can complete the download as follows:

   **Mozilla Firefox®**
   
   - Click Save File when prompted by the "Opening GoToMeeting Launcher.exe" dialog (click restart the download in the browser window if needed).
• Click the Downloads button in the toolbar, and then select the “GoToMeeting Launcher.exe” file.
• Click Run if prompted.

Google Chrome™
• When the download finishes, click GoToMeeting Launcher file.exe at the bottom of the page to open the file (click restart the download in the browser window if needed).
• Click Run when prompted.
Internet Explorer®

- Click Run when prompted (click launch GoToMeeting again in the browser window if needed).

3. The GoToMeeting Launcher application will be automatically installed, along with the Web Deployment browser plugin (click Yes if prompted by User Account Control). GoToMeeting will be automatically launched.
Once the download is done, the customer will be able to join future meetings even faster! See Run GoToMeeting once installed for more information about joining future meetings.

**Note:** If customers remove the Launcher application at a later time, they'll need to go through the entire download process again. We don't recommend that customers do this if they frequently join support sessions, as they will lose the benefit of faster join times.

### Run the desktop app once installed

Once the Launcher application has been installed, customers will not need to download it again (unless they remove it). When these customers join a support session next, they will be prompted with additional dialogs from the web browser requesting permission to start the Launcher and/or GoToMeeting application on the customer's behalf.

**Mozilla Firefox**

If you are running Firefox, you may be prompted to choose an application to use (either the Citrix Online Launcher application, or the GoToMeeting application).

1. Select the "Remember my choice for gotomeeting1468 links" check box to avoid being prompted by the dialog again when joining future sessions.

2. Click **OK** to continue. The Launcher application will then start, as shown in Step #3 above.
**Google Chrome**

If you are running Chrome, it may request your permission to open an external application (i.e., the Launcher application or the GoToMeeting desktop application) by prompting you with an "External Protocol Request".

1. Select the "Remember my choice for citrixonline links" check box to avoid being prompted by the dialog again when joining future sessions.

2. Click **Launch Application** to continue. The Launcher application will then start, as shown in Step #3 above.

![External Protocol Request](image)

**Internet Explorer**

Customers running Internet Explorer v9 or newer will not be prompted by any additional dialogs. Customers running v8 or older will be prompted to manually launch the applications.

1. Click **Launch GoToMeeting** in the web browser.

2. Click **Run** in the Application Run dialog. The Launcher application will then start, as shown in...
Optimal Firewall Configuration

Covers Citrix SaaS products involving our servers as of September 2014

Citrix SaaS products are configured to work outbound through ports 8200, 80 or 443. In a restricted environment, port 8200 can be set up for outbound connections. Our products do not listen for, nor do they require, any inbound connections. Connections outbound via port 8200 are optimal, although connections through ports 80 and 443 can also be used.

Integrated Voice over IP (VoIP) connections are configured to work outbound through UDP port 8200. Integrated webcam video support is configured through UDP port 1853.

For most firewall or proxy systems, we recommend specifying a whitelist of DNS addresses for Citrix services so outbound connections can be made. The list of Citrix domains currently includes (but is not limited to) the following:

| *.assist.com | *.gotomeet.me | *.openvoice.com |
| *.citrixonline.com | *.gotomeeting.com | *.osdimg.com |
| *.citrixonlinecdn.com | *.gotomypc.com | *.podio.com |
| *.cloudfront.net | *.gototraining.com | *.securevdr.com |
| *.expertcity.com | *.gotowebinar.com | *.sf-api.com |
| *.fastsupport.com | *.helpme.net | *.sf-api.eu |
| *.go2assist.me | *.hu.tt | *.sharefile.com |
| *.gofastchat.com | *.joingotomeeting.com | *.sharefile.eu |
| *.gotoassist.com | *.jointraining.com | *.sharefileftp.com |
| *.gotoassist.me | *.joinwebinar.com | *.sharefile-webdav.com |

Important Note: Changes to the firewall configuration are discouraged unless absolutely necessary because our IP ranges and those of our provider networks need to be periodically audited and modified, creating additional maintenance to your network. These changes are necessary to continue to provide the maximum performance for the Citrix SaaS family of applications. Maintenance and failover events may cause you to connect to servers within any of the ranges.

If your firewall includes a content or application data scanning filter, this may cause blocking or latency, which would be indicated in the log files for the filter. To address this problem, verify the below IP ranges will not be scanned or filtered by specifying exception IP ranges that will not be filtered. If your security policy requires you to specify explicit IP ranges, then configure your firewall to limit port 8200 or 80 or 443 destination, UDP ports 8200 and 1853 and IP addresses to only the Citrix ranges and those of our provider networks given below.
<table>
<thead>
<tr>
<th>Citrix Assigned Range by Block</th>
<th>Numeric IP Address Range</th>
<th>Netmask Notation</th>
<th>CIDR Notation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block 1</td>
<td>216.115.208.0 - 216.115.223.255</td>
<td>216.115.208.0 255.255.240.0</td>
<td>216.115.208.0/20</td>
</tr>
<tr>
<td>Block 2</td>
<td>216.219.112.0 - 216.219.127.255</td>
<td>216.219.112.0 255.255.240.0</td>
<td>216.219.112.0/20</td>
</tr>
<tr>
<td>Block 3</td>
<td>66.151.158.0 - 66.151.158.255</td>
<td>66.151.158.0 255.255.255.0</td>
<td>66.151.158.0/24</td>
</tr>
<tr>
<td>Block 5</td>
<td>66.151.115.128 - 66.151.115.191</td>
<td>66.151.115.128 255.255.255.192</td>
<td>66.151.115.128/26</td>
</tr>
<tr>
<td>Block 6</td>
<td>64.74.80.0 - 64.74.80.255</td>
<td>64.74.80.0 255.255.255.0</td>
<td>64.74.80.0/24</td>
</tr>
<tr>
<td>Block 8</td>
<td>67.217.64.0 - 67.217.95.255</td>
<td>67.217.64.0 255.255.224.0</td>
<td>67.217.64.0/19</td>
</tr>
<tr>
<td>Block 9</td>
<td>78.108.112.0 - 78.108.127.255</td>
<td>78.108.112.0 255.255.240.0</td>
<td>78.108.112.0/20</td>
</tr>
<tr>
<td>Block 10</td>
<td>68.64.0.0 - 68.64.31.255</td>
<td>68.64.0.0 255.255.224.0</td>
<td>68.64.0.0/19</td>
</tr>
<tr>
<td>Block 11</td>
<td>206.183.100.0 - 206.183.103.255</td>
<td>206.183.100.0 255.255.252.0</td>
<td>206.183.100.0/22</td>
</tr>
<tr>
<td>Block 12</td>
<td>173.199.0.0 - 173.199.63.255</td>
<td>173.199.0.0 255.255.192.0</td>
<td>173.199.0.0/18</td>
</tr>
<tr>
<td>Block 13</td>
<td>103.15.16.0 - 103.15.19.255</td>
<td>103.15.16.0 255.255.252.0</td>
<td>103.15.16.0/22</td>
</tr>
<tr>
<td>Block 15</td>
<td>140.207.108.0 - 140.207.109.255</td>
<td>140.207.108.0 255.255.254.0</td>
<td>140.207.108.0/23</td>
</tr>
<tr>
<td>Block 16</td>
<td>23.239.224.0 - 23.239.255.255</td>
<td>23.239.224.0 255.255.224.0</td>
<td>23.239.224.0/19</td>
</tr>
<tr>
<td>Block 17</td>
<td>185.36.20.0 - 185.36.20.255</td>
<td>185.36.20.0 255.255.252.0</td>
<td>185.36.20.0/22</td>
</tr>
</tbody>
</table>
Citrix server / Datacenter IP addresses for use in firewall configurations

Equivalent specifications in 3 common formats

<table>
<thead>
<tr>
<th>IPv6 addresses space</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Citrix Assigned Range by Block</strong></td>
</tr>
<tr>
<td>Block 1</td>
</tr>
<tr>
<td>Block 2</td>
</tr>
</tbody>
</table>

Citrix scales its services into third-party cloud and carrier networks for improved performance. To ensure continuous uptime, Citrix also maintains datacenters in San Jose, Las Vegas, Chicago, New York, Atlanta, Washington D.C., Hong Kong, Sydney, Amsterdam, Frankfurt, Bangalore and Shanghai.

**IP ranges for the content delivery network (CDN)**

**IP ranges for other services (audio, video and screen sharing)**
The Citrix Online Web Deployment Plugin

Enable the Citrix Online Web Deployment Plugin

The first time you host/join a session or upgrade/downgrade GoToMeeting on a Windows computer, you'll be prompted to download a file (the Citrix Online Launcher.exe) that includes a browser plugin that lets you launch the GoToMeeting software faster.

Many browsers now automatically block plugins. Even if your browser has blocked plugins, you can still get into session as long as you have downloaded the Citrix Online Launcher file. However, you may notice dialogs regarding the plugins when you start or join a session and it is best practice to allow these plugins to run. We do not require that you run the plugin, but it will confirm that the software is installed on your computer.

Enable the plugin on Chrome

Do either of the following:

- Ignore or close the dialog.
- Click Run this time or Always run on this site to enable the plugin.

Enable the plugin on Firefox

Do either of the following:

- Ignore or close the dialog
- Click Continue Allowing to enable the plugin
Enable the plugin on Safari

Do either of the following:

- Ignore or close the dialog
- Click Trust to enable the plugin
Test your Connection, Audio or Webcam

You can test your internet connection, audio connection and webcam at any time, whether you’re getting ready to start a session or are already in one.

Test your internet connection

Before a session

1. To test your connection from a computer or mobile device, join the test session using the following URL: https://www3.gotomeeting.com/join/406552062.

2. You will automatically be launched into session.
   - Desktop users – If you have not yet installed the GoToMeeting desktop application, the download will automatically begin. See Install on Windows or Install on Mac for more information.
   - Mobile users – If you have not yet installed the GoToMeeting app, you will be directed to the app store to download it.

3. If you see a "Waiting for Organizer" message, you've successfully joined the test session. You should be able to join GoToMeeting, GoToWebinar and GoToTraining sessions from this computer. Close the "Waiting for Organizer" dialog to exit the test session.

Note: If you’re unable to join the session, you may not have all the necessary software. See Join Help for more troubleshooting tips, and make sure you have all the System Requirements.

During a session (Windows only)

Does something feel off with your meeting session? You can test your GoToMeeting connection while in session to find out for sure.

1. While in a session, open Preferences.

2. Click Connection in the left navigation.

3. Under "Test your GoToMeeting connection", click Test Connection.

4. Under "Test Results", you'll see one of the following messages:
• **Passed:** You've established a connection.
• **Fail:** You haven't established a connection. See [Connection Test Help](#) for troubleshooting info.

**Note:** You may need to enter your Windows username and password or domain if you have a proxy that prevents you from connecting to GoToMeeting. If you don’t have a proxy, please check to see that you have the minimum system requirements.

5. Click **OK** when finished.
Test your computer audio

Before a session

1. Right-click the daisy icon in the system tray and select Preferences.
2. Select Audio in the left navigation.
3. Configure and test your audio as follows:
   - Use the drop-down menus to select which devices to use for microphone and speakers. If you do not see the device you're looking for, ensure that it is properly plugged into your computer.
   - If they are working as expected, you'll see the Mic meter and Speakers meter light up in green. If you do not see that happen, try selecting a different device.
   - If needed, click Play Sound to play a noise to test your speakers setup.
4. Click OK when finished. GoToMeeting will remember your selection (unless the selected device is disconnected before the next session).
During a session

1. You can use any of the following methods while in session:

   - Follow the instructions under Preferences > Audio, as described above.
   - Access the drop-down menus described above in the Audio pane of the Control Panel.
   - Click Sound Check in the Audio pane of the Control Panel, then use the Sound Check window to select your device and test the sound. If the audio isn't working as expected, try selecting another device that's connected to your computer from the drop-down menu until the audio indicators turn green.
Test your webcam

You can test your webcam at any time to make sure everything looks the way you want it to.

1. Right-click the daisy icon in the system tray and select Preferences.
2. Click Webcam in the left navigation.
3. If you have a webcam connected, you will see a preview of it under "Webcam Setup".

Preview your webcam

1. While in a meeting, select the Webcam tab in the Options pane.
2. A preview of your webcam will be displayed. Once you share your webcam, a blue highlight will appear around the webcam box and the "Preview" header will disappear.